HCLSoftware

HCL DevOps Test
Performance

11.0.7 Documentation
December 2025



Special notice

Before using this information and the product it supports, read the information in Notices on page mcclx.



Contents

SpPeCial NOLICE......cuiieieiiiiceieeee e i
Chapter 1. Release Notes.........cccceeeeevrvnnrreneeeeeeeeeeeennnn. 13
What's NeW......cooiiiiiiieeee e 14
Deprecations and removals .........cccccoccveieienieneeieennee. 30
DefeCt fIXES. ..ot 40
KNOWN ISSUES......ooiiiiiiiiiiiieiitee e 50
Chapter 2. System Requirements..........ccccccceeriiiiiinnnnnnne. 72
HardWare.........c.oouieuieieieeeeeeeeec e 73
Operating SYSteMS.......ccvevieiieiecee e 75
HoSt prerequUISites.......ooovvveieiiecieceeceeeeeeeeee 77
Recording SUPPOIt........cooieieierierieeceeeie e 80
Supported SOftware.........cccccoevvieiecierecieeeee e 81
Chapter 3. Getting Started.........cccccoovrreerreeeeeeeeeeeeennnne. 86
Task flows for performance testing............cccccevenee. 86
Task flow: HTTP record..........cccooeveevnenieiernieienns 86
Task flow: Generating workload............................ 88
Task flow: Recording a SAP test.........ccceeveeneee. 90
Task flow: Recording a service test to test an SOA
apPlicatioN......cceiieiee e 92
Task flow: Recording a SAP batch input test........ 94
Task flow integrating DevOps Test Performance
and DevOps Test Integrations and APIs............... 96
Task flow: Rate Scheduler..........ccccooenevininennns 98
DevOps Test Performance overview.............c........... 100
HTTP performance testing overview.................. 100
SAP performance testing overview..................... 101
Citrix performance testing overview................... 101
Service testing OVerview...........ccceevevveeeveeeeeennnnne. 103
Generic service client overview............cccceun..... 104
Socket API performance testing overview......... 106
TN3270 performance testing overview.............. 107
IBM® Engineering Test Management
OVEIVIEW. ..ottt ee e 107
Streamlined Eclipse and full Eclipse overview........... 109
Starting the product in full Eclipse mode........... 109
Starting the product in streamlined Eclipse
MOt 110
Chapter 4. Tutorials.........cccceeeeervriinneereeeeeeeeeeeeeeeeeeeennnns 111
Performance test a Web application........................ 111
Introduction: Test a Web application.................. 111
Module 1: Creating projects and recording user
ACTIONS. ..o 11

Module 2: Editing a test
Module 3: Validating a test with a single user....114

Module 4: Representing workloads..................... 115
Module 5: Running the test..........ccccevevinreennee. 116
Module 6: Evaluating results.........c..cccccoeveruennene. 117

SUMMAIY..ceiiiiieie e e 118
Performance test an SAP application...................... 119
Introduction: Performance test SAP
SOIULIONS....cviiiieiiieeee e 119
Module 1: Creating projects and recording user
ACHIONS ... 120
Module 2: Editing an SAP test...........cccceevveuenne 121
Module 3: Running tests.........cccccoooveveeiieeneene. 122
SUMMAIY ..t e 124
Performance test a Citrix application......................... 124
Introduction: Performance test Citrix
applications..........ccooeevieiiciiiee e 125
Module 1: Creating projects and recording user
ACHIONS ...t 125
Module 2: Editing a Citrix performance test....... 127
Module 3: Representing workloads..................... 128
SUMMAIY..ceiiiiieieeiecee e 130
Chapter 5. Samples........ccceiiiiiieiiiiiiirrnneeeeeeeeeeeeeeeeenns 131
Installation tuning tests for WebSphere® Application
SEIVET .ttt 131
Installing the assets for tuning tests.................. 132
Testing with the Snoop test.........ccoccevvvveiennnne. 132
Testing the PlantsByWebSphere application......133
Testing the Daytrader application....................... 133
Chapter 6. Administrator Guide............ccccoevvuueeeeeeeeeeenns 134
Installation of DevOps Test Performance.................. 134
Installation requirements...........ccccceevevriieeennnnn. 134
Installation conventions and terminology.......... 135
Installation Manager overview...........c..c..c.......... 135
Installation locations..........cccceeeneniieeieieeee 136
Offering coexistence considerations.................. 137
Eclipse instance overview............cccccoeveveeuvennnn. 137
Increasing the number of file handles on Linux™
WOTKSTatiONS.....ccviiiiieiieieee e 138
Installation of the product by using IBM®
Installation Manager...........ccoceeeveceienrieeienee. 139
Uninstalling the product by using IBM® Installation
MaNAGET........iieiieeie et 147
Installation of the product by using the stand-alone
INSTaller.....o.oiieee e 147
Uninstallation of the product by using the stand-
alone installer.........cccooiiiiieieeceeee e 162
License management.........cccoovevierienienieeie e 164
License descriptions............cccocveevieieieiecieceene, 164
License configuration..........c..ccccevveenenieeneniennnne. 165
Collecting usage metrics data...........cccceevennennen. 169
Product upgrade and migration............c.cccccooeveeurnenne. 170
Migrating test assets to new version of the
PrOAUCT. ..ottt 170



Contents | iv

Configuration of the product............ccccoevevieinervenennne. 171
Configuring the environment for SAP tests........ 171
Configuring Docker containers

Integration with other products................

Integration plugin compatibility matrix............... 174
Running tests by using Ant........c.ccoocveievieniennnnne 176
Integration with Azure DevOps..........cccccuveuee.e. 189
Integration with Apache JMeter.......................... 203
EGit integration..........cooe e 209
Configuration of test runs as a GitHub Actions
WOTKFIOW. ..o 219
Integration with Engineering Test
Management..........ccoecvieiieiiieiieeee e 235
Integration with IBM® Engineering Workflow
Management..........ccoooieiiiiienieeeee e 247
Integration with HCL DevOps Deploy.................. 250
Integration with DevOps Test Integrations and
APIS o 272
Integration with IBM® DevOps Deploy............... 282
Integration with Jenkins...........c.ccooooeevieieiennnn. 303
Testing with Maven.........cccccooeiiiieiiiee e 331
Integration with Micro Focus ALM...................... 333
Chapter 7. Test Author Guide..........cccceeeeeerrrrnneeereeeeenns 349

Creating teStS...uiiiiieceecececee e 349
Performance testing tips........ccccooevveevnineiennnene. 349
Creating @ project.......cccooeeiieeieiieiieeeeee e 350
Recording HTTP tests........ccoccooveieviiviiciicieies 351
Recording SAP tests........ccoceeeeveceecceeeeeee 381
Recording Citrix testS.......ccoceveviiieieeeceeee 398
Recording service tests.........cccocvevveievienieeieneneen 413
Recording socket and TN3270 tests.................. 437
Digital certificates overview...........cccccveuvenee.n. 446
Kerberos overview..........ccccceeeveeveniieeieseee 453
Annotating a test during recording..................... 457
Recording sensitive session data....................... 457
Splitting a test during recording............c.c.......... 458
Generating a new test from a recorded
SESSION. ..ttt 459
Organizing test assets by type.......cccceevveennnee. 459

Editing teStS. i 460
Editing HTTP tests......ccooeiiieeieeeeeeee 460
Editing SAP tests.......coeieiiiiece 496
Editing Citrix tests........ccooveveeiieiiieeeeeeee 508
Editing service tests.......cccoorveiiiieieeeeee 521
Editing Socket tests........cceviviiiiieieeeee 554
Editing Kerberos tests............ccccevveviiiieieieiennnns 565
Adding test elements..........ccccooeeieieicciieien 566
Searching within tests........cccccoooevinieieieie 574
Exporting @ test......ccoooieiieiiiieeeeeee 577

Copying test assets with dependencies............. 578
Disabling portions of a test..........ccceevecieriennnen. 580
Running test elements in random order............. 582
Renaming test assets........ccoccvveeciveeicieeciiecieee 583
Deleting test assets......ccocecevieneveeieieieeeene 584
Debugging custom code for tests and compound
TESTS e 586
Providing tests with variable data (datasets)..... 586
Test variables........coceveiieieieeeeceeeee 609
Correlating response and request data.............. 615
Data transformation..........cccceeeeeeeneeinenereeennne. 652
Compound TESTS......ccuveciiiiicieeteeeeeeece e 662
Creating a compound test..........cccecveviireenrennene. 662
Viewing compound tests.........cccccoevvevieviieiineennnns 664
Adding tests into a compound test..................... 665
Modifying a compound test..........ccccoeveveenennnne. 666
Running compound tests..........cccceveieninieeirennne. 666
Generating compound test result reports........... 667
Importing a compound test into a project.......... 668
Adding compound tests to schedule.................. 669
Simulating services with stubs............ccccoeivieieennn. 669
Service stub OVerview..........ccceceeeveceenenienennene 669
Creating a service stub.............cccooeveeiiienennn. 670
Editing a service stub.........ccoceiiiiiieieeee 671
Deploying service Stubs..........ccccceeevevieniinieeieennene. 672
Recording service stub activity in a log file........ 673
Setting log level for service stubs....................... 674
Sending service requests with the generic service
ClIENT. .. 674
Creating transport protocol configurations........ 674
Sending service requests with WSDL files.......... 686
Sending HTTP endpoint requests....................... 688
Sending a JMS endpoint request........................ 689
Sending a WebSphere® MQ endpoint
FEQUEST...ceeiieieiee e 690
Sending OData endpoint batch requests............ 692
Sending WebSphere Java MQ endpoint
FEQUESTS. ..o 693
Testing all operations in a WSDL file.................. 696
Viewing message content..........cccccceevvvevveennneen. 697
Synchronizing a remote WSDL file...................... 698
Synchronizing a local WSDL file with GSC.......... 699
Adding static XML headers to a service
FEQUEST ... 699
Opening file attachments.........c..ccocoeevevieniinnnnnen. 700
Emulating workloads............ccccoeeveviieiiieieieieeee 700
Schedule overview...........cccocvveieenerieeeeeeennn 700
Creating a VU Schedule..........cocooieiiniiiinne. 701
Creating a Rate Schedule..........ccccooveveieiennnne. 718



Using Application Performance Management in a

schedule.........ccoeoiniiiniiiniicceee 725
Think time overview...........cccoeeevvernccnneeenn 727
Working with agents..........ccccceiiiiiieienee e 730
Adding a test to a schedule............c.cccocueeurenenee. 734
Adding must run tests
Assigning variables.............cccocooeieiiieicee
Defining performance requirements in
schedules.........c.occcniiiniiiniiic 736
Repeating tests in a schedule..............c..c........... 737
Creating rate generators in user groups............. 739
Running tests at a setrate..........c.ccecee.
Running tests in random order
Adding a transaction to a schedule.................... 744
Emulating network traffic from multiple
ROSTS ..o 744
Monitoring resource data............cccccoeevrevreriennnnnn. 747
Resource Monitoring Service...........cccoccveveenenne 769
Setting log and statistic levels..........cccccceeuen. 770
Chapter 8. Test Execution Specialist Guide................... 781
Running schedules with performance testing........... 781
Running a local schedule or test............cc.......... 781
Running a long run mode SAP GUI test.............. 782
Running long duration Citrix tests.........cccceceeuu... 783
Testing with Docker images..........ccccceeveeeeueneene. 784
Adjusting delays in HTTP tests......cccccoocevivieenenns 790
Setting a launch configuration...............c..c......... 793
Running a configured schedule........................... 794
Configuring multiple host names for a
[0CATION. ..ot 795
Automating tests from command line................ 796
Controlling caches size........c.ccooveveiecieieeene 826
Increasing memory allocation.............ccccceeueenee.e. 826

Controlling execution of web analytic reports....828
Debugging HTTP tests

Debugging Citrix tests.........cccooeeieieieieceee
Extending test execution with custom code.............. 845
Creating custom Java™ code.........ccccoeeeurrueennne 846
Test execution services interfaces and
ClaSSES..c..iieieeeee e 848
Reducing the performance impact of custom
COUB. ..ttt 851
Custom code examples.......ccccoeeeveeiccieereeenenne. 852
Migrating custom code from previous
VETSIONS. ... cuiiiniiirienteteitnteneee ettt 879
Extending DevOps Test Performance to support other
PrOtOCOIS. ...ttt 880
Protocol extension structure...........ccccccoveueennee. 881
Extending the test recorder...........ccccceoenvneneee. 882
Extending the test generation framework........... 893

Reports and counters

Contents | v

Contributing annotations...........cc.cecveeevenenennen. 899
Extending the load test behavior model............. 902
Extending data correlation ..............ccccceeiiinine. 914
Extending the test editor............c..ccoooveieeeinn. 918
Contributing error handlers.........cccccooovrinieinnnnne 931
Extending the schedule component................... 937
Extending code generation..............ccccoeveevrenenen. 939
Extending the run-time environment................... 945
Extending the test log viewer..........ccccoeveeneee. 953
Extending evaluation results..........c..ccccoeveiennne 953
Chapter 9. Test Manager Guide............ccccceveeeeereeeeannne. 961
Evaluating results in web analytic reports................. 961
Comparing results among runs...........cc.cceeeueeee. 961
Comparing schedule stages.........ccccoceeveveiennns 961
Comparing results from various regions or agent
10CAtIONS....ccuieieeceeee e 962
Generating functional reports............cccccecveienene 963
Publishing functional reports to the server........ 965
Publishing test results to the server................... 966
Publishing specific results to the server............. 968
Customizing reportS........cceeveeeeenienierieeeeeee
Export test results.........c.ccooveieciiiciciciee
Viewing response time breakdown
LOQS OVEIrVIEW. ..o
Viewing test 10gS.....ccocveievieriiiieieiee e
Viewing errors while running tests.....................
Viewing reports after arun............ccccoevevvennnnnn.
Accessing reports remotely..........ccccceeveeerennnne.
Exporting test [0gS......cccoovviieieiiieicieieeee
Exporting event 10g.........ccooveviieieiiiiiiceeee
Exporting event console output............c.............
Viewing adjustments to page response times... 998
Viewing resource monitoring data...................... 999

Requirements report
Synchronization Point report............cccceeveneenee.
LOOPS FEPOI ...ttt
Agents Health Report............ccooveiiiiiiiiii,
Rate Runner report..........ccccceveeieevceeeccieecieeen.
Transaction report........cccoceeveeeciieecieecee e

Transaction Percentile report...
Transaction Net Server Time Percentile

=T 070 o ST UUSRRTSN 1008
Rate Generator report..........ccccoeveiiieinicieeenee. 1009
HTTP performance test reports........................ 1010
SAP performance test reports............ccc.cu....... 1032
Citrix performance test reports...........c..cc......... 1036
Web service performance test reports............. 1041



Vi

Contents | vi

Socket performance test reports...................... 1049
HTTP coUNters.......ccooceeiieieeiieeeeee e 1051
SAP COUNTEIS....couiiiiiiiieieeeeeee e 1069
CitriX COUNTErS.....cveiiiieeeeee e 1076
Service CoUNters.......coccevieiienieeeeeeeeeee 1085
Socket COUNTErS.........c.ccveeiiviiiiieiieieeee e 1106
Chapter 10. Troubleshooting Guide............................. 1110
Troubleshooting performance testing...................... 1110
Performance testing error messages.........ccc.c........ 1115
PRXEOTOTW...ooiiiiiiieeiieieee e 1115
PRXEAG43W......c.ooiiriiiiiiieienieeeeeeese e 1115
PRXEAO5T ..ottt 1115
RMSEQOO3W.....oouieieieiieeieee e 1115
RMSEQOO4W......cooeieiiiieeieieieeie e 1116
RMSEQOOSW.....oiiiieieiieeeieieeceeee e 1116
RMSEQOOBW.....c..eeieieiieeieeieeee e 1116
RPACO00TW......iiiiiieieee e 1116
RPHDTO32E.........ceoieiiieeiieieieieee e 1116
RPHDTO34E.........cooeiieniiieieeceeeeeee e 1117
RPHEOOOTE. ... 1117
RPHEOTT6E. ... 1117
RPHEOOTOW.......ooeiieieieeieceeeeeee e 1117
RPHEOOTTW...oiiiiiiieeieeeeeeeeeeeeie e 1117
RPHEOOT2W....oiiiieieeieeeeeeee e 1117
RPHEOOT3W....oiiiiiieeeeeee e 1117
RPHEOOTAW........oiiieieieet e 1117
RPHEOTOOW.....c..oiiiiieieiiiieeceeeeieeeeeeeee i 1118
RPHEOTOTW....oiiiieieeeeeeeeeeeeeeee e 1118
RPHEOTO2W.....ocuieiiieeeeeee e 1118
RPHEOTO3W......eiieieieieetceeeeeee e 1118
RPHEOTOAW.....coiiiiieieiieeeeeesieeeeeeee e 1118
RPHEOTOSW....oeiiiieieeeeeeeeeee e 1118
RPHEOTOOW........eoeiieieeieee e 1118
RPHEOTO7W....oiieiieiieieet e 1119
RPHEOTO8BW.....c..eiiiiiieieiiiieeeeeeiececeeee e 1119
RPHEOTOOW.....oeiiiiieeeeeeeeeee e 1119
RPHEOTTOW....ooiiiiiieeeeeee e 1119
RPHEOTTTW...oiiiiieieeet e 1120
RPHEOTT2W....oiiiiiieieiiceeeeeeeeeeee e 1120
RPHEOTT3E. ..o 1120
RPHEOTT3W....iiiiiiieeeeeec e 1120
RPHEOTTAE. ... 1120
RPHEOTTAW....oiiiiiiiieiieeeeeeeeeee e 1120
RPHEOTT5E. ... 1120
RPHEOTTSW....iiiiieeeee e 1121
RPHEOTT7W ..ottt 1121
RPHEOTT8W....oiiiiiieieiieeeeeeeeceee e 1121

RPHEOTTOE. ... 1121
RPHEOT20E.......cccooiiiiiciicccce 1121
RPHEOT2TE. ...t 1121
RPHEOT22W....cooiiiiiiiiiccece 1121
RPHEOT23W ..o 1121
RPHEOT24W.....oiiiiiiicccccee 1121
RPHEOT25W......oiiiiiiiiiiiccce, 1121
RPIBOOOTE.......ooiiiiiiicciicccecccceeas 1122
RPIHOOTAE.......ooiiiiiice 1122
RPKGOOQOE........ccoooiiiiiiiiciiiciccccce 1122
RPKGOTOOE.........ccooiiiiiiiiiicicccce 1122
RPKGOTOTE. ... 1122
RPKGOTTOE.....cooiiiiiiiciiicicccccee 1123
RPSEQOTAW. ..o 1123
RPSFOTTAE. ..o 1123
RPSFOT72E.......ooiiiiiiicicciceeeccee 1123
RPSFOTOSE. ... 1123
RPSFOTO7E......ooiiicicccceceee 1123
RPSFOTO8E........coiiiiiiiiiiicicccce 1124
RPSFOTOOE. ... 1124
RPSFO2T2E......ooiiiiiiiicce 1124
RPTAOOOOW.......cooiiiiiiiciciccccececee 1124
RPTAOOOTL...cviiiiiiiiiiiiccccccce 1124
RPTAOOOZE.......coiiiiiiciccccce 1124
RPTAOOOBE........coiiiiiiiiiicccccce 1124
RPTAOOOAE...... ..o 1125
RPTAOOOOE........cocoiiiiiiiiiiicccc 1125
RPTAOOTOE. ... 1125
RPTAOOTTE. ..o 1125
RPTAOOT2E. ... 1125
RPTAOOT3E.......ciiiiiiiicciccccc 1126
RPTAOOTAE. ... 1126
RPTAOOTSE. ... 1126
RPTAOOTOE. ... 1126
RPTAOOTTE. ... 1126
RPTAOOTBE. ... 1126
RPTAOOTOE. ... 1126
RPTAOOZ0E........ccooiiiiiiiceiccccce 1126
RPTAOOZ2TE. ... 1126
RPTAOOZ3E.......c.oiiiiiciicicccccce 1127
RPTAOOZ24E.........coiiicccce 1127
RPTAOO25E..... ..o 1127
RPTAOOZ6E..........ccoiiiiiiiicc, 1127
RPTAOOZ5I.......coiiiiiiicccccccce 1128
RPTAODOZ6L........oooeiiiiciccc 1128
RPTAODO27I.....oviiiiiiiiiiceccccee 1128
RPTAOO3TE. ... 1128



Contents | vii

RPTAOO32I......coiiiiiiiccccc 1128 RPTIOO7 T 1134
RPTAOO33I......ceiiiiiiic e 1128 RPTIOO72E.......ciiiiiiiciccceecee 1134
RPTAOOB4E..........coiii 1128 RPTIOO72L....oomiiiiiiiiiiiiiiiiccce, 1134
RPTAOOSBSE.......coiciiciicicccccce 1128 RPTIOO73E......ciiiiicicieccces 1134
RPTAOOB6E.........ccooiiiiiiiciiiciccce 1128 RPTIOO7AE.......ccooiiiiiiiiicicccce 1135
RPTAOOSTE......ccooiiiiiiicciccceccecee 1128 RPTIOO7SE.......ciiiiicicciccccceeee 1135
RPTAOQOSBS8E.........cooeiiiiiciicccccc 1129 RPTIOTTOL o, 1135
RPTAOOBOE.......coiiiiciciccccccee 1129 RPTIOTT T 1135
RPTAOOA4OE.........ccooiiiiiiciicccece 1129 RPTIOTT2L. e 1135
RPTAOOATE. ... 1129 RPTIOTT3l e 1135
RPTAOOAZE.........oieieiiniceticcteceeeeeiee 1129 RPTIOTATE. ..., 1135
RPTAOOA3E.......coiiiiicicicccceecees 1129 RPTIOTAZE......ciiiicicccces 1135
RPTAOTOOW....oiiiiicicccce 1130 RPTIOTABE. ... 1135
RPTAOST8E......ccooiiiiiiicciccccce 1130 RPTIOTAAW. ... 1136
RPTBOOOSE.........cocooiiiiiiciiccccc 1130 RPTIOTAS5E......coiiiiiiiiccce 1136
RPTCOOO03E........cociiiiiiiciiiccceecceeccee 1130 RPTIOTABE......c.ooiiiiicicicicces 1136
RPTCOOO4E..........ciiiiiiiccee 1130 RPTJO063E.........cooiiiccccc 1136
RPTCOOOSE.........ccoiiiciicciiccccece 1130 RPTJOO7SE......coiiiiic e 1136
RPTCOOOBE..........ccocoiiiiiiiiiiiiiiiciccce 1130 RPTJTOO2E. ... 1137
RPTCOO008LI........cooiiiiiiiicicccccee 1130 RPTJTOO3E. ... 1137
RPTCOO0020E.........cccciiiiiiiiiiiciccce 1130 RPTJTO04E. ... 1137
RPTCTO0TW. ... 1131 RPTJTOO0SE.......ooiiiiccccccc 1137
RPTCTO02W......coiviiiiiiiiiiiccccecc 1131 RPTJTOOGE. ..., 1137
RPTCTO09......oiiiiiccccece 1131 RPTJTOOTE. ... 1137
RPTCTOTT L 1131 RPTJTO08E.........ciiiiccccce 1138
RPTCTOT2L s 1131 RPTJTO09E........ooiiiiciceccc 1138
RPTCTOT3l i 1131 RPTJTOTOE. ... 1138
RPTCTOTAL .o 1131 RPTJTOTTE. ..o 1138
RPTCTO0TSL e 1131 RPTITOT2E. ... 1138
RPTCTOTON....eeiiiiiiiccccccccs 1131 RPTITOT3E. ..o 1138
RPTCTOT7 i 1131 RPTJTOTSBE. ... 1139
RPTCTOT8I e 1131 RPTJTOTOE. ... 1139
RPTCTO0TON .o 1132 RPTITOTTZE. ..o 1139
RPTCT0201......coiiiiiiiiiiiceccceccs 1132 RPTJTOT8E. ... 1139
RPTCTO2T i 1132 RPTJTOTOE. ..., 1139
RPTCTO30E........ciiiiiiiiiiiiccciecceecceae 1132 RPTJTO20E........cooiiiiiiciiececece 1139
RPTCTO03TE....ciiiiiiiiccccee 1132 RPTITOZ2TE. ... 1139
RPTCTO32E.......coiiiiciiiciicceccecee 1132 RPTIOT2T N 1140
RPTDOOTTW...oiiiiiiiiiiiiiccccces 1133 RPTJTO22E........coiiiic 1140
RPTEOOOSW......ooiiiiiicccccee 1133 RPTJTO23E.....c.oiiicicctiecccc e 1140
RPTEOOTTW ..o, 1133 RPTJTO024E........ooiicc 1140
RPTEOQTATE. ..o 1133 RPTJTO25N.....ciiccccceccee 1140
RPTEOTS0E........cociiiiiiiiiiciccc e, 1134 RPTJTO261.......coiiiiiiiiciicccs 1140
RPTHOT30I.....oiiiciicicccce, 1134 RPTJTOB0E.......ooiiiiiicciicec e 1140
RPTHO4OE. ... 1134 RPTITOATE. ... 1140
RPTIO069E........cccoooiiiiiiiciiecieccee 1134 RPTJTOA2E. ... 1140
RPTIOO70E.......cccoiiiiiiiiiiiciicccce 1134 RPTJTO43E. ... 1140

vii



viii

Contents | viii

RPTJTO44E........oiiiicccce 1141
RPTITT00L .o 1141
RPTJTTOTE. ..o 1141
RPTITTO2W...oiiicicicecece, 1141
RPTITTO3W...ooiiiicee 1141
RPTJTTOAE. ... 1141
RPTJTTATE. i 1141
RPTITTA2E. ... 1141
RPTJT200W....oiiiiiiiiiceccee 1142
RPTJT220E.......iiiiiccccceee 1142
RPTIT22TE. ..ot 1142
RPTJT240E........ccooiiiiiccecccce 1142
RPTJT24TE. ... 1142
RPTJT242E......ooiicccccee 1142
RPTJT244E. ... 1142
RPTJT248E.......ciiiiiiiiiics 1142
RPTJT26TE. ... 1142
RPTJT270E. ... 1143
RPTIT27TE .ot 1143
RPTJT280E........coiiiiiiccccccccees 1143
RPTJT4001. ..., 1143
RPTKOOOOL......cociiiiiiiciiscici e 1143
RPTKTOOTE. ... 1143
RPTKTOTOE. ... 1143
RPTKTOTOE. ..., 1144
RPTKTO20E.........ccoiiiiiiiicecceccee, 1144
RPTKTO2TE. ...ttt 1144
RPTKTO22E.......ooiiiciccccecee 1144
RPTKTO023E.......oiiiiieiiccccee 1144
RPTLOOOTW. ... 1145
RPTLOOOZW......c.coiiiiiiiiiiiiiiccccs 1145
RPTLOOO3W......oiiiiiiiiicccccecccees 1145
RPTLOOOAW. ... 1145
RPTLOOOSW......iiiiiiiiiiccccceeeee 1145
RPTLOOOOW.........cooiiiiiiiiiicicccc 1145
RPTLOOO7W.....oviiiiiiiiiiicccccecieees 1145
RPTLOOOSE.........ccociieiiecicccee 1145
RPTLOOOO......ciiiiiiiciiccccceeeee 1145
RPTLOOTOE.......c.ciiiiiiiiiiiiiccccccce 1145
RPTLOOTTE. ..o 1145
RPTROOOOW.......ccoiiiiiiiiiiccccccec 1146
RPTROOOTW ... 1146
RPTROOO2W.......ocoviiiiiiiiiiiciicccce 1146
RPTROOO3W.....cooiiiiiiiiiiiiiiicccccceccee 1146
RPTROO04AW.......ooiiiiiiiiiiccccce 1146
RPTR200TE......cciiiiiiiiciicccececee 1146
RPTR2003W.......ocoiiiiiiiiiiiiiicccccce 1146

RPTSTOOOE........ccoiiiiiiiiiccc 1146
RPTSTOO0ZE.......cooiiiiiicicccece 1146
RPTST5T0E.......oiiiiiiiiic e, 1147
RPTSTOO0T .o 1147
RPTSTOO0AL.....ooiiiiiccccee 1147
RPTXO00TE. ... 1147
RPTXO0002E........cocooiiiiiiiciiciccc 1147
RPTXO0003E.......cooiiiiiciiiciccccccce 1147
RPTXO004E........c.ccooiiiiiicicc 1147
RPTXO00SE........ocoiiiiiiicicciccecee 1147
RPTXO0006E.........ccccooiiiiiiiiiiciicc 1148
RPTXO007E.......ciiiiiiciicicccccccees 1148
RPTXOO008E.........ccooiiiiiiiiciiicccccee 1148
RPTXO009E.......ccoiiiiiiiiciccccciecee 1148
RPTXOO0TOE.......coiiiiiiciiciicccc 1148
RPXDOO022W......cooiiiiiiiiiiciieceeeceecees 1148
RPXEQOB T 1149
RPXESS02E.......cooiiiiiiiiccicccce 1149
RPTXTOTOL ..o, 1149
RPTXTOTT e 1149
RPTXTOT 2L 1149
RPTXTOT 7] 1149
RPTXTOT8I...oiiiiiiciccce, 1149
RPTXTOTOL .o 1149
RPTXTO8TE. ... 1149
RPTXTO82E......coiiiiicccciccecee 1150
RPTX200TE......ciiiiiiciiciccccc 1150
RPTX2002E.......ccooiiiiicicicecccce 1150
RPTX2003E......ccooiiiiiiiiiieccccccece 1150
RPTX2004E........cocooiicccecee 1150
RPTX2005E........ccooiiiciiciiccc 1150
RPTX2006W.......ccoomiiiiciiiciiiciccceeccce 1150
RPTX20071.....ociiiiiiieiiccee 1150
RPTX2008I......coiiiiiiiiciiicccccee 1151
RPTX2000........coiiiiiiiiiiccccce 1151
RPTX20T0.....coiiiiiciccccecee 1151
RPTX20TTE. ..o 1151
RPTX20T2E......ciiiiiccccccecee 1151
RPTX20T3E.....coiiiiiiciiccc 1151
RPTX20T4E. .. ..o 1151
RPTX20T5E......ciiiiiecccece 1151
RPTX20T61......ceiiiiiiiccccecee 1151
RPTX20T7E. ..ot 1151
RPTX20T8W.....coiiiiiiiciiiccccccece 1151
RPTX20T9...iiiic 1151
RPTX2020L......coiiiiiiiiiciiiciiiccceeee 1152
RPTX202TE......ciiiiiieieincietccteeeeeeciee 1152



RPTX2023W....cooiiiiiiiiciiicccce

RPTX2027W
RPTX2029W

RPTX2061W
RPTX2062W
RPTX2063W

RPWFOO11E
RPWFO0012E
RPWF0021E
RPWF0032E
RPWFO051E
RPWF0052E
RPWFO056E
RPWF0066E
RPWF0071E
RPWF0072E
RPWF0074E
RPWF0075E
RPWF0076W
RPWF0081W
RPWF0082W

Contents | ix

RPWFOOS83E.........ccooiiiiiciiicccce 1157
RPWFOOBAE..........cocoiiiiciiciece 1157
RPWFOOB8SE.........ccccoiiiiiiiiciccccce, 1157
RPWFOTOTE. ..., 1157
RPWFOTO2E.......cooiiiiiiicicccce 1157
RPWFOTO3E......ccoiiiicceccee 1157
RPWFOTO4E. ..., 1157
RPWFOTTTE. ... 1157
RPWFOTT2E. ..o 1157
RPWFOT2TW....oiiiiiiiiiccccceee 1157
RPWFOT22W....oiiiiiiiiiieiiiicictceeeeeees 1157
RPWFOT23W.....oiiiiiiiiiccccececcee 1158
RPWFOT24W....c.ooiiiiiiiiiccce, 1158
RPWFOT30W....ciiiiiiiiiiiciecceeccee 1158
RPWFOT3TW. ..o 1158
RPWFOT32E.......ociiiiiiiiiccccccce 1158
RPWFOT40E........cccooiiiiiiiiccce 1158
RPWHOOO7W......coiiiiiiiiiiicicicceceiee 1158
RPWHOOOOW.......cocviiiiiiiiicice, 1158
RPWHOOTOW. .....ooiiiiiiiciciccces 1158
RPWHOOTZE........ccoiiic 1158
RPWHOOTAE... ... 1158
RPWHOOTSE.........cooiiiiiiiiiciicece, 1158
RPWHOOTEE.........c.ooiiiiiiiiicicciece, 1159
RPWHOOTTE......coiiiccc 1159
RPWSOO00TE.....c.ooiiiiiicieiiicceeccices 1159
RPWSOO002E.........ccooiiiiiiiiicccce 1159
RPWSOO003E........cccoiiiiiiciiccccecee 1159
RPWSOO004E.........cooiiiiiiiiiciciccccs 1159
RPWSO0005E.........coooiiiiciiicieccccccie 1160
RPWSOO006E..........cccociiiiiiiiiiccce, 1160
RPWSOO00TE.......cociiiiiiiciicccceeceee 1160
RPWSO0008E..........ccoiiiiiiiciiiccccs 1160
RPWYOOOZE.........cooooiiiiiiiiiiicieececeeee 1160
RPWYOO003L.......cooviiiiiiiiiiicccccccce 1160
RPWYO004W......ccooiiiiiiiiiiiiccccceccee 1161
RPWYOOOSE.........cocooiiiiiiiiiciiicece 1161
RPWYOQOOGE..........cccooiiiiiiiiiciiiciecee 1161
RPWYOOOTE.......ccoiiiiiiiiiiiciicccc 1161
RPWZIOO0O02E..........ccocoiiiiiiiiiicciccccees 1161
RPXDOOOTE.......coiiiiiiiiiciccccccen 1161
RPXDOOOZE........cocooiiiiiiiciciiciciccceeee 1161
RPXDOO0SE........ccocoiiiiiiiiiiiiiiiciiccee 1161
RPXDOOOAE........ccoooiiiiiiiicicccecce e 1161
RPXDOOO0SE........ccoiiiiiiiiciiccicccee, 1161
RPXDOOOGE..........ccooeiiieiciicicicccecee, 1162
RPXDOOOT7F......cocoiiiiiiiiiiiiiiiccicccce 1162



Contents | x

RPXDOOT7W...ooiiiiiiiiicccccc 1162
RPXDOOT8E.......cccooiiiiiiiiciccceccece 1162
RPXDOOTOE.......cooiiiiiiiiiiicccccce 1162
RPXDOO020E.........cooiiiiiiiiiiecicecciceeccee 1162
RPXDOO2TE......ooiiiiciiiciicccec 1163
RPXDOO2TW....ooiiiiiiiiiiiicccceee 1163
RPXEOOOTW....oooiiiiiiiiiiiiiiicccce 1163
RPXEOOTOW. ... 1163
RPXEOOTTW ... 1163
RPXEOOT2W....ooiiiiiiiiciiiciiccecccece 1163
RPXEOOT3W....oooiiiiiiiiiiiiiiicccce 1163
RPXEOOTAW. ... 1163
RPXEOOTEW....ooiiiiiiiciicccece 1163
RPXEOOTOW.....oviiiiiciiicccceccecee 1163
RPXEOOT7W....oiiiiiiiiiiiciiiccccccce 1163
RPXEOOT8W......oiiiiiiiiiiicccceccece 1163
RPXEOOTOW....ooiiiiicccccec 1164
RPXEOO2TW ..o 1164
RPXEOO23W.......cooiiiiiiiiiiiiiiiicccce 1164
RPXEOO24W.......cooiiiiiiiiiiiiciicceecee 1164
RPXEOO25W.....ocoiiiiiiiiiiciiccce 1164
RPXEQO27W.....ooiiiiiiiiciiiciicceccece 1164
RPXEOO28W.......cocuiiiiiiiiiiiiiiciicccce 1164
RPXEOO29W......omiiiiiiiiciccceceecee 1164
RPXEOO30W......oiiiiiiiiiiciicccccece 1164
RPXEOO3TW. ..o 1164
RPXEOO33W......ooiiiiiiiiiiiiiciciccccce 1164
RPXEOO35W.....c.oiiiiiiiiiiiccceccecee 1164
RPXEQO36W......c.ooiiiiiiiiiciiicccccc 1165
RPXEQO37W.....oiiiiiiiiciiiciiccecececee 1165
RPXEOO38W.......cooviiiiiiiiiiiciiciccccce 1165
RPXEOO3OW......oiiiiiiiiiiicccecece 1165
RPXEOO40W......c.oiiiiiiciiiiciiicccccec 1165
RPXEOO4TW ..o 1165
RPXEOO42L.......ooooiiiiiiiiiicciicccc 1165
RPXEOO43L......coiiiiiiiciiiccececceeeea 1165
RPXEQO44AW.......oiiiiiiiiiiiiicccce 1165
RPXEQO45W......ooiiiiiciiiciicceccece 1165
RPXEOO46W.......cocoiiiiiiiiiiiiiciccicce 1165
RPXEOOATE...... oo 1165
RPXEQO48W........coiiiiiiiiiciiicccee 1166
RPXEQO4OW.....ooiiiiiiiiiciicceccece 1166
RPXEOOSOW......oviiiiiiiiiiiiiiiccccce 1166
RPXEOOSTW. ..o 1166
RPXEQOS2W.....ooiiiiiiiiiiiciciccccec 1166
RPXEOOS3W.....ooviiiiiiiiciiiciicceccecee 1166

RPXEOOSAW......cooiiiiiiiiiiiiiicccce 1166

RPXEQOSSW.....ouviiiiiiicccc, 1166
RPXEQOSOW........cuiiiiiiciiiccccceceee 1166
RPXEOOSTE.......ccoiiiiiiiciiiciicce e, 1166
RPXEOOS8E.........ccoiiieiiiciiciccceecc e 1166
RPXEQOSOE........cooiiiiiicccc 1166
RPXEQOGOE..........ccooiiiiiiicicicicccceee 1167
RPXEOTOOW......oiiiiiiiiiiiicicccc 1167
RPXEOTO2W......oiiiiiiciicicecccc e 1167
RPXEOTOBW.....oiiiiiiiiicccccc, 1167
RPXEOTOAW.....oiiiiiiiicceeceee 1167
RPXE250TE.......cooiiiiiiiciiciccce, 1167
RPXE2550E.........ccoiiiiiiiiiiccicccce e 1167
RPXE2552L.....ooiiiiiiiiiiiiciicee 1167
RPXE2900E.........ccooiiiiiiiccicicceeee 1167
RPXE290TW.....oiiiiiiiieieiceteeeeeeeee 1168
RPXE4000W......cooiiiiiiiiciciccccccees 1168
RPXE4O0TE.....c.ooiiiiiii e 1168
RPXE4O02E.......cccooiiiiiiiccicccece 1168
RPXE4003E........ccooooiiiiiiiiicicccccce, 1168
RPXE4Q04E.........ccoiiiiiiiiciccceccce 1168
RPXE4O05E........cccooiiiiiiciiiccce 1168
RPXE4O06E.........cccooiiiiiiicicicicccee 1168
RPXE4QO07E.......ccccooiiiiiiiiiiciiccc e 1168
RPXE4008E.........cciiiiiiiiiicicccece e 1168
RPXE4008I.......ccoieiiiiiiiiciicccce 1168
RPXE4000L.......cooiiiiiiiiicieciecceeee 1168
RPXE40T0L.....ciiiiiiiiiiiiiiicccccce 1169
RPXE4OTTE. ... 1169
RPXE40T3l..ccciiiiiiiiiiiccccee 1169
RPXE4OTAE. ... ..o 1169
RPXE4OT5E.......cocooiiiiiiiiiciccc e, 1169
RPXE4OTOE........ocoiiiiiicicciccccce 1169
RPXEAOT 71 1169
RPXE4OT8E.......coiiiiiiiiccccce 1169
RPXEAOTOE.. ..ot 1169
RPXE4020E.........ccciiiiiiiiccicccece e 1169
RPXE4O2TE. ... 1169
RPXE4O22E.......ccooiiiiiiii e 1169
RPXE4023E.......ccoiiiiiiiiiicicccce, 1170
RPXE4024E.........ccoiiiiiiiiiiciccceccce 1170
RPXE4025E........coiiiiiicc 1170
RPXE4O26E........cccooiiiiiiiccicccce 1170
RPXEAO27E.......ooieiineiiiieeeeeeeeeeeeee 1170
RPXE4028E.........cciiiiiiiiiiicciccceccee 1170
RPXE4020E........coiiiicc 1170
RPXE4OS0L.......ooiiiiiiiiiccccccee 1170
RPXE4TOOW.....ooiiiiiiiiiiiicccccc 1170



RPXE4111W
RPXE4112W

RPXE4200W
RPXE4201W

RPXE4A204W......cooiiiiiiiiciiicicceee
RPXEA2TAW.....ooviiiiiiiiiciiiceccee

Contents | xi

RPXE4900L.......cciiiiiiiiiiciccece 1176
RPXEA9T0L.....oiiiiiiciiccccceee 1176
RPXEAGT Tcuiiiiiciiiceceececeeeeee 1176
RPXE4A9T 2L 1176
RPXE49T3l....ciiiiiiiicccce 1176
RPXEAOTAL.....oiiiiiiiiiiccccccee 1176
RPXEA9T51....iiiiiiiciiceeceeee 1176
RPXE49T06L......coiiiiiiiiiiiiccicccce 1176
RPXEAOT 71 1176
RPXEAOT8I.....oiiiiiiiciiiccccccee 1176
RPXEA920L.......coiiiiciiiiceeceeceeee 1177
RPXE4A92T1....oiiiiiiiciccecccce 1177
RPXE4930L.......ooiiiiiiiiiiiiiccccce 1177
RPXEAO3TI..oiiiiiiiiiciiiccccee 1177
RPXEA932L.....ooiiiiiiiiciiicieecececeeeee 1177
RPXE4940L.......ooiiiiiiiiiiccieeccccee 1177
RPXE494TI....ooiiiiiiicccee 1177
RPXEAG42L.......ooiiiiiiiiiiciicicccce 1177
RPXEA944AW.....c.ooiiiiiiiiiicetieceeeeee 1177
RPXE4945W......coiiiiiiiiiicccece 1177
RPXE4948W........oiiiiiiiiiiicice, 1177
RPXEAO50L.......ooiiiiiiiiiciceccce 1177
RPXEAOS52E.......cooiiiiieiiiiceeceeeeeee 1178
RPXES30TE......cooiiiiiiiciciecc e 1178
RPXES305E.......cccoiiiiiiiiciiiccce 1178
RPXES330E.......coooiiiiiicciceeceee e 1178
RPXESS500W......cooviiiiiiiiiiiiiccce 1178
RPXESS0TW....oiiiiiiciiciccecees 1178
RRITOOOTE. ... 1179
RRITOOOZE.........ccociiiciiicicccceeeeeee 1179
RRITOOO3E........c.ooiiiiiiiiiciccce 1179
RRITOOOAE........c.ooiiiiiiiciec e 1179
RRITOOOSE.......c.ooiiiiieiiiccccccce 1179
RRITOOOBE..........cociiiiciiiicicicceeeee 1180
RRITOOOTZE........cooiiiiiiiciiiciccccc 1180
RRITUITOOZW......comiiiiiiiiccccccceees 1180
JMXEOOQOSE.......cociiiiiicce, 1180
DCRCOOOTE. ...t 1180
DCRCOOOZE.........ccoiiiiiiiciiciccccce 1180
DCRCOOOSE........cocciiiciiicciccececcecceee 1180
DCRCOOOBW.......c.ecmiiiiiiciiicicicccee e 1181
DCRCO0O0OW.......iiiiiiiiciicecceceeeeeeee 1181
DCRCOOTOE.......ccooiiiiiiiiiiicccce 1181
DCUIOOO0TE......ciiiiiiiiciiiciic e 1181
DCUIOO0SE........cooiiiiiiiiccccccceee 1181
DCUIOOOAE..........ooiiiiieiciicecccceeee 1181

DCUIO00GE..........ccciiiiiiiciiiciccc e, 1181



Contents | xii

DCUIOO07W......eieieeee ettt 1181 NOTICES. ..o mcclx
DCUIOO08BW......ueveeieeereieeecieieeeeteeiee e 1181 INAEX.c.eeieeiiict ettt
DCUIOOQOE........ciiiieeirieieeeieeieeieeeeeie e 1181
DCUIOOTOE.....c.ccieieieeieieieeeieieeeee et 1182
DCUIOOTTE. .iiiuieeiieieeieieiee et 1182
DCUIOOT2E.....cicioiiieieeieieeeeeeeeeeeie e 1182
DCUIOOT3E.....cieiieieeirieieeeeieeeeeeieeeeeee e 1182
DCUIOOTAE.....cicieieieieieieteieeeeeee e 1182
DCUIOOTSE.......ociiieieeiiieieieieieeeeieiee e 1182
DCUIOOTBE........cioviieeicreieeieteeeeeereieeeeeveeeeeas 1182
DCUIOOTTE. ... it 1182
DCUIO998E........ccoieieeiiieieeieieieeeeeeseeeeee e 1182
Additional error messages.........ccoeeeeieiieneneeeenenns 1182
Address already in US€........cccoceeieiecienieeienee. 1183
Browser profile in USe........c.ccoeveieiiciiiieiene, 1183
Cannot open test........ccoevveeieiiecieieeeeeee 1183
Connection closed.........ccooveeieiiniieeieeeee 1184
Dataset accessed using different modes......... 1184
Error binding to port..........cccocoeiiiiieiiii 1184
Error connecting to license server.................... 1184
No local agent controller............cccceveieeieennen. 1185
Performance Test Errors were found in the
PrOJECT ..ttt 185
Test run aborted.........coocooveiiiieieee, 1185
Test run aborted due to error...........cccccveueennee. 1186
Testgen completed with warnings.................... 1186
Variable not initialized...........ccccocevvevirinieiennnn. 1186
Chapter 11. Reference Guide..........cccceeeeeieiiiiiiiiiinnnane 1188
Accessibility features...........coooevecieveniiieieieeee 1188
Keyboard shortcuts for performance and service
TESTING. .. 1188
General reference for performance testing.............. 1190
Data correlation rules..........cccocooevieeinineneeennne 1190
Error conditions..........cceeveerieiiinieieceeeeen 1191
Resource monitoring data sources................... 1193
Ul preferencCes.........coeeeeeieienieieeieeieieeieee e 1194
HTTP preferences..........cccceevevivieniccieieeiieene 1195
SAP test preferences...........ccccoveeveeieiieennennn. 1201
Citrix recorder preferences..........cccccceveeeeennn. 1203
Socket Test Generation preferences................. 1208
Citrix monitoring panel reference...................... 1210
Proxy recording preferences.........cccccevvruennnene 1211
Test editor preferences...........ccccooeveeveeeeeeneene. 1211
Report preferences...........ccoceevevieeieiecienieenenees 1213
Test editor references.........cccceeeveveveeerenieneennns 1215
VU Schedule editor reference...........cccceevenveeee. 1246
WSDL security editor reference.........c.cccceeveverveennen. 1253
Security Considerations...........cccccoeeeieiecienene e, mcclix

Xii



Chapter 1. Release notes for DevOps Test Performance
2025.12 (11.0.7)

This document includes information about the new features introduced, features deprecated or removed, defects fixed,
and known issues identified in this version of HCL DevOps Test Performance (Test Performance). You can also find the

installation and upgrade instructions along with the contact information of HCL Customer Support.

Product description

Test Performance is a scripting-free environment for automating load and scalability testing of web, ERP, and server-based
software applications. Test Performance provides rich and customizable reporting to help you identify the presence and
cause of system bottlenecks. It captures the network traffic that is rendered when the application under test interacts

with a server. This network traffic is then emulated on multiple virtual users while you play back the test. See DevOps Test

Performance overview on page 100.

What's new

You can find information about the features introduced, enhancements, or other changes in Test Performance. See What's
New on page 14.

Deprecated features or capabilities

To find information about the features or capabilities that are deprecated in this version and are planned for removal in a

future release, see Deprecations and removals on page 30.

Removed features or capabilities

To find information about the features or capabilities that are removed in this version, see Deprecations and removals on

page 30.

Product download and installation

If you have purchased the licenses to use the product, you can download the product software packages from My
HCLSoftware (MHS) .

For instructions about installing the product software, see Installation of DevOps Test Performance on page 134.
Product upgrade
For instructions about upgrading the product software, see Product upgrade and migration on page 170.

Defect fixes and known issues

For the list of defects fixed in this version that include defects submitted by customers and defects found during testing, see

Defect fixes on page 40.

13


https://hclsoftware.flexnetoperations.com/flexnet/operations/logon.do
https://hclsoftware.flexnetoperations.com/flexnet/operations/logon.do

HCL DevOps Test Performance

For the list of known issues that are identified in this version and the previously published known issues that are still

applicable, see Known issues on page 50.
Contacting HCL support

« For technical assistance, contact HCL Customer Support.

« Before you contact HCL support, you must gather the background information that you might need to describe your
problem. When you describe a problem to the HCL support specialist, be as specific as possible and include all
relevant background information so that the specialist can help you solve the problem efficiently. To save time, know
the answers to these questions:

> What software versions were you running when the problem occurred?

> Do you have logs, traces, or messages that are related to the problem?

> Can you reproduce the problem? If so, what steps do you take to reproduce it?

o |s there a workaround for the problem? If so, be prepared to describe the workaround.

What's New

You can find information about the features introduced, enhancements, or other changes made in HCL DevOps Test
Performance (Test Performance). You can also find the features that were introduced in previous versions of Test

Performance. DevOps Test Performance is the new name of HCL OneTest™ Performance from 11.0.0 onwards.

What's New in DevOps Test Performance 2025.12 (11.0.7)

The following section lists the features, enhancements, or other changes made in Test Performance.

Feature title Description

Support for testing on SAP GUI Test performance now supports recording and playback of tests on both 32-bit and
8.0 64-bit SAP GUI 8.0. See SAP performance testing guidelines on page 381.

What's new in earlier versions

You can find information about the features introduced in previous versions of Test Performance in the following sections.

* What's New in 11.0.6 on page 15
« What's New in 11.0.5 on page 15
« What's New in 11.0.4 on page 15
« What's New in 11.0.3 on page 15
* What's New in 11.0.2 on page 16
« What's New in 11.0.1 on page 16
« What's New in 11.0.0 on page 16
« What's New in 10.5.4 on page 17
* What's New in 10.5.3 on page 17
« What's New in 10.5.2 on page 18
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- What's New in 10.5.1 on page 19
« What's New in 10.5.0 on page 20
* What's New in 10.2.3 on page 21
« What's New in 10.2.2 on page 23
« What's New in 10.2.1 on page 24
« What's New in 10.2.0 on page 25
* What's New in 10.1.3 on page 26
« What's New in 10.1.2 on page 26
« What's New in 10.71.1 on page 28
« What's New in 10.71.0 on page 28

What's New in 11.0.6

There are no announcements on the features or enhancements in Test Performance this time.

What's New in 11.0.5

Feature title Description

Improved visual design and user |You can now view PT analytics reports with a consistent look, updated styles, colours,
experience for web analytics fonts, and layout.

reports

What's New in 11.0.4

There are no announcements on the features or enhancements in Test Performance this time.

What's New in 11.0.3

Feature title Description
Rollout of the new license and HCL DevOps Test Performance licenses and downloads from version 11.0.3 onwards
download portal are now available on the My HCLSoftware (MHS) portal. MHS is a cloud-based web

application designed to help you manage your software entitlements and licenses
effectively and this portal replaces HCLSoftware License & Download Portal (FlexNet
Operations Cloud). See License management on page 164.

Enhancement to Test HCL DevOps Test Performance Agent is enhanced with a new parameter known
Performance Agent configuration | as, Server Path Context. Now, when you install Test Performance Agent by using
Installation Manager, Install Anywhere, or by configuring the maj or dono. confi g
file, this new Server Path Context parameter is included. This enhancement ensures
that the Server Path Context value set during the installation of the agent, as well as the
value configured in the maj or dono. conf i g file, aligns with the value configured on
Test Hub.
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What's New in 11.0.2

The following section lists the features, enhancements, or other changes made in Test Performance.

Feature title Description
Support for You can now install Citrix on Windows 64-bit operating systems. The option to install the 32-bit
Citrix on installers of Citrix is disabled to ensure easier setup and compatibility of Citrix installations with newer

Windows 64-bit | environments.
operating
systems

Changes to the | The Citrix test runs across scheduled tests, standalone tests, and compound tests are changed by

Citrix test runs | disabling and enabling of certain features as follows:

» The Monitoring Panel feature is disabled for Citrix test run in a schedule. See Enabling and
disabling the Citrix monitoring panel on page 842.

» Long Run mode is enabled for Citrix test run in a schedule. See Running long duration Citrix tests
on page 783.

» The Monitoring Panel is enabled for standalone tests and compound tests. By enabling the

Monitoring Panel for these test types, you can observe and effectively debug issues.

DevOps Test Performance Agent for AIX 11.0.2 now supports Java 17 as a part of installation.

S rt f
fpport for Additionally, this update introduces a new requirement that you must install IBM XL C/C++
Java17in
v ! for the AIX library before you install Test Performance. For more information, refer to
DevOps Test . . . .
https://www.ibm.com/support/pages/ibm-xI-cc-runtime-aix-161#DNLD.
Performance
for AIX 11.0.2

What's New in 11.0.1

The following section lists the features, enhancements, or other changes made in Test Performance.

Feature title Description

Enhanced the Ul for dataset The CSV Editor, which is used for editing datasets in Test Performance, currently

editing features an improved user interface. You can now experience changes in the
presentation of pages and the methods to configure and edit datasets in the Ul.

What's New in 11.0.0

The following section lists the features, enhancements, or other changes made in Test Performance.
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Feature title

Description

Renaming of OneTest products | The following OneTest products have new names starting from 11.0.0:

« HCL OneTest™ Performance is now HCL DevOps Test Performance.
* HCL OneTest™ APl is now HCL DevOps Test Integrations and APlIs.
« HCL OneTest™ Server is now HCL DevOps Test Hub.

» HCL® OneTest™ Embedded is now HCL DevOps Test Embedded.

« HCL OneTest™ Virtualization is now HCL DevOps Test Virtualization.
* HCL OneTest™ Studio is now HCL DevOps Test Workbench.

Changes to the Licensing

environment variables

With the renaming of HCL OneTest Products to HCL DevOps Test Products in 11.0.0,
the HCL Licensing environment variables that contained "ONETEST" are changed

to be used without "ONETEST". For example, the HCL_ONETEST_LICENSING_URL
environment variable now must be called HCL_LICENSING_URL.

Note that the old environment variable names are still supported.

What's New in 10.5.4

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Support for JSONPath in
data correlation rules

You can now use data correlation rules to create references by using JSONPath, in addition

to using regular expressions.

Support for Citrix Workspace
App 23.03

HCL OneTest™ Performance now supports Citrix Workspace App 23.03. Recording a Citrix
test on page 401

What's New in 10.5.3

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Support to control test runs

for error handling

A new error condition Test Verdict Failed is added to Error handling to manage the test
when the overall verdict of the test is failed. The error condition can control the behavior of
the test and can contribute to the health of the test. See Error conditions on page 1191.

Support to delete any row or

all rows in datasets

You can now use new two methods to delete rows in a dataset. When you use

IDatasetController in a custom code, you can use the following two methods to delete rows:
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Feature title

Description

IDatasetController.deleteRows(fromindex, tolndex) - You can use this method to specify a

range of rows to delete. The index starts at 1.

IDatasetController.deleteAllRows() - You can use this method to delete all the rows in the

dataset.

See Deleting rows in a dataset on page 878.

Customizing names of
exported statistical reports

You can now specify a pattern that defines the file names of the exported statistical reports

when you run tests from the command line. See Command-line parameters on page 800

Support for Revenera
2022.12

With Revenera 2018.02 (LLS 1.0) reaching EOS, you can now use Revenera 2022.12 (LLS
3.0) as a local license server to host licenses for HCL OneTest™ Performance.

What's New in 10.5.2

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Error reports for dropped

connections

Previously, during test runs or schedules, the system under test occasionally dropped
the connection, however, the error was reported as a server timeout. HCL OneTest™
Performance now reports the error condition for a dropped connection separately. See Error

conditions on page 1191.

Support to view the type
of correlation for Test

References

You can now view the type of correlation that is configured for Test References from the
Type column on the Test Editor -Test References page for HTTP tests. You can also view the
reference type in the Details tab on the Test Element properties page. (Data Correlation >
Show References > Test Editor- Test References > Properties > Test Element Properties
> Details).

The types of correlation are Auto, User, or Rule.

See Viewing references on page 643.

Changed the assets.xml to

assets.yaml

HCL OneTest™ Performance now writes details of the assets to the assets.yaml file, which
was previously written to the assets.xml file. You can view the assets.xml file is deleted and
new assets.yaml file is added. You can now easily check in and merge the assets.yaml file

when there is a conflict.

18
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Feature title

Description

Support for Instana

integration

You can now integrate Instana with HCL OneTest™ Performance to enhance data
collection in performance tests. When you select the Enable Instana option, HCL OneTest™
Performance filters the HTTP headers and adds them to the request in tests to collate data

about the pages and transactions.

See Using Application Performance Management in a schedule on page 725

Enhancement to an IF

condition comparison

HCL OneTest™ Performance is now enhanced to perform a digit comparison when you
apply an IF condition to a test or a schedule. If the digit comparison in the IF condition is
successful, the result is displayed as true. Otherwise, it is displayed as false. See Adding

conditional logic on page 567.

Enhancement to the

command line option

Previously, to run all the test assets from the specified folder path, you created a batch file
and ran the test from the command line. The command line option is now enhanced so
that you can run multiple test assets at a time by using the wildcard character * enclosed in
quotes. You can use * in different combinations to specify any or all test assets that are in a

folder. See Running multiple tests from the command line on page 823.

Support for TLS 1.3

HCL OneTest™ Performance now supports TLS 1.3. You can record websites that support
TLS 1.3 and play back the recorded test.

What's New in 10.5.1

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Removed option to discard
time measurements for
unhealthy transactions from

preferences

Previously, you were able to select the option to discard time measurements for unhealthy
transactions in the Test Execution Preferences (Windows > Preferences > Preferences >
Test > Test Execution). You can now select the option in the Details tab of a schedule. See

Schedule properties on page 1246.

Enhancements to address
the reporting of failed

requests

Previously, HCL OneTest™ Performance did not include the response times in the
performance reports when the primary requests failed, and this might have caused the

reports to be misinterpreted. HCL OneTest™ Performance is now enhanced as follows:
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Feature title

Description

- The response codes are included in the response code verification points as the
default option. You can disable the default option from the preferences, if you want
the response codes to be ignored.

« The option to discard the response times for the pages that fail is now provided for
a schedule. HCL OneTest™ Performance reports the response time for unhealthy
pages as the default option.

« The Performance report summary displays the healthy pages recorded as a
percentage.

Viewing the Page Details and
Page Element Details report

You can now view two new reports namely, Page Details and Page Element Details. These
reports are added to the HTTP Performance report. In the Page Details report, you can view
the summarized statistics of every page. In the Page Elements Details report, you can view

the summarized statistics of page elements. See Performance report on page 1011.

What's New in 10.5.0

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Support to run tests or
resources as a GitHub

Action

You can now run tests that are contained in HCL OneTest™ Performance as a GitHub Action
from a Git repository. See Configuration of test runs as a GitHub Actions Workflow on

page 219.

Enhancements to the

Jenkins plugin

You can now define the build parameters during the configuration of either Freestyle or
Pipeline projects in Jenkins. You can then use those build parameters to run the Jenkins
job. See Build parameters for Jenkins on page 304.

Support to show or hide SAP

GUI during the test runtime

You can now change the behavior of the display of SAP GUI during the test run time
irrespective of preferences that you configured in GUI on execution section. See Changing

preferences for SAP test generation on page 396.

Support to modify regular
expressions for SAP Object

Identifier

You can now modify the identifier of an SAP script object by updating the regular
expression in the SAP GUI Object Information section. See SAP set details on page 1228.
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Feature title

Description

Enhancement to test reports

You can now copy the contents of the table, which is in the HTML format, from the web

©

analytics reports by using the Copy icon . See HTTP performance test reports on

page 1010.

Support for the Application
Performance Management
(APM) in a schedule

You can now use AppDynamics application with HCL OneTest™ Performance to enhance
the data collection by adding filters based on HTTP headers that you used in tests. See

Using Application Performance Management in a schedule on page 725.

What's New in 10.2.3

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Enhancements to integration

plugins

The following table lists the parameters added in HCL OneTest™ Performance 10.2.3 with

the checkmark

v
icon for each of the integration plugins:
Parameters Integration plugins
Azure IBM® MicroFocus | Ant Jenkins
DevOps UrbanCode™ | ALM
Deploy
and HCL®
Launch
v v v v v
Duration
v v v v v
Exportlog
v v v v 4
Publish
v v v v v
Publish_for
v v v v v
Publishrepo
rts
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Feature title Description
Parameters Integration plugins
Azure IBM® MicroFocus | Ant Jenkins
DevOps UrbanCode™ | ALM
Deploy
and HCL®
Launch
v v v v
Rate
v v v v
History
v v v
Exportstatsf
ormat
v v v
Labels
v v
Exportstatsh
tml
v
Exportstatre
portlist
v
Exportstats
v
Overwrite
v
Configfile
v
Results
v
Usercomme
nts
v
Users
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Feature title

Description

The following topics provide more information about parameters for each of the integration

plugins:
« Running tests from Azure DevOps as a Pipeline job on page 191
« Configuring the process in UrbanCode Deploy on page 285
« Configuring the process in HCL Launch on page 254
« Configuring test scripts in Micro Focus ALM on page 335
 Running tests by using Ant on page 176

« Configuring the Freestyle project in Jenkins on page 307

Viewing test run results
on the Azure Test Plans
dashboard

When you use the HCL OneTest Studio extension in Azure DevOps pipelines to run
performance test assets, you can now view the results of the test runs on the Test Plans
dashboard of Azure DevOps.

See Running tests from Azure DevOps as a Pipeline job on page 191.

Support to auto-save the
load test profile details of

test assets

HCL OneTest™ Performance now automatically saves the load test profile details of tests,

compound tests, vu schedules, and rate schedules.

What's New in 10.2.2

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Support to run tests from the
Jenkins pipeline projects

You can now use the HCL OneTest™ Performance Jenkins plugin to run the test assets from
the Jenkins Pipeline projects. See Integration with Jenkins on page 303.

Support to add labels from
Jenkins

You can now add labels to test results when you run test assets from Jenkins by specifying
a value in the Labels field. See Configuring the Freestyle project on page 307 or Creating

a pipeline script from Jenkins on page 317.

Support to add labels from
Ant

You can now add labels to test results when you run test assets from Ant by specifying a

value for the labels parameter. See Running tests by using Ant on page 176.
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Feature title

Description

Access to properties of a
dataset through a custom
code

You can now get the properties of the dataset through custom code. When a test asset
is associated with a dataset by using a custom code, you can write the properties of the
dataset to the test logs. See Getting the properties of a dataset on page 878.

Support to extract the JSON

value from a Reference

Based on the JSON Path expression that you entered in the Regular Expression field,
you can now extract the Reference value. See Selecting a Reference in a response on

page 640.

Enhancements to the
performance report

The Errors page of the performance report now displays a graph to show errors against the
time that occurred during the playback of the test or schedule. See Performance reports on
page 1028.

Enhancements to HTTP
requests

You can now provide a name for individual HTTP requests from the HTTP Requests Details
pane to use the short or meaningful name for requests. You can view the same name from
the Page Elements Performance Report and thus you can sort or trace Requests efficiently.
See HTTP request details on page 1220.

Support to display response
codes in Statistics Session

Viewer

If the test includes requests with various response codes, you can now view those response
codes from the Statistics Session Viewer window. You can right-click the test result and
select Open With > Statistics Session Viewer > Run > HTTP Detailed Status Code to access
response codes.

Automatic creation of

environment variables

If you use HCL OneTest™ API extension to run integration tests from HCL OneTest™
Performance, then the | NTEGRATI ON_TESTER _HOME and | NTEGRATI ON_TESTER AGENT_HOVE
environment variables are now automatically created when you install HCL OneTest™ API
10.2.2 or later.

Support to record tests by
using the Microsoft Edge

browser

After you install HCL OneTest™ Performance on Linux operating system, you can now
choose the Chromium-based Microsoft Edge browser to record the following tests:

« HTTP tests

« Service tests when recorded from a browser

What's New in 10.2.1

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.
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Feature title

Description

Support to add labels from

the command-line interface

You can now add labels by using a new parameter called -labels to test results when you
run test assets from the command-line interface. See Running a test or schedule from a

command line on page 821.

The execution agent is now
renamed as the Ul Test
Agent

The execution agent that was delivered along with HCL OneTest™ Performance Agent

10.2.0 is now renamed as the Ul Test Agent.

What's New in 10.2.0

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Support to install and use
the product in different
languages

You can now use the stand-alone installer and the product in your preferred language.
You can select the preferred language for the stand-alone installer and the product by
selecting the language during the installation of the product. See Installation of DevOps

Test Performance on page 134.

Introducing the new
execution agent as part of
HCL OneTest™ Performance
Agent installation

An execution agent is now delivered as part of HCL OneTest™ Performance Agent.

You can use this execution agent to perform the automation testing of the Windows
desktop applications, mobile web, hybrid applications on iOS and Android devices. During
the installation of HCL OneTest™ Performance Agent, the execution agent is installed

automatically. See Installation of the Agent on Windows systems on page 155.

Support for application
performance management

tools

You can now use AppDynamics or Dynatrace applications with HCL OneTest™ Performance
to enhance the data collection by adding filters based on HTTP headers that you used in

tests. See Using Application Performance Management in a schedule on page 725.

Using a JSON notation in a

reference for an HTTP test

If a request or a response contains the JSON data, then the test editor displays a value in a
more readable JSON format. If you create a reference in the JSON data, you can now use
the JSON notation instead of a regular expression to locate the JSON value at run time. See

Creating a Reference or a Field Reference on page 639.

Support to record tests by
using the Microsoft Edge

browser

After you install HCL OneTest™ Performance either on Windows systems or Mac operating
systems, you can now choose the Chromium-based Microsoft Edge browser to record the

following tests:
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Feature title

Description

« HTTP tests
« Citrix tests from the Citrix Web Interface
« SAP tests when initiated from HTTP SAP-portal

« Service tests when recorded from a browser

See Recording an HTTP test on page 355.

Support to the latest version
of the SAP GUI client

You can now record and play back tests of SAP applications built with the SAP GUI client
7.7.

What's New in 10.1.3

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Sorting the HTTP pagesin a
performance report

In a performance report, you can now sort the order of the HTTP pages that are captured in
a test or schedule either by alphabetical order or order of execution of the HTTP pages. See
HTTP performance test reports on page 1010.

Separate installation of JDK

or JRE is not required

The HCL OneTest™ Performance stand-alone installer now uses the embedded JRE
for execution and it no longer requires a separate JRE or JDK to be present to run the
stand-alone installer.

What's New in 10.1.2

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

Documentation

You can now quickly add your comments to provide your feedback about the
documentation for HCL OneTest™ Performance by posting to a product forum. To add your
comments as feedback, you must first register at HCL Support. Your login information
along with your comments are governed by the privacy policy of HCL. By commenting, you
accept the terms of use of HCL.

Exporting test results to
JSON

When you want to analyze test results in a text format, you can now export all test results
or a specific test result that you captured during a test run to a JSON file. See Methods to
export test results into a JSON file on page 988.
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Feature title

Description

Importing a CSV file with a
separator character

You can now import a CSV file that has a separator character into the dataset and configure
the required separator values in the CSV Editor. See Editing datasets on page 600.

Adding a Verification point
to an SAP object

You can now add a verification point to an SAP object in the SAP GUI Grid View to verify the
state of the SAP object after the SAP recording is complete. See Adding a verification point
to an SAP GUI Grid View object on page 504.

Recording an SAP
transaction from a running
SAP GUI

You can now record certain SAP transactions from a running SAP GUI session to create
a test that contains some specific part of an SAP session. See Recording a specific SAP

transaction from a running SAP session on page 387.

SAP extension on Windows

64-bit operating system

You can now choose SAP extension when you install HCL OneTest™ Performance on

Windows 64-bit operating systems.

Enhancements to reports

and counters

- The title of the page in a performance report is now updated with the filter value
that you specified in the View Settings pane. See Filtering data in test results on

page 972.

- In a Transaction report, you can now view the number of transactions that are
active during the schedule run and the number of virtual users that execute certain

transactions simultaneously. See Transaction report on page 1005.

« You can now publish large test results from HCL OneTest™ Performance to HCL
OneTest™ Server. See Publishing test results to the server on page 966.

» When you want to analyze the additional counters on a quick view reports, you can
now add percentile counters to the counter tree. See Adding additional counters on

a separate page on page 974.

* You can now define a percentile value as decimal numbers for a counter. See

Modifying counters in a graph on page 983.

Access to a dataset from a

custom code

You can now access datasets from a custom code. When a test is associated with a
dataset, you can read or write the dataset values from the custom code. See Reading and

writing data from a dataset on page 877.

Access to the actual name of
the schedule

When you use the custom code, you can now access the actual name of the schedule in the

test log. See Accessing the actual schedule name from the custom code on page 876.
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Feature title

Description

Brotli encoding format

HTTP tests now automatically decompress data that were compressed, by using the Brotli

encoding format.

What's New in 10.1.1

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.

Feature title

Description

HCL Launch integration

You can now integrate HCL OneTest™ Performance with HCL Launch by using the HCL

OneTest™ Performance Launch plugin to run tests. See Integration with HCL DevOps Deploy

on page 250.

Enhancements to HCL
OneTest™ Performance

integrations

* You can now use the Resource Monitoring Override Labels parameter when you

choose to run tests from other applications such as Jenkins, Ant, Maven, Micro

Focus Application Lifecycle Management (ALM), Azure DevOps, and UrbanCode

Deploy (UCD). See Integration with other applications on page 174.

« After you configure the HCL OneTest™ Server URL and if the Publish result after

execution field is set to Always, then when you run tests from other applications,

you can now view hyperlinks that point to the corresponding test reports as follows:

Applications Location of the report
Jenkins Console page

Ant Log file

Maven Console page

Micro Focus Application Lifecycle

Output window

Management
Azure DevOps Task page
UrbanCode Deploy Output log

What's New in 10.1.0

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Performance.
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Feature title

Description

Microsoft Azure DevOps

integration

You can now integrate HCL OneTest™ Performance with Azure DevOps by using the HCL
OneTest Studio extension to run tests as tasks in Azure DevOps pipelines. See Integration
with Azure DevOps on page 189.

Support for console mode
installation by using the
stand-alone installer

You can now install HCL OneTest™ Performance and HCL OneTest™ Performance Agent by
using the stand-alone installer on Ubuntu and Red Hat Enterprise Linux (RHEL) operating
systems in console mode where GUI mode is not supported.

Support for Jaeger traces

view

You can now use the Jaeger to view test logs of tests or schedules that you run from the
command-line interface to analyze traces of transactions between distributed services. See
Integration of Jaeger with the product.

A quick view in reports

You can now add the additional counters on a separate page without editing an existing
report to investigate performance issues in detail. See Adding additional counters on a

separate page on page 974.

Updates to Dataset CSV
Editor

The browser-based CSV Editor provides additional options that include Find and Replace,
Undo, and Redo to organize your data in the dataset in a better way. See Editing datasets on

page 600.

Labels for Resource

Monitoring sources

In HCL OneTest™ Performance, you can now select the data sources in a schedule based on
the labels that you added for the data sources in HCL OneTest™ Server. See Enablement of

Resource Monitoring services for a schedule on page 748.

Environment variables for

Jenkins

You can now set environment variables on the Jenkins server as inputs to the text fields
that are available for HCL OneTest™ Performance test in a Jenkins build step. See

Integration with Jenkins on page 303.

Enhancement to
performance reports

- The Overall page of the performance report is updated to show the Page VPs, Page
Element VPs, Page Status Codes, Page Element Status Codes, and Page Health
information in an individual chart and the information about the overall verification

point in a pie chart. See Overall page on page 1012.

« The Resources page of the performance report is updated to show the resource
counters information in front of their Resource Monitoring source name. The
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Feature title Description

Performance Summary table now shows the Type of the source and Name of the

resource counter in two different columns. See Resources page on page 1024.

- You can now view and monitor the counter information generated by the custom
code on a graph when the custom code starts in the test run. See Adding custom

counters to reports on page 867.

Enhancements to SAP GUI Most of the steps are automated now when you record SAP tests by using an SAP batch
input test recording wizard. See Recording a SAP batch input test on page 393.

Properties Verification You can now add verification points for the properties in a test response when you record a
Points in Service Test service test or after you record the service test. See Adding properties verification points to

a test response on page 528.

Support for Text message After you create a WebSphere MQ protocol configuration, now you can change the message
in WebSphere MQ protocol | format by selecting the Text Message check box in the Message Structure. See Creating a
configuration WebSphere MQ protocol configuration on page 679.

Deprecations and removals

You can find the features or capabilities announced as deprecated and the features or capabilities that are removed in HCL
DevOps Test Performance (Test Performance). DevOps Test Performance is the new name of HCL OneTest™ Performance
from 11.0.0 onwards.

When features or capabilities are announced as deprecated, they continue to be supported although such features or
capabilities are no longer enhanced and might be removed in a subsequent release. If you use a deprecated feature, you
must migrate to the alternate feature, if applicable, before the deprecated feature is removed.

The removed features will not be available in the product version in which they are removed.
Note: You can contact the HCL Client Support team if you have any concerns.

You can find information about the following deprecations or removals:

« Product features or capabilities on page 30

» Dependent software on page 31

Product features or capabilities

You can find information about the features or capabilities of Test Performance that are announced as deprecated in an

earlier version, and the version in which they are removed.



Chapter 1. Release notes for DevOps Test Performance 2025.12 (11.0.7)

Note: The features removed in this version are listed first, followed by the features deprecated. The features removed

or deprecated in earlier versions are listed later in the table.

Feature or capability Feature deprecated in | Feature removed in
version version

Response Time Breakdown capabilities are removed. NA 11.0.4

Support for Google Web Toolkit (GWT) transformation is deprecated. 11.0.3

Support to use the stand-alone installer package to install HCL DevOps | 11.0.1 11.0.2

Test Performance on Linux or macOS is deprecated.

You must first download and install IBM Installation Manager from (site)
if you do not have it installed already. You must then download the Test
Performance package that is dependent on IBM Installation Manager
and install it by using Installation Manager.

The capability to integrate Test Performance with Jaegar and send test | NA 11.0.2
logs to the Jaeger Ul during the test run by using the -history jaeger
option through the command line is no longer supported.

Support to use the 32-bit installer package to install HCL DevOps Test NA 11.0.2

Performance on Windows is removed.

Support of HCL DevOps Test Performance Citrix Extension 10.5.4

Support of HCL DevOps Test Performance Siebel Extension 10.5.4 11.0.2

Dependent software

You can find information about the dependent software that were announced as deprecated in an earlier version and the
version in which they were removed. Dependent software can include the operating systems, license servers, applications, or

software required for using Test Performance.
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Note: The features removed in this version are listed first, followed by the features deprecated. The features removed

or deprecated in earlier versions are listed later in the table.

Dependent software

Deprecated in

Support removed in

version version
Operating system
Red Hat Enterprise Linux (RHEL) 7.5 Not applicable
Red Hat Enterprise Linux (RHEL) 7.7 Not applicable
Red Hat Enterprise Linux (RHEL) 7.8 Not applicable
Red Hat Enterprise Linux (RHEL) 7.9 10.5.4
Red Hat Enterprise Linux (RHEL) 8 10.2.0 10.2.3
Red Hat Enterprise Linux (RHEL) 8.1 10.2.0 10.2.3
Red Hat Enterprise Linux (RHEL) 8.2 Not applicable 10.2.3
Red Hat Enterprise Linux (RHEL) 8.3 Not applicable 10.2.3
Red Hat Enterprise Linux (RHEL) 8.4 10.5.2 10.5.4
Red Hat Enterprise Linux (RHEL) 8.5 Not applicable 10.5.0

Red Hat Enterprise Linux (RHEL) 8.6 11.0.0
Red Hat Enterprise Linux (RHEL) 8.8 11.0.3
Red Hat Enterprise Linux (RHEL) 9.0 11.0.0
Red Hat Enterprise Linux (RHEL) 9.2 11.0.3
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Dependent software

Deprecated in

Support removed in

version version
Operating system
Ubuntu 18.04 LTS 10.2.3 10.5.3
macOS BigSur 11.6 10.5.3 10.5.4
macOS Catalina 10.15 10.2.3 10.5.2
macOS Mojave 10.14 Not applicable 10.2.2
macOS Monterey 12 11.0.0 11.0.4
Windows Server 2016 10.5.0
Windows Server 2019 11.0.3
Licensing
HCL Local License Server 2.0 (also known as 2021.05) | Not applicable 10.5.3
HCL Local License Server 3.0 (also known as 2022.12) | Not applicable 11.0.2
HCL Local License Server 2024.04 Not applicable 11.0.3
Web browsers
Apple Safari 14 10.5.1 10.5.2
Apple Safari 15 10.5.4 11.0.0
Apple Safari 16 11.0.2
Google Chrome 91-96 10.5.0 10.5.1
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Dependent software

Deprecated in

Support removed in

version version

Operating system

Google Chrome 97-100 10.5.1 10.5.2
Google Chrome 101-103 10.5.2 10.5.3
Google Chrome 104-106 10.5.3 10.5.4
Google Chrome 107-108 10.54 11.0.0
Google Chrome 109-111 11.0.0 11.0.1
Google Chrome 112-114 11.0.1 11.0.2
Google Chrome 115-117 11.0.2 11.0.3
Google Chrome 118-120 11.0.3 11.0.4
Microsoft Edge 42-44 10.2.0 10.2.3
Microsoft Edge 91-96 10.5.0 10.5.1
Microsoft Edge 97-100 10.5.1 10.5.2
Microsoft Edge 101-103 10.5.1 10.5.3
Microsoft Edge 104-105 10.5.3 10.5.4
Microsoft Edge 106-108 10.5.4 11.0.0
Microsoft Edge 109-111 11.0.0 11.0.1
Microsoft Edge 112-114 11.0.1 11.0.2
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Dependent software

Deprecated in

Support removed in

version version

Operating system

Microsoft Edge 115-117 11.0.2 11.0.3
Microsoft Edge 118-120 11.0.3 11.0.4
Microsoft Internet Explorer 11 (For Reports Only) 10.2.0 10.2.2
Mozilla Firefox 60 to 77 10.2.0 10.2.3
Mozilla Firefox 78 to 88 10.2.3 10.5.0
Mozilla Firefox 89 to 90 10.5.0 10.5.1
Mozilla Firefox 91 10.5.0

Mozilla Firefox 92 10.5.0 10.5.1
Mozilla Firefox 93 to 95 10.5.0 10.5.1
Mozilla Firefox 96 to 99 10.5.1 10.5.2
Mozilla Firefox 100 to 102 10.5.2 10.5.3
Mozilla Firefox 103 to 105 10.5.3 10.5.4
Mozilla Firefox 106 to 108 10.5.4 11.0.0
Mozilla Firefox 109 to 111 11.0.0 11.0.1
Mozilla Firefox 112 to 114 11.0.1 11.0.2
Mozilla Firefox 116 to 118 11.0.2 11.0.3
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Dependent software

Deprecated in

Support removed in

version version
Operating system
Mozilla Firefox 119 to 121 11.0.3 11.0.4
Mozilla Firefox ESR 60 Not applicable 10.1.1
Mozilla Firefox ESR 68 10.2.2 10.2.3
Mozilla Firefox ESR 78 Not applicable 10.5.0
Mozilla Firefox ESR 91 Not applicable 10.5.4
Mozilla Firefox ESR 102 10.5.2 11.0.1
Mozilla Firefox ESR 115 11.0.4
Virtualization Management
Docker CE 19.3 10.2.0 10.5.0
Docker CE 20.1 Not applicable 10.5.4
Docker Compose 1.25 10.2.0 10.5.0
Docker Compose 1.26 10.2.0 10.5.0
Docker Compose 1.27 Not applicable 10.5.0
Docker Compose 1.29 10.5.0 10.5.1
Docker Compose 2.6 10.5.2 10.5.3
Docker Compose 2.10 Not applicable 10.5.4
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Dependent software

Deprecated in

Support removed in

version version
Operating system

10.5.4
Docker Compose 2.12 11.0.0
Docker Compose 2.15 11.0.0 11.0.1
Docker Compose 2.17 11.0.0 11.0.1
Docker Compose 2.20.0 11.0.2 11.0.3
Docker Compose 2.22.0 11.0.2 11.0.3
Docker Engine 23, 24 11.0.2 11.0.3

11.0.3

Business Process Management
SAP 7.6 10.2.3 10.5.4
SAP 7.5 Compilation 2 10.2.0 10.2.3
Development Tools
Rational Team Concert 6.0.3 10.2.0 10.2.3
Rational Team Concert 6.0.4 10.2.0 10.2.3
Rational Team Concert 6.0.4 Not applicable 10.5.0
Rational Quality Manager 6.0.3 10.2.0 10.2.3
Rational Quality Manager 6.0.4 10.2.0 10.2.3
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Dependent software

Deprecated in

Support removed in

version version
Operating system
Rational Quality Manager 6.0.5 10.2.0 10.2.3

Not applicable
Rational Quality Manager 6.0.6 10.5.0
Rational ClearCase 8.0.1 or later

10.2.0 10.2.3
Eclipse Runtime Environment
Eclipse Runtime Environment 4.2 10.2.0 10.2.3
Eclipse Runtime Environment 4.6 10.2.0 10.2.3
Eclipse Runtime Environment 4.7 10.5.0 10.5.1
Eclipse Runtime Environment 4.7.3.1 10.5.0 10.5.1
Eclipse Runtime Environment 4.8 10.5.0 10.5.1
Eclipse Runtime Environment 4.23 Not applicable 10.5.0
DevOps Tools
IBM UrbanCode Deploy 7.0.2 Not applicable 10.5.0
IBM UrbanCode Deploy 7.1.1.1 Not applicable 10.5.0
IBM UrbanCode Deploy 7.1.2.1 Not applicable 10.5.0

IBM UrbanCode Deploy 7.2.1.0

11.0.1

IBM UrbanCode Deploy 7.2.3.0

11.0.1
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Dependent software

Deprecated in

Support removed in

version version

Operating system

IBM UrbanCode Deploy 7.3.2.2 11.0.4

IBM UrbanCode Deploy 7.3 11.0.4

HCL Launch 7.1.0.1 Not applicable 10.5.0
HCL Launch 7.1.1.1 Not applicable 10.5.0
HCL Launch 7.1.2.1 Not applicable 10.5.0
HCL Launch 7.2.3.0 11.0.1

HCL Launch 7.2.1.0 11.0.1

HCL Launch 7.3.2.2 11.0.4

HCL Launch 7.3 11.0.4

Jenkins 2.235.1 Not applicable 10.5.0
Jenkins 2.277.4 Not applicable 10.5.0
Jenkins 2.289.3 Not applicable 10.5.0
Jenkins 2.303.3 Not applicable 10.5.2
Jenkins 2.361.1 10.5.3 10.5.4
Jenkins 2.346.2 10.5.3 10.5.4
Jenkins 2.339 10.5.3 10.5.4
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Dependent software Deprecated in Support removed in

version version

Operating system

Jenkins 2.375.2 10.5.4
Jenkins 2.387 11.0.0 11.0.1
Jenkins 2.39 10.5.4 11.0.0
Jenkins 2.426.2 11.0.4
Jenkins 2.440.2 11.0.4

Application Servers

WebSphere Application Server 9 11.04

WebSphere Liberty 17.0.0.1 11.0.4

Defect fixes

You can find the defects that are fixed in this version of HCL DevOps Test Performance (Test Performance). You can also
find the defects that were fixed in the earlier versions of Test Performance. DevOps Test Performance is the new name of

HCL OneTest™ Performance from 11.0.0 onwards.

You can find the following information:

» Defects fixed in DevOps Test Performance 2025.12 (11.0.7) on page 40

« Defects fixed in earlier versions on page 40
Defects fixed in DevOps Test Performance 2025.12 (11.0.7)
No external defects were identified and fixed in DevOps Test Performance.

Defects fixed in earlier versions

You can find information about the defects fixed in each of the following versions:
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« Defects fixed in 11.0.6 on page 41

« Defects fixed in 11.0.5 on page 41

« Defects fixed in 11.0.4 on page 41

« Defects fixed in 11.0.3 on page 41

« Defects fixed in 11.0.2 on page 42

« Defects fixed in 11.0.1 on page 42

« Defects fixed in 11.0.0 on page 43

« Defects fixed in 10.5.4 on page 43

« Defects fixed in 10.5.3 on page 44

« Defects fixed in 10.5.2 on page 44

« Defects fixed in 10.5.1 on page 45

« Defects fixed in 10.5.0 on page 45

« Defects fixed in 10.2.3 on page 46

« Defects fixed in 10.2.2 on page 46

« Defects fixed in 10.2.1 on page 46

« Defects fixed in 10.2.0 on page 47

« Defects fixed in 10.1.3 on page 47

« Defects fixed in 10.1.2 on page 48

« Defects fixed in 10.1.1 on page 49

« Defects fixed in 10.71.0 on page 50

Defects fixed in 11.0.6

No external defects were identified and fixed in DevOps Test Performance.

Defects fixed in 11.0.5

No external defects were identified and fixed in DevOps Test Performance.

Defects fixed in 11.0.4

No external defects were identified and fixed in DevOps Test Performance.

Defects fixed in 11.0.3

The defects fixed in Test Performance 11.0.3 are as follows:

Table 1. List of fixes in 11.0.3

ID / APAR

Description

TP-93551

Previously, during the playback of a test with WebSocket interactions on an HTTPS
connection, a BufferOverflowException occurred when arbitrary WebSocket traffic was
received. This problem is fixed.
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Defects fixed in 11.0.2

The defects fixed in Test Performance 11.0.2 are as follows:

Table 2. List of fixes in 11.0.2

ID / APAR

Description

TP-92013

Previously, when you ran an HTTP test with a POST request that contained JSON content,
the equal symbol (=) was transformed to \u003d during playback. This transformation
caused Content-Length discrepancies and impacted the POST request. This problem is
fixed.

Now, you must regenerate the tests to get the updated JSON content, if they were created
in an older version of DevOps Test Performance. Alternatively, you can manually replace
\u003d with an equal symbol (=) in the JSON content.

TP-93602

The DevOps Test Application Server Instrumenter no longer supports Application Servers

running Java 6 or 7. The minimum supported Java version is now 8.

TP-92614

When you try to instrument WebSphere Application Server (WAS) server by using
the Application Server Instrumenter (ASI) in DevOps Test Performance11.0.2, the
instrumentation of the WAS server fails with an error message.

Before you use the Application Server Instrumenter to instrument WebSphere Application
Server, you must set the JAVA_HOME environment variable to the folder <WAS i nst al |

di r >\ j ava, and then start Application Server Instrumenter.

TP-91484

Previously, when you selected the Load option from My Repository workspace for
a component to load all the test assets available in the stream to be pushed to IBM
Engineering Workflow Management, the assets created by the other users failed to load

and displayed an error message. This problem is fixed.

Defects fixed in 11.0.1

The defects fixed in Test Performance 11.0.1 are as follows:

Table 3. List of fixes in 11.0.1

ID / APAR

Description

TP-89717

Test Performance test generator omits null parameters in JSON data transform. This problem is

fixed.
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Defects fixed in 11.0.0

The defects fixed in Test Performance 11.0.0 are as follows:

Table 4. List of fixes in 11.0.0

ID /|Description
APAR

TP-8 |Previously, there was an issue with the Substitute menu in the Test Editor. Even when you selected the Show
9717 | Recently Used Data Sources option the Substitute menu did not display any recently used data sources. This

problem is fixed.

TP-8 | Previously, when you made a test call to get Row with a specific index and updated the dataset, an issue occurred,
9647 |where the dataset service did not return the row data if the file on the agent was not the latest. This problem is
fixed.

TP-8 | Transaction Net Server Time incorrectly reported as 0 when nesting transactions. This problem is fixed.
9595

Defects fixed in 10.5.4

The defects fixed in HCL OneTest™ Performance 10.5.4 are as follows:

Table 5. List of fixes in 10.5.4

ID / APAR Description

TP-88193 Previously, it was not possible for you to use Git Actions to run tests when HCL OneTest™

Performance is installed on MacOS Ventura 13. This problem is fixed.

TP-88675 Previously, when you opened a failed event from the Execution Event Console in HCL OneTest™
Performance and then selected the Show in Test Log option, this option did not direct you to the

corresponding failed step. This problem is fixed.

This problem is fixed.

Previously, when there were multiple images used for synchronization, there was a display issue

TP-89156
where the hash code would not display correctly. Although the values were correct, the display

would not refresh to show them. This problem is fixed.

Reference extraction fails with auto-generated JSON regular expressions.
TP-88357
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Table 5. List of fixes in 10.5.4 (continued)

ID / APAR Description
Previously, it was not possible for you to use Git Actions to run tests when HCL OneTest™
TP-88193 . . o
Performance is installed on MacOS Ventura 13. This problem is fixed.

Defects fixed in 10.5.3

The defects fixed in HCL OneTest™ Performance 10.5.3 are as follows:

Table 6. List of fixes in 10.5.3

ID /APAR Description
Dataset modifications by API are not seen when using multiple agents.
TP-86813
Codegen failure for HTTP test due to bad JSON regular expression.
TP-88273
Renaming HCL OneTest™ Performanceplayback results does not change name shown when
TP-86580 -
viewing results.

Defects fixed in 10.5.2

The defects fixed in HCL OneTest™ Performance 10.5.2 are as follows:

Table 7. List of fixes in 10.5.2

ID /APAR Description

HCL OneTest™ Performance imposes an undocumented 50MB limit on dataset size.
TP-85401

SOAP Envelope cannot have children other than SOAP Header and Body error when playing back
TP-85720 .

service test.

HCL OneTest™ Performance test shows "null" for response when JSON data transform applied.
TP-85760

HCL OneTest™ Performance data correlation auto-generated JSON reference reports Reference
TP-85704 ) . .

Extraction Failure during playback.

POST content of failed request not shown in Test Log if logging not All.
TP-86710

Handling of WebSocket traffic during the HTTP test run is improved.
TP-86421
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Defects fixed in 10.5.1

The defects fixed in HCL OneTest™ Performance 10.5.1 are as follows:

Table 8. List of fixes in 10.5.1

ID /APAR Description
TP-85088 Requirements/Error Handling in HCL OneTest™ Performance 9.0 test cause problem with HCL
OneTest™ Performance 10.2.3
TP-79041 Unable to get dataset error if encrypted communication used with agents.
TP-84249 Discard Changes error while resolving merge conflicts for testsuite files during branch merge with
Egit.
Previously, the Browser tab in the Protocol Data pane did not display the recorded web pages
TP-84064 .
when you performed the following tasks:
« Installed HCL OneTest™ Performance on Ubuntu 22.04.1 LTS.
« Highlighted any page from the recorded test.
This problem is fixed.

Defects fixed in 10.5.0

The defects fixed in HCL OneTest™ Performance 10.5.0 are as follows:

Table 9. List of fixes in 10.5.0

ID /APAR Description

TP-83219 Meaningless GUID comments in HTTP test created from playback of Web Ul test.

TP-83267 Values in Requirement Target column in Requirements Report not modifiable.

TP-82527 Previously, when you ran the performance schedule by enabling the Resource Monitoring
sources, the quick view report had issues in the counter name when you refreshed or
reopened the report. This problem is fixed.

TP-83532 Previously, when you viewed or saved the executive summary from the Web Analytics
report, you were not able to print the entire report. This problem is fixed.
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Table 9. List of fixes in 10.5.0 (continued)

ID /APAR

Description

TP-82509

Previously, the pie chart in the quick view report overlapped with the names of the legends

when you set the Show legend option to At the top side. This problem is fixed.

Defects fixed in 10.2.3

The defects fixed in HCL OneTest™ Performance 10.2.3 are as follows:

Table 10. List of fixes in 10.2.3

ID /APAR Description
TP-80344 Performance Report Elapsed Time inconsistent between report in workbench and exported HTML
report.
TP-78644 During substitution of dataset values, the current row is always skipped and the number of
iterations is less than the total number of rows in the dataset. This problem is fixed.

Defects fixed in 10.2.2

The defects fixed in HCL OneTest™ Performance 10.2.2 are as follows:

Table 11. List of fixes in 10.2.2

ID /APAR Description
TP-79311 Invalid Image Synchronization failures reported intermittently on the Citrix Monitoring Panel.
TP-77904 Resource Monitoring->Windows Performance Monitor does not use supplied Authentication
credentials
TP-78348 Rate Schedule playback fails with RUNFAIL error from agent

Defects fixed in 10.2.1

The defects fixed in HCL OneTest™ Performance 10.2.1 are as follows:
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Table 12. List of fixes in 10.2.1

ID /APAR Description
TP-78114 HCL OneTest™ Performance 10.2.0 hangs at Guid.java when opening tests.
TP-77264 Citrix test editor behaves erratically when working with multiple values in Image Synchronizations.
TP-77614 HTTP Preprocessor getContent() returns content prior to substitution.
TP-76446 HCL OneTest™ Performance WebSocket playback on secure connection sometimes loses
responses.
TP-78247 SAP test playback is failing with Exception: java.lang.RuntimeException: SapGuiController.exe

Defects fixed in 10.2.0

The defects fixed in HCL OneTest™ Performance 10.2.0 are as follows:

Table 13. List of fixes in 10.2.0

ID /APAR Description
TP-75082 Image Synchronizations with OCR fails for large-sized image areas in Long Run mode.
TP-76089 TN3270 recording in Rational Performance Tester 10.1.2 not working with BlueZone client.
TP-74431 Misleading statistics for HTTP test when no primary request on page.
TP-75146 Sequential Number built-in data source access, when shared across users, is unreasonably slow.
TP-72337 Rate Generator in Compound Test is not executed.

Defects fixed in 10.1.3

The defects fixed in HCL OneTest™ Performance 10.1.3 are as follows:
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Table 14. List of fixes in 10.1.3

ID /APAR Description

TP-74141 In HCL OneTest™ Performance 10.1.2, when you export a report that contained any percentile
counters, such as the Transaction Percentile or HTTP Page Percentile reports, to CSV or JSON
file, only one percentile counter would have exported. This problem was fixed.

TP-73141 Image Synchronizations with OCR fail in Long Run Mode.

TP-72866 Resource Monitoring using JVM Monitoring data source fails in HCL OneTest™ Performance
10.1.0 with ClassNotFoundExceptionP

TP-72335 Rate Generator in Random Selector->Weighted Block of a schedule fails with NullPointerException

TP-72852 Inconsistent reporting of 401 response code in HTTP playback.

TP-72312 Misleading statistics for HTTP test when no primary request on pageP.

TP-62308 HCL OneTest™ Performance does not allow newlines in regular expressions associated with
references.

Defects fixed in 10.1.2

The defects fixed in HCL OneTest™ Performance 10.1.2 are as follows:

Table 15. List of fixes in 10.1.2

ID /APAR Description
TP-71696 CSV Editor import of large (>11 Mb) CSV into dataset not working. This problem was fixed.
TP-71013 Page Element Sizes report page is empty. This problem was fixed.
TP-70128 End of dataset reached error when we run schedule from more agents. This problem was fixed.
TP-70112 Citrix web-interface recording doesn't work for full screen desktops. This problem was fixed.
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Table 15. List of fixes in 10.1.2 (continued)

ID /APAR Description

TP-68695 A new socket recorder technology using the Microsoft Detour library was added to handle clients
that could not be captured with the existing socket recorder.

TP-66568 On Mac operating systems, when you use HCL OneTest Performance to record a test by using
Safari 13.x was showing an error. This problem was fixed.

TP-67544 Previously, when you configure HCL OneTest™ Performance tests on the UCD server and the
Overwrite Results file option is checked in the Edit Properties, the results file was not geting
overwritten during the test execution. This problem was fixed.

TP-69252 Previously, the user could have select the incompatible counters from the Quick View report which
causes the graph to empty. This problem was fixed.

TP-68990 The start and end of a Timed Section can now be bound to an iterate action.

Defects fixed in 10.1.1

The defects fixed in HCL OneTest™ Performance 10.1.1 are as follows:

Table 16. List of fixes in 10.1.1

ID /APAR Description

TP-69156 Test Editor does not include response when content is chunked and deflated

TP-69304 The Quick View in statistical reports did not support the visualization of resource monitoring
counters in new executions.

TP-67548 Any existing offline user token that is used inHCL OneTest™ Performance Agent becomes invalid
when you upgrade from the previous version of Rational Performance Tester to V10.1.0.

TP-67544 When you configured HCL OneTest™ Performance on the UCD server and the Overwrite Results
file option was checked in the Edit Properties, the results file does not get overwritten during the
test execution.
Previously, there was an issue when you use IBM Installation Manager 1.8.6 to install HCL

TP-59612
OneTest™ Performance on Mac OS. This problem was fixed.
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Defects fixed in 10.1.0

The defects fixed in HCL OneTest™ Performance 10.1.0 are as follows:

Table 17. List of fixes in 10.1.0

50

ID /APAR Description

TP-66996 Test Generation hangs while correlating Text based Web Socket requests.

TP-66217 Specified loop iteration rate is not honored when the delay between is set to randomly vary.

TP-65700 Conversion of a JMeter script to VU schedule does not work when the script contains Property
functions.

TP-63404 Save selection as new test disabled in tests containing web socket traffic.

TP-62848 Screen size becomes unmanageable when the Citrix server sets resolution parameters for
seamless mode.

TP-62103 Citrix recording wizard prevents editing display resolution parameters when recording with an ICA
file.

TP-51255 Allow variable substitution in Jenkins plugin.

TP-64567 When you add a language by using the Modify option in IBM Installation Manager, the
configuration gets corrupted and the product becomes unusable. This issue was fixed.

TP-64546 When you created and edited a dataset, and then try to add a column to the dataset from a test,
there was an issue because the editor would have locked the file. This issue was fixed.

Known issues

You can find the known issues that are identified, if any, in this version of HCL DevOps Test Performance (Test Performance).

You can also find the known issues identified in the earlier versions of Test Performance. DevOps Test Performance is the

new name of HCL OneTest™ Performance from 11.0.0 onwards.

You can find the following information:

» Known issues in DevOps Test Performance 2025.12 (11.0.7) on page 51

« Known issues from earlier versions on page 51
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Known issues in DevOps Test Performance 2025.12 (11.0.7)

No known issues have been identified in DevOps Test Performance for this release.

Known issues from earlier versions

The known issues identified in the earlier versions of Test Performance that are still applicable are as follows:

ID Description Identified in version Applicable in and until version

TP-99 11.0.5 11.0.5
383 When Test Performance is installed

in the shell-sharing mode with Test
Ul, and if you try to record an HTTP
or Web Ul test, the Select Client
Application page in the recording
wizard might not list the available

browsers for selection.

Also, when you try to run a test,
before selecting the browser,
you might see an error message
indicating a test run failure.

To work around these problems,
perform the following steps:

1. Set the environment variable

WDM EDGEDRI VERURL with the value:

https:// nsedgedri ver. nicros
oft.conml

2. Restart Test Performance.

After installing DevOps Test 11.0.5 11.0.5
Performance on Red Hat Enterprise
Linux (RHEL) by using IBM

Installation Manager, you might get

TP-96
453

a "Permission denied" error when
you try to open the application. This
issue might occur if the system's
default permission settings

are restrictive, preventing from

accessing required files.
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Description

Identified in version

Applicable in and until version

To work around this problem, before
starting the installation, you must
run the following command in the
terminal so that the system's default
file permissions are less restrictive:

umask 022

Note: You must run this
command as a user with
administrative rights to
ensure the permissions
apply correctly during
installation.

TP-95
069

When you run the Test
Performance asset by using
pomCustomSurefireSample.xml
with Apache Maven, the test fails
with an error after you run the
command mvn clean verify -f

pomCustomSurefireSample.xml.

11.0.3

TP-88
114

In the Test Editor panel, the
Response Content field might
intermittently appear empty on
Windows system when the data size
is between 30 KB and 40 KB. You
can resolve the issue by restarting
the application or by adding the
following line to the configuration
file located in

<workspace>/.metadata/.plugins/or
g.eclipse.core.runtime/.settings/co

m.ibm.rational.test.common.editor.f
ramework.prefs:st . scal abl e. t hresh

ol d=30

11.0.1
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Description

Identified in version

Applicable in and until version

TP-91
484

When you select the Load option
from My Repository workspace for
a component to load all the test
assets available in the stream to be
pushed to Engineering Workflow
Management, the assets created
by the other users fail to load and
display an error message.

11.0.1

11.0.1

TP-90
515

The single shell-shared package,
DevOps-Test-Ul-
and-Performance-Windows-x86,
is not available anymore. To
install DevOps Test Ul and
DevOps Test Performance in

the shell-shared mode on the
32-bit platform, you must use
DevOps-Test-Ul-Windows-x86 and
DevOps-Test-Performance-Windo
ws-x86 packages by using

Installation Manager.

11.0.0

TP-88
149

When you record a Citrix test by
using the on-server or published
application options on Citrix
Workspace App 23.03, the recording
fails with a client error. Citrix
Workspace App 23.03 only supports
recording by using Web Interface
and ICA file options.

10.5.4

TP-88
120

When you import projects from Git,
tests run from the command line fail
if you use wildcards to identify tests

or if you use the option -testType.

The workaround for this limitation

is that you can avoid using assets

10.5.4
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Description

Identified in version

Applicable in and until version

from Git. Alternatively, you can
export or import test assets with
dependencies into a different
workspace.

TP-88
193

You cannot use Git Actions to

run tests when HCL OneTest™
Performance is installed on MacOS
Ventura 13.

10.5.3

10.5.4

TP-88
149

When you run HCL OneTest™
Performance on MacOS Ventura,
the "Preferences" option in the
Rational Performance Tester menu

is displayed as "Settings".

10.5.3

TP-85
460

When you install HCL OneTest™
Performance 10.5.1 or later on a
Windows Server 2022 computer, and
open the Web Analytics reports for
editing, the icons are not displayed.
To work around the problem, you
can perform the following steps

on browsers other than Internet

Explorer:

1. Open HCL OneTest™
Performance.

2. Go to Window > Preferences.

3. Select Test > Performance
Reports

4. Select In external browser"
under Open Statistics
Report.

5. Click OK.

6. Close the report and then

double-click the result.

10.5.1
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ID Description Identified in version Applicable in and until version

Perform the following steps in

Internet Explorer:

1. Enter Internet options in the
start menu.

2. Select Local Intranet in the
Security tab.

3. Click Sites.

4. Type http://127.0.0.1, and
then click Add.

5. Click Close, and then click
OK.

6. Restart HCL OneTest™

Performance.

TP-84 [When you start the HCL OneTest™ 10.5.0
021 Performance adapter for IBM
Rational Quality Manager as a
Windows service, the schedule run

fails with license errors.

To work around this problem,
you must add the License Server
ID and License Server URL as
System Environment variables by
performing the following steps:

1. Right-click the Windows icon
from the Windows taskbar,
and then click System.

2. Click Advanced system
settings from the Related
setting.

3. Click the Advanced tab,
and then click Environment
Variables.

4. Click New from the System

variables.
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Description

Identified in version

Applicable in and until version

5. Enter
HCL_ONETEST_LICENSING_
URL in the Variable name.

6. Enter the URL of the License
Server in the Variable value.

7. Click OK.

8. Click New from the System
variables.

9. Enter
HCL_ONETEST_LICENSING
_ID in the Variable name.

10. Enter the ID of the License
Server in the Variable value.
11. Click OK.

TP-83
770

When you install HCL OneTest™
Performance on Windows systems,
and then open a performance test
report by using an internal browser,
the icons are not displayed in the

performance report.

To work around this problem, you
must perform the following steps:

1. Close HCL OneTest™
Performance

2. Open Internet Explorer.

3. Click Settings - Internet
options, and then select the
Security tab.

4. Select Internet from the
Select a zone to view or
change security settings
pane.

5. Click Custom level, and
then choose Enable for

Downloads - Font download.

10.5.0
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Description

Identified in version

Applicable in and until version

6. Click OK to accept the
changes made to the
security settings.

7. Click Apply, and then click
OK to save the changes.

8. Close Internet Explorer.

9. Open HCL OneTest™
Performance, and then
access the performance test
report.

TP-84
064

The Browser tab in the Protocol
Data pane does not display the
recorded web pages when you

perform the following tasks:

« Install Rational Performance
Tester on Ubuntu 22.04.1
LTS

- Highlight any page from the
recorded test

10.5.0

10.5.1

TP-82
960

When you want to install HCL
OneTest™ Ul, HCL OneTest™ API,
or HCL OneTest™ Performance
on Mac 0S Big Sur (11.x), you
must download all of the product
offerings that are contained in the
HCL OneTest™ Studio package to
prevent installation errors.

10.5.0

TP-79
188

When you use the double quotation
marks (") for the Labels or User
comments options to run the test
by using integration plugins, then
the labels in the test result or the
User Comments row of a report do
not include the double quotation

10.2.3

57



58

HCL DevOps Test Performance

usercomments parameters and then
run tests from the command-line
interface, the command-line
interface does not accept values for

these parameters.

To work around this problem, you
must perform the following actions
based on the operating system that
you used to install HCL OneTest™

Performance:
On the Windows operating system:
1. Open the command-line interface.

2. Change the directory to a location
that contains the CommandLine.exe
file.

You can locate the directory in the

following location:

ID Description Identified in version Applicable in and until version
marks.The integration plugins that
do not support double quotation
marks (") for the Labels or User
comments options are as follows:
» Ant
» Azure DevOps
» MicroFocus ALM
« UrbanCode Deploy
« Jenkins
» Maven
To work around this problem, you
must create a command-line config
file, and then run the test by using
the Configfile option.
TP-81 | When you use the double quotation |10.2.3
353 marks (") for the labels or
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ID Description Identified in version Applicable in and until version

<installation_directory>
\IBM\IBMIMShared\plugins\com.ibm
.rational.test.It.cmdlineexecute<time

_Stamp>

3. Run the test by using valid

parameters.

On Windows, Linux, and Mac
operating systems:

1. Create a command-line config
file by using HCL OneTest™

Performance.

2. Run the test by using the
-configfile parameter.

TP-82 | When you run the performance 10.2.3 10.5.0
527 schedule by enabling Resource
Monitoring sources, the quick view

report shows the following issues:

* The selected counter
names in All Resources
for the specific Resource
Monitoring source are
displayed correctly for
the first time. However,
when you refresh the quick
view report or reopen the
report, the names of the
counters are displayed as
TRANSLATE ME.

The Pie chart collates the

names of the legends when
you set the Show legend
option to At the top side.

To work around this problem, you

can perform the following steps:
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Description

Identified in version

Applicable in and until version

1. Select or clear any other
counter from the left
navigation pane so that
the correct names of the
counters are displayed in the
Legend.

2. Set the value of the Show
legend option to other than
At the top side or set the
product preferences to open
the report on the external
browser by navigating to
Window - Preferences -
Test — Performance Test

Reports.

TP-51
357

When you playback a Citrix test
asset with Citrix Receiver 4.11 or
later, the test asset fails to run.To
work around this problem, you must
install Citrix Receiver 4.9.

10.2.1

TP-76
892

If your computer restarts due to

any reason, you might not be able

to uninstall or open the product at
times. To work around this problem,
you must always clear the files from
the Temp directory before you install

or after you uninstall the product.

While performing the uninstallation,
if your computer prompted for a
restart, perform the following steps:

1. Click Continue to proceed
with the uninstallation of the
product.

2. Clear the files from the Temp

directory.

10.2.0
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Description

Identified in version

Applicable in and until version

In a scenario where you are unable
to open the product due to your
computer restart, then you can
perform the following steps to do a
fresh installation of the product:

1. Clear the files from the Temp
directory.

2. Close all the processes that
are related to the product.

3. Delete the installation folder

of the product.

4. Perform the following steps
to delete the Registry entry
of the product:

a. Press Windows +R.

b. Enter regedit in the
Open field, and then
click OK.

c. Locate one of the
following key based
on your product:

i. HCL
OneTest™
Performance
HKEY_LOCAL
_MACHINE\S
OFTWARE\Mi
crosoft\Wind
ows\CurrentV
ersion\Uninst
al\HCL
OneTest™
Performance

ii. HCL
OneTest™
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Description

Identified in version

Applicable in and until version

Performance
Agent -
HKEY_LOCAL
_MACHINE\S
OFTWARE\Mi
crosoft\Wind
ows\CurrentV
ersion\Uninst
al\HCL
OneTest™
Performance
Agent
Shell-shared
installer -
HKEY_LOCAL
_MACHINE\S
OFTWARE\Mi
crosoft\Wind
ows\CurrentV

ersion\Uninst
all\HCL
OneTest™
d. Right-click the entry
to be deleted, and
then click Delete.
e. Click Yes to confirm
the deletion.
5. Install the product.

62

TP-76
105

If your application uses TLS1.1

or TLS1, then HCL OneTest™
Performance cannot record or run
those test assets until you modify
the java.security file. This issue is
because TLS 1.1 and TLS1 are not
supported by Java.

To work around this problem, you

must perform the following steps:

10.2.0
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Description

Identified in version

Applicable in and until version

1. Navigate to
<location_of_the_product>\
IBM\SDP\jdk\jre\lib\security.

2. Open the java.security file
in any of the text-editing
programs to edit the content.

3. Locate the following
line of code:
tls. disabl edAl gorithnms=SSL
v3, TLSvi, TLSvl.1, RC4,
DES, MD5wi t hRSA

4. Remove TLSv1 and TLSv1.1
from the code.

5. Save the java.security file.

6. Restart HCL OneTest™

Performance

TP-73
401

When you install the product by
using the stand-alone installer

on macOS Catalina 10.15.7, the
product installation fails with an
error message. To work around

this problem, you must set the
Appearance option to Light under
System preference before you install
the product.

10.1.3

TP-72
726

When you use a calendar dialog

box to select a value in an SAP
transaction session and record

the SAP test in your product, the
Test Generation page and the

Error Log page display a warning
message.The warning message
states that the SAP calendar object
has an unpredictable behavior when
you play back the test and you must
set the date in the value fields by

10.1.3
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Description

Identified in version

Applicable in and until version

64

using the string format.Therefore,
when you select the Hide GUI during
the execution option from the SAP
Options tab in the Test Details
section to play back the SAP test,
the product is unable to create a
calendar object. Hence the test run
fails.

To work around this problem, you
must perform the following steps:

1. Open the SAP test.

2. Perform the following
actions to set the calendar
date in a text format:

a. Expand an SAP
transaction, and
then expand the
test element (For
example, IDoc
List/WEQ5) that has
the calendar control
data.

b. Select Set focus on
<date>.

c. Right-click the date
from SAP Protocol
Data, and then click
Create Element. The
Create Element page
is displayed.

d. Select Set text, and
then enter the date in
the Input value text
field.

e. Click Finish.

3. Right-click the calendar
control (For example,
Calendar/WEQ5), and then
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Description

Identified in version

Applicable in and until version

click Disable to disable the
test elements that have the
calendar control.

4. Save the changes, and then
run the test.

TP-70
696

When you record an SAP test by
selecting the Record from a running
session started with the SAP logon
option, then the schedule run fails
with the following error message
on the Test Log page or Execution

Event Console log page:

Connection with the existing
SAP GUI session or shortcut is
not allowed during schedule

execution

To work around this problem, you
must perform the following steps:

1. Record an SAP test that has
a logon session.

2. Place the transaction
session that you created
by using the Record from a
running session started with
the SAP Logon option.

3. Record an SAP test that has
the logoff session.

4. Save and run the schedule to
verify the transaction details.

Note: The session
created by the first test is

10.1.2
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Description

Identified in version

Applicable in and until version

considered as the current

session.

TP-69
141

You must decrypt and encrypt each
dataset by using the CSV Editor to
apply the strongest encryption on
each dataset that you used in the

earlier version of the product.

10.1.2

TP-62
667

When you install HCL OneTest™
Performance 10.1.0 on Red Hat
Linux Enterprise 8.0 or later, the
installation fails with an error
message. To work around this
problem, you must first install
li bnsl . so. 1 On your computer
for a successful installation

of the product. Alternatively,
you can create a soft link from
li bnsl . so. 2 by running the
following command on the
command-line interface:sudo I n
-s /usr/lib64/libnsl.so.2 /

usr/1ib64/libnsl.so.1

10.1.0

TP-66
551

When you record a Citrix test by
using an ICA file, the recording

fails with an error message. You
must first verify the values for

the parameters DesiredHRES and
DesiredVRES in the ICA file because
the values for these parameters are
set to 0 instead of a valid number.
To resolve this issue, you must first
set a value for the parameters to
record the Citrix test by using the
ICA file.

10.1.0
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Description

Identified in version

Applicable in and until version

TP-66
806

On Windows Server operating
systems, when you use HCL
OneTest™ Performance to run a

VU schedule that has Citrix test,
sometimes the playback fails
because an action from the test

is incorrectly played back by the
Citrix receiver. To resolve this issue,
you must install HCL OneTest™
Performance and HCL OneTest™
Performance Agent on Windows 10
operating systems when you want to
run the VU schedule that has Citrix
test.

10.1.0

TP-67
053

On Windows, there is an
incompatibility between the version
of Java packaged with the product
(OpenJDK Opend9 V1.8.0_252) and
AdoptOpenJDK14 when Symantec
Endpoint Protection is installed. To
work around this problem, uninstall
the AdoptOpenJDK14 product or
remove it from the PATH before

using the product.

10.1.0

TP-67
514

When you run tests or schedules
that have a file name with
non-English characters from the
command-line interface, then the

test run fails with an error message.

To work around this problem, you
must use CommandLine.exe to
run tests or schedules from the
command-line interface. You can
locate CommandLine.exe in the

following folder path:
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Description

Identified in version

Applicable in and until version

IBM\IBMIMShared\plugins\-
com.ibm.rational.test.lt.cmdlineexec
ute_7.2.3200.v<YYYYMMDD_HH
MM>

TP-57
089

In HCL OneTest™ Performance
10.0.0 and later, when you

set the environment variable,
JAVA_HOME, to the bundled JDK
that is shipped with the product,
tests that run from Jenkins show a
java.l ang. Qut Of MenoryError: Java
heap space error after completion of

the test run.

With 10.0.0 and later, you might
expect a reduction in the number
of Virtual Users (VUs) supported

by HCL OneTest™ Performance
Agent depending upon workload
characteristics. This variation is the
result of the product shipping with
OpenJDK 8 with OpendJ9 instead of
IBM JRE.

OpenJDK 8 with OpenJ9 JRE
exhibits a higher utilization of CPU
for the workload. Up to 30% or
more decrease in the supported
VUs capacity may be expected for
CPU-bound workloads. However,
for memory-bound workloads, a
much smaller, if any reduction in
VUs capacity may be expected. If
you need higher performance and
have access to IBM JRE 8.0.5.35
or later which contains the latest
security fixes, you can switch from
OpendJDK 8 with OpenJ9 to IBM

JRE. For more information, see

10.0.0
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Description

Identified in version

Applicable in and until version

http://www.ibm.com/support/docvi
ew.wss?uid=ibm10956413.

When you do performance
monitoring of the resources of

a remote Windows computer,

you specify the credentials of

that computer in HCL OneTest™
Performance. The credentials

are stored in a Windows file. If

the credentials of the remote
computer change and you updated
the credentials from HCL OneTest™
Performance, the test run with
Windows Performance Monitoring
will still fail. You must restart the
workbench computer and then
change the credentials from HCL
OneTest™ Performance.

When you playback a test
remotely such as from the
command line or Jenkins, the log
file in the workspace displays
lllegalStateException: Workbench
has not been created yet. error
message. The test will execute

successfully.

On Mac OS X, if you have HCL
OneTest™ Performance configured
for a floating license or Authorized
User License, you will get a
com.ibm.rational.test.It.licensing.RP
TLicenseExceptionerror the

first time you run a schedule.

The exception forces the

schedule to stop the execution

with a failure. After the initial

failure, all subsequent runs of

69


http://www.ibm.com/support/docview.wss?uid=ibm10956413
http://www.ibm.com/support/docview.wss?uid=ibm10956413

70

HCL DevOps Test Performance

Description

Identified in version

Applicable in and until version

schedules would pass without the

above-mentioned error.

Permanent known issues

When you do performance
monitoring of the resources of

a remote Windows computer,

you specify the credentials of

that computer in HCL OneTest™
Performance. The credentials are
stored in a Windows file. If the
credentials of the remote computer
changes and you updated the
credentials from HCL OneTest™
Performance, the test run with
Windows Performance Monitoring
will still fail. You must restart the
workbench computer and then
change the credentials from HCL
OneTest™ Performance.

You cannot install HCL OneTest™
Performance and Rational®
Performance Tester on the same
computer or package group. Also,
you cannot install or shell-share HCL
OneTest Performance with another
Rational testing product such as
Rational Test Workbench.

Running tests with Chrome
while logged in as root on Linux
computers is not supported.

When you start an information
center for the first time, you might
see an error "Unable to acquire

PluginConverter service during
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Description

Identified in version

Applicable in and until version

generation for error messages". You

can safely ignore the error.

Stop the information center and

then restart it.

There are a bunch of issues related
to Eclipse GTK 3. If you face any of
such issues, you can switch to using
GTK 2. See the list of issues.

To run SAP GUI tests with 20 or
more virtual users on Oracle JDK,
you can use the Long Run Mode
option. Otherwise, the SAP GUI tests
would fail.

After starting the product, a
message such as the following
appears in the product console:
The IBM Class Sharing Adaptor will
not work in this configuration. You
are not running on a J9 Java VM.
This message is displayed because
the version of Eclipse that is used
in the IDE is from IBM and has the
IBM Java optimizations enabled. To

resolve the issue:

1. Locate the com.ibm.cds
plugin in the Shared
installation directory of the
installed product.

2. Back up the plugin and then

remove it.
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Chapter 2. System Requirements for DevOps Test
Performance 2025.12 (11.0.7)

This document includes information about hardware and software requirements for HCL DevOps Test Performance (Test
Performance) 2025.12 (11.0.7).

Contents

« Hardware on page 73
o Linux on page 73
o Mac on page 74
o Windows on page 74
» Operating Systems on page 75
o Linux on page 76
o Mac on page 76
o Windows on page 77
» Host prerequisites on page 77
o Terminal services on page 78
o Virtualization Management on page 79
o Web Browsers on page 79
« Recording support on page 80
 Supported software on page 81
o Application servers on page 81
> Development tools on page 82
> DevOps tools on page 83
o Message Oriented Middleware on page 84

Disclaimers
This report is subject to the Terms of Use and the following disclaimers:

The information contained in this report is provided for informational purposes only. While efforts were made to verify the
completeness and accuracy of the information contained in this publication, it is provided AS IS without warranty of any kind,
express or implied, including but not limited to the implied warranties of merchantability, non-infringement, and fitness for

a particular purpose. In addition, this information is based on HCLs current product plans and strategy, which are subject

to change by HCL without notice. HCL shall not be responsible for any direct, indirect, incidental, consequential, special or
other damages arising out of the use of, or otherwise related to, this report or any other materials. Nothing contained in this
publication is intended to, nor shall have the effect of, creating any warranties or representations from HCL or its suppliers or

licensors, or altering the terms and conditions of the applicable license agreement governing the use of HCL software.

References in this report to HCL products, programs, or services do not imply that they will be available in all countries in
which HCL operates. Product release dates and/or capabilities referenced in this presentation may change at any time at
HCLs sole discretion based on market opportunities or other factors, and are not intended to be a commitment to future
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product or feature availability in any way. Discrepancies found between reports and other HCL documentation sources

may or may not be attributed to different publish and refresh cycles for this tool and other sources. Nothing contained in

this report is intended to, nor shall have the effect of, stating or implying that any activities undertaken by you will result in

any specific sales, revenue growth, savings or other results. You assume sole responsibility for any results you obtain or

decisions you make as a result of this report.

Notwithstanding the Terms of Use users of this site are permitted to copy and save the reports generated from this tool for

such users own internal business purpose. No other use shall be permitted.

Hardware

You can find information about the hardware requirements for HCL DevOps Test Performance (Test Performance)

Contents

* Linux on page 73
* Mac on page 74
« Windows on page 74

Linux
Hardware Components Requirement | Notes
Disk space Test Performance 10 GB - Disk space requirements can be
reduced or increased depending on
Test Performance Agent the features that you install.
 An additional 500 MB of disk space
is required in the /tmp directory.
Memory Test Performance 8GB « For best results with large test runs,
use 16 GB of RAM.
Test Performance Agent
- For best results with large test runs,
use a modern processor with 2.30
GHz or higher that supports the
supported Operating system.
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Mac

Hardware

Components

Requirement

Notes

Disk space

Test Performance

Test Performance Agent

10GB

- Disk space requirements can be
reduced or increased depending on

the features that you install.

« Large test runs can store several
gigabytes of data. Make sure that
you have adequate disk space before

attempting a large test run.

Memory

Test Performance

Test Performance Agent

8 GB

« For best results with large test runs,
use 16 GB of RAM.

- For best results with large test runs,
use a modern processor with 2.30
GHz or higher that supports the

supported Operating system.

Windows

Hardware

Components

Requirement

Notes

Disk space

Test Performance

Test Performance Agent

10GB

- Disk space requirements can be
reduced or increased depending on
the features that you install.

« Large test runs can store several
gigabytes of data. Make sure that
you have adequate disk space before

attempting a large test run.

« Additional disk space is required
if you use FAT32 instead of NTFS.
An additional 500 MB of disk space
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Test Performance Agent

Hardware Components Requirement | Notes
is required in the directory that you
specify in the environment variable
TEMP.

Memory Test Performance 8 GB

« For best results with large test runs,
use 16 GB of RAM.

« For best results with large test runs,
use a modern processor with 2.30
GHz or higher that supports the

supported Operating system.

Operating systems

You can find the operating systems that are supported, organized by operating system family for HCL DevOps Test

Performance (Test Performance).

Contents

* Linux on page 76

* Mac on page 76

» Windows on page 77

Bit version support

Different parts of a product might run on the same operating system but support different application bitness.

Bitness Description

64- The product or part of the product runs as a 32-bit application in the 64-bit platforms listed as supported.
Tolerate

64-Exploit | The product or part of the product runs as a 64-bit application in the 64-bit platforms listed as supported.
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Linux
Notes
Operating system Hardware Bitness Components
Desktop Agent
Red Hat Enterprise Linux (RHEL) 9.6 x86-64 64-Exploit v v
Red Hat Enterprise Linux (RHEL) 9.4 x86-64 64-Exploit v v
Red Hat Enterprise Linux (RHEL) 9.2 x86-64 64-Exploit v v Deprecated in
11.0.3
Red Hat Enterprise Linux (RHEL) 8.10 x86-64 64-Exploit v v
Red Hat Enterprise Linux (RHEL) 8.8 x86-64 64-Exploit v v Deprecated in
11.0.3
Ubuntu 22.04.1 LTS x86-64 64-Exploit v v
Mac
Operating system Hardware Bitness Components Notes
Desktop Agent
MacOS Sequoia 15
x86-64 64-Exploit v v
MacOS Sonoma 14
x86-64 64-Exploit v v
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Windows
Operating system Hardware Bitness Components Notes
Desktop Agent

Windows Server 2025 x86-64 64-Exploit v v

Windows 11 x86-64 64-Exploit v v

Windows 10 Enterprise x86-64 64-Exploit v v

Windows 10 Pro x86-64 64-Exploit v v

Windows Server 2022 x86-64 64-Exploit v v

Windows Server 2019 x86-64 64-Exploit v v Deprecated in
11.0.3

Windows Server 2016 x86-64 64-Exploit v v 4 Deprecated in
10.5.0

Host prerequisites

You can find the host prerequisites that support the operating capabilities for HCL DevOps Test Performance (Test

Performance)

Contents

« Installation tool on page 77

« Licensing on page 78

» Terminal services on page 78

« Virtualization Management on page 79

« Web Browsers on page 79

Installation tool

Installation Tool Version

IBM® Installation Manager 1.10.1




HCL DevOps Test Performance

Licensing
License Server Version Test Performance
Notes
My HCLSoftware (MHS)
Latest Cloud version " 4
HCL Local License Server 5.0 v
HCL Local License Server 5.1 v
HCL Local License Server 5.2 v
Terminal services
Supported software Vers Components Notes
ion
Des |Agent
ktop
Citrix Workspace App 23.03 | " |Not
applicable
Citrix Receiver 49 " | Not
applicable
Citrix XenApp 6.5 +" | Not ]
) For remote terminal access.
applicable
Citrix XenDesktop 7.8 " |Not
applicable
Citrix Virtual Apps and 7.0 " |Not
Desktops applicable
8
SAP GUI 4 W To record and playback tests of SAP applications built with the
SAP GUI client.
7.7 v v
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Notes
Containers Vers Components
ion
Des |Agent
ktop
28.4.0
Docker Engine v v
28.3.0
v v
28.0.4 Deprecated in
o L 11.0.7
27.5.0
v v
2.39
Docker v v
Compose
2.38.0
4 v
2.34.0 Deprecated in
v v

11.0.7

Web Browsers

The following versions of web browsers support the viewing of performance reports and datasets. See Recording support on

page 80 to know the browsers that are supported to record the HTTP tests.

Notes
Browsers Version Components
Des |Agent
ktop
Apple Safari 18 or later %" | Not applicable

Google Chrome

136 or later| &

Not applicable

Microsoft Edge

136 or later|

Not applicable
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Notes
Browsers Version Components
Des |Agent
ktop
Mozilla Firefox (including ESR 128 or later v Not applicable
versions)

Recording support

You can find information about the web browsers that support recording capability of HTTP tests for HCL DevOps Test

Performance (Test Performance)

Web browsers

The following versions of web browsers support the recording of HTTP tests. See Web Browsers on page 79 to know the

browsers that are supported to view the performance reports.

Supported Browsers Version Desktop
26

Apple Safari v
18 v
141 to 143

Google Chrome v
136 to 140
13210135
141 t0 143

Microsoft Edge v
135t0 140
13210134

Mozilla Firefox 143 to 145 v
137 t0 142
134t0 136
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Supported Browsers Version Desktop
140

Mozilla Firefox ESR v
128 v

Supported software

You can find the additional software that is supported for HCL DevOps Test Performance (Test Performance).

Contents

« Application servers on page 81

« Development tools on page 82

« DevOps tools on page 83
* Message Oriented Middleware on page 84

Application servers

Support for the following application servers is in reference only to the HTTP response Time Break Down capability:

Supported software Vers Components Notes
ion
Des [Agent
ktop
IBM® WebSphere Application |8.5.5 " | Not
Server applicable
8.5.5 " [Not WebSphere Application Server 8.5.5.20 onwards supports
.20 applicable |Java 8.
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Development tools

Supported software Vers Components | Notes
ion
Desk | Agent
top
eGit 6.5 +" | Not To store your test assets in the remote Git repository and use eGit for
applica version control operations.
ble

IBM® Engineering Test | 7.1 + | Not
Management applica
ble

7.03| % |[Not
applica
ble

To initiate the test runs from Engineering Test Management.

IBM® Engineering 7.03| " |Not
Workflow Management applica
ble

To perform integrations with Engineering Workflow Management.

DevOps Test Ul 11. " |Not
0.7 applica
ble

Eclipse shell sharing and to run WebUI integrations.

DevOps Test Workbench | 11. +" | Not

To integrate and run Test Integrations and APlIs tests.

0.7 applica
ble
JMeter 56.3| « [Not To integrate and run JMeter tests.
applica
ble

5.6.2 " |Not
applica
ble

To integrate and run JMeter tests.
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Supported software Vers Components | Notes
ion
Desk | Agent
top
543 | « |Not To integrate and run JMeter tests.
applica
ble
DevOps tools
Supported software | Version Components Notes
Des Agent
ktop

Apache Ant 1.9 or later v Not applicable | To initiate the test runs from ANT.
Azure DevOps Latest v Not applicable | To initiate the test runs from Azure DevOps pipeline.

8.1.2.3
HCL DevOps Deploy v Not applicable

8.1.1

v Not applicable | To initiate the test runs from Deploy.

8.0.1.2 + | Notapplicable

8.0 + | Notapplicable
HCL® Launch 7322 v Not applicable | Deprecated in 11.0.4

7.3.0 v Not applicable | Deprecated in 11.0.4

7.2.3.0 v 4 Not applicable | Deprecated in 11.0.1

7.21.0 v Not applicable | Deprecated in 11.0.1
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IBM® MQ

84

9.2.1 v v

Supported software| Version Components Notes
Des Agent
ktop
2.524
Jenkins v Not applicable | To initiate the test runs from Jenkins.
2.479.2
v Not applicable | To initiate the test runs from Jenkins. Deprecated in
11.0.7
2.492.3 To initiate the test runs from Jenkins.
%  |Not applicable
2.462.3 v Not applicable | To initiate the test runs from Jenkins. Deprecated in
11.0.7
Maven 3.5 or later v Not applicable | To initiate the test runs from Maven.
Microfocus ALM 12.6 v Not applicable | To initiate the test runs from Microfocus ALM.
Github Actions Latest v Not applicable | To initiate the test runs from Github Actions.
DevOps Loop 2.0.0
+" | Not applicable
DevOps Test Hub 11.0.7
+ | Not applicable
Message Oriented Middleware
Supported software | Vers Components
ion
Des |Agent
ktop
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Supported software | Vers Components
ion
Des |Agent
ktop
9.0.5 v v
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Chapter 3. Getting Started

This guide provides an overview and describes the task flows to get you started with HCL DevOps Test Performance (Test

Performance). This guide is intended for new users.

You can find the following information:

« Task flows for performance testing on page 86
« DevOps Test Performance overview on page 100

« Streamlined Eclipse and full Eclipse overview on page 109

Task flows for performance testing

The task flows are designed to help you understand the end-to-end process of some of the capabilities of performance
testing. For some of the technologies, there are specific task flows that you can follow to gain a clear understanding of the

process.

Task flow: HTTP record

The diagram shows the task flow of HTTP recording to test the performance of an application using HCL DevOps Test
Performance (Test Performance).

To test the performance of an application, you must first record the HTTP traffic that traverses between the client and the

server.

Once you complete the basic HTTP recording, play it back and fix the errors, if any. You can then customize your test by
adding other elements such as datasets, loops, and transaction.
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Task flow: Generating workload
The diagram shows the task flow of generating workload by creating user groups and dividing the load across different

remote agents.

The agents generate load on the application under test. The number of agents required depends on various factors including
the size of the load you want to put on the application under test, hardware capacity of systems that install the agents, and

the application under test itself.
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1. Installing DevOps Test Performance on page 139
2. Creating a VU Schedule on page 701
3. Defining requirements in schedules on page 736
4. Enablement of Resource Monitoring services for a schedule on page 748
5. Running a local schedule or test on page 781
6. Evaluating results in web analytic reports on page 961
7. Publishing test results to the server on page 966
8. Running a user group at a remote location on page 713

9. Checking the status of agents on page 731
10. Setting user loads on page 705
11. Adding a user group to VU Schedule on page 709
12. Adding a test to a schedule on page 734
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Task flow: Recording a SAP test

The task flow shows the recording of interactions with the SAP GUI client to generate a SAP test.

The recording wizard opens the SAP GUI client and records all the interactions that occur between the client and the server.
You can record a SAP test by using the HTTP SAP Portal option to measure the performance of a SAP Portal from a web
interface. After you complete SAP recording or HTTP recording session with SAP portal, you must play it back and fix the
errors, if any. You can add other HCL DevOps Test Performance (Test Performance) elements such as data correlation,
verification points, and loops and playback the test again to evaluate the results.
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Note: If a test is not behaving as expected during playback, you must ensure that the connection to the SAP server is
available. For more information, see SAP connection details on page 1227.
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. Recording an SAP test on page 384

. Recording a session with HTTP SAP Portal on page 390
. Running a local schedule or test on page 781

. Running a local schedule or test on page 781

. Evaluating results in web analytic reports on page 961

. Correlating response and request data on page 615

. Verifying application behavior on page 522

. Adding a loop to a test on page 569

. SAP Performance report on page 1033
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Task flow: Recording a service test to test an SOA application

The task flow shows the testing services in an SOA environment. You can record a test session by invoking service calls by

using a generic service client or an existing client.

To test the performance of an SOA application, you must record a service call and create a service test. After you complete
the service test recording, play it back and fix the errors, if any. You can edit your service test to include verification points,

data correlations, loops, and play back the test again to evaluate the results.
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. Recording service tests on page 413

. Running a local schedule or test on page 781

. Running a local schedule or test on page 781

. Correlating response and request data on page 615
. Verifying application behavior on page 522

. Adding a loop to a test on page 569

. Web service reports on page 1041

. Generating functional reports on page 963

93



HCL DevOps Test Performance

Task flow: Recording a SAP batch input test

The task flow shows the recording of certain SAP transaction sessions from SAP GUI with SAP batch input tests recording
wizard. When you record a session, the recording wizard automatically starts a SAP GUI interface and records the
transaction that you specified. Typically, you use batch input tests in a schedule mixed with normal SAP performance tests to

increase the load on the server.

After you complete the recording, the wizard generated a SAP batch input test in Test Performance. You can then play it back

again to fix the errors, if any.

Note:

« You must perform the recording of certain SAP transaction sessions from SAP GUI. For more information, see
Recording a SAP batch input test on page 393.
- If a test is not behaving as expected during playback, you must ensure that the connection to the SAP server

is available. For more information, see SAP connection details on page 1227.

Later, you can add the other Test Performance elements such as data correlation, verification points, loops, transactions, and

custom codes to test and playback the test to evaluate the results.
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1. Recording a SAP batch input test on page 393
2. Running a local schedule or test on page 781
3. Data correlation overview on page 615
4. Verifying application behavior on page 522
5. Adding a loop to a test on page 569
6. Adding a transaction to a test on page 566
7. Creating custom Java code on page 846
8. Running a local schedule or test on page 781
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10. SAP Performance report on page 1033
11. Generating functional reports on page 963



HCL DevOps Test Performance

Task flow integrating DevOps Test Performance and DevOps Test Integrations and APls

You can execute integration tests in HCL DevOps Test Performance (Test Performance) by using Test Performance
Extension for Test Integrations and APIs. In Test Performance, you can create a compound test to run the integration tests by

using agents.

To integrate tests, you must install Test Performance Extension for Test Integrations and APIs. Also, to execute the tests
remotely, you must install Test Performance Agent and Test Integrations and APIs Agent.

After installing all the required software, you must set the environment variable and connect to the integration project. To
open the Test Integrations and APIs project from Test Performance Test Navigator, you must set the path to the execution
file in the Test Integrations and APIs preferences. Later, you must create a compound test and play back the test to evaluate

the results.
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Task flow: Rate Scheduler

The task flow shows running a rate scheduler to monitor the workload at the desired rate (transactions per second).

After installing HCL DevOps Test Performance (Test Performance) agent, you must create a rate scheduler by adding
elements such as rate runner group, tests, user load, and checking the agent status. Then, you must define the performance
requirements for a schedule to specify the acceptable thresholds to validate the service-level agreements. Later, you must
enable the resource monitoring service and play back the scheduler to evaluate the results.
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. Installing DevOps Test Performance on page 139

. Setting rate load on page 719

. Rate Runner group overview on page 720

. Creating a Rate Schedule on page 718

. Checking the status of agents on page 731
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. Defining requirements in schedules on page 736
9. Enablement of Resource Monitoring services for a schedule on page 748
10. Running a local schedule or test on page 781
11. Transaction report on page 1005
12. Rate Runner report on page 1003
13. Evaluating results in web analytic reports on page 961
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DevOps Test Performance overview

You can gain the conceptual understanding of HCL DevOps Test Performance (Test Performance) and its test extensions

with these topics.

You can find the following information:

« HTTP performance testing overview on page 100

» SAP performance testing overview on page 101

« Citrix performance testing overview on page 101

« Service testing overview on page 103

« Generic service client overview on page 104

» Socket API performance testing overview on page 106
» TN3270 performance testing overview on page 107

* IBM Engineering Test Management overview on page 107

HTTP performance testing overview

There are five stages when performance testing HTTP applications: test creation, test editing, workload emulation with

schedules, schedule execution, and evaluation of results.

« Test creation. Although it is possible to write a test from scratch, you generally create HTTP performance tests by
recording representative interactions with an application. These actions are saved and a test is generated from these
recorded actions. Test recording and related tasks are explained in Recording HTTP tests on page 357.

- Test editing. After recording a test, run it individually and inspect the results to make sure that the HTTP tests are
doing what you expect. You might want to edit your tests. Typical changes that you might make are:

> Replacing a value in a recorded test with values in a dataset. This produces more realistic test data. Providing
tests with variable data (datasets) on page 586 explains how to use datasets to replace data.

- Adding dynamic data to a test (referred to as data correlation). Data correlation, including how to manually
correlate test values, is explained in Correlating response and request data on page 615.

- Enabling verification points, so that you can determine whether an expected behavior occurred. Verification
points are explained in Verifying expected behavior on page 476.

- Workload emulation with schedules. After editing HTTP tests, you create a schedule. You add user groups to the

schedule and add appropriate tests to each group to emulate a task. A typical schedule contains the following:
> User groups and tests. A schedule requires at least these items to run.
> User groups running from a remote location. This separates your workbench activity and your load-adding
activity. For more information, see Running a user group at a remote location on page 713.
> Optional schedule items, such as loops, delays, and think time behavior settings, to further emulate a load.
For more information, see Emulating workloads on page 700.
- Schedule execution. You typically run a schedule as explained in Running a local schedule or test on page 781.
- Evaluation of results. Reports are displayed during the schedule run. You can also regenerate reports after the run,

customize reports, and export reports in HTML format, so that others who do not have the product can see them.
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SAP performance testing overview

With HCL DevOps Test Performance Extension for SAP (Test Performance Extension for SAP) Solutions, you can test the

performance of SAP applications.

Informative performance test results rely upon sound test development. Each of the following stages contributes to

generating meaningful results when performance testing SAP applications:

« Test creation. You create your test by recording a session with the SAP GUI client. Typically, the recorded session
starts when you log on to the SAP server. You then interact with the application in order to produce a relevant
performance test, and the session ends when you log out. The recorded session is split into transactions and SAP
screens. Response time measurements and verification points are automatically added to transactions and SAP

screens.

Test editing. After recording, you can edit the events in each transaction and SAP screen. With the SAP Protocol Data
view, you can use snapshots of the SAP screen to edit the events. You can replace recorded test values with variable
test data, or add dynamic data to SAP tests. You can also set verification points on field values or window titles to
validate that the test behaved as expected.

Test validation. Before deploying the test, you can run the test manually as a single virtual user to make sure that the
test runs smoothly and produces the expected results in a nominal environment with minimal server load. You can

experience multiple test editing and validation cycles before your test is robust.

.

Workload emulation with schedules. When the test runs repeatedly as anticipated, you specify an execution schedule
and user groups to emulate a workload that is generated by a large number virtual users. You can add SAP batch

input tests to the schedule to simulate a heavy load on the servers while minimizing virtual tester resources.

Schedule execution. You run the schedule, deploying test execution over virtual users that can be hosted on remote
hosts. Each virtual user runs an instance of the SAP GUI client. Response time results are provided by the SAP server
and recorded. Verification points are checked and results are recorded.

- Evaluation of results. You evaluate the results produced by the SAP performance tests through the various reports

that are generated during execution. You can also design custom reports.

Citrix performance testing overview

HCL DevOps Test Performance Extension for Citrix (Test Performance Extension for Citrix) Presentation Server allows you to

test the performance of Citrix applications.

Informative performance test results rely upon sound test development. Each of the following stages contributes to

generating meaningful test results:

- Test creation. You create your test by recording a session with the Citrix XenApp client. Typically, the recorded
session starts when you log in to the Citrix server. You then interact with the application to produce a relevant
performance test. The session ends when you log out. The recording is split into window events and contains
keyboard and mouse interactions with the Citrix server. You can use the Citrix Recording Control window to add
screen captures or comments. You can add image synchronizations to help the test remain synchronized with the

server.
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- Test editing. After recording, you can edit the events in each window element. Because the recorded input is primarily
made of low-level keyboard and mouse input, you can streamline the test by, for example, replacing key-press events
with string inputs. You can use the comments and recorded screen captures to make navigating through the test
easier. You can replace recorded test values with variable test data, or add dynamic data to the test. You can also set
verification points on window titles or image synchronizations to validate that the application behaves as expected.

- Test validation. Before deploying the test, you can run the test manually as a single virtual user to make sure that the
test synchronizes user input actions and server output correctly in a nominal environment with minimal server load.
You might experience multiple test editing and validation cycles before your test runs as expected.

- Workload emulation with schedules. When the test runs repeatedly as anticipated, you specify an execution schedule
and user groups to emulate a workload that is generated by a large number of virtual users.

 Schedule execution. You run the schedule, deploying test execution over virtual users that can be hosted on remote
hosts. Each virtual user runs an instance of the Citrix client.

- Evaluation of results. You evaluate the results produced by the tests through the various reports that are generated

during execution. You can also design custom reports.

Prerequisites

Before you can test the performance of Citrix applications, a Citrix XenApp client must be installed on the same computer as
Test Performance. The Citrix XenApp client is required for recording and execution of performance tests.

Ensure that you have a working Citrix client environment and that you can connect to a Citrix server. .

If you are deploying tests over remote computers to emulate a large number of users, the following software must be

installed on each remote computer:

« The Citrix XenApp client

« The Test Performance Agent

Limitations

Citrix performance tests use window creation and change events, and optionally image recognition techniques, to
synchronize user input with server output. Before you record a session with a Citrix application, the behavior of that
application must be perfectly reproducible. Specifically, the application must always create windows and GUI elements at the
same locations and in the same sequence. Mouse or keyboard events must always produce the same output. Consider these

examples:

« If the application displays windows or dialog boxes on only the first execution of a particular program or feature, such
as tips or security warnings, ensure that they are disabled when you record the test. Any windows or dialog boxes
that were recorded but are not displayed on subsequent executions, or displayed at different coordinates on the
screen, will fail the test and cause synchronization timeouts.

« If you save a file during a recorded session, the application might issue a warning for an existing filename when you
replay the tests. If the warning was not in the recorded session, this will fail the test and cause errors.
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It is essential to be aware of the context of user actions when you edit a test. Because the Citrix performance tests interact
with the Citrix XenApp client at a very low level (mouse movements and key presses) any changes that you make to the test
after the recording, such as moving test elements, adding loops or conditions, or inserting new sequences, can alter the
context of the emulated user actions and cause synchronization timeouts.

Service testing overview

The service testing capabilities of HCL DevOps Test Performance (Test Performance) automate the creation, execution
and analysis of functional, regression and performance tests for SOAP-based web services, including support for Java
Messagine Service (JMS), Websphere MQ, WebSphere Java MQ, and Microsoft .NET Windows Communication Foundation
(WCF), as well as any service that produces XML, plain text, or binary data.

Informative test results rely upon sound test development. Each of the following stages contributes to generating meaningful

test results:

« Preparation. Set up your test environment with the libraries and configuration files required for SOAP-based web
services or custom security algorithms. You can import Web Service Description Language (WSDL) definition files
and digital certificates that are required by the web services to automatically generate your tests. You can create

SOAP security profiles with security algorithms for the web service calls and message returns.

.

Test creation: Create your test by recording the service requests and responses either with the generic service client,
or with an existing client or a web browser through a recording proxy. When you start the recording, you interact with
the service by performing service requests and receiving responses. You can also create service tests manually or

from a synchronous Business Process Execution Language (BPEL) model.

.

Test editing: After recording, you can edit the requests and responses in the test. You can use XML Schema
Description (XSD) documents to facilitate XML edition. You can replace recorded test values with variable test data,

or add dynamic data to the test.

Functional testing: You can run the test to ensure that service matches the expected behavior defined in verification
points. During the run, each verification point is checked and receives a pass, fail or inconclusive status.

Performance testing: If you are using Test Performance, you can specify an execution schedule and user groups to
emulate a workload that is generated by a large number of virtual users. Then, you can run the schedule, deploying
test execution on virtual users that can be hosted on remote computers. Each virtual user runs an instance of the test
client. Response times are measured and recorded. Verification points are checked and recorded.

Stub simulation: Service stubs are functional simulations of an existing service. Service stubs are useful for replacing
a service that is unavailable or impractical to use in a test environment. They can also be used to input specific data
into a service under test or for prototyping. You can deploy stubs onto a stub server, which can replace the actual

server in your test or development environment.

Evaluation of results: You evaluate the results that the tests produce through the performance and verification point
reports that are generated during execution. You can also design custom reports by manipulating various counters.

Functional reports provide a comprehensive view of the behavior of the service under test. Reports can be exported

and archived for validation.

Service testing tools

The following tools are available in the product:
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- The generic service client enables you to manually perform service requests for a wide variety of transport protocols,
authentication configurations and security profiles, making it an extremely versatile service client. It effectively
replaces a dedicated client and can be used to record service calls or for manual testing and debugging a service
during development. To open the generic service client, click the Generic Service Client [ toolbar button.

« The WSDL security editor allows you to set up sophisticated algorithm stacks for your service requests and
responses. Algorithm stacks contain digital certificate information and the security algorithms that are applied to
messages to perform secure communication with a web service. Algorithm stacks are made of blocks, which can be
key definitions, encryption , time stamp, or signature operations which can be associated with any operation in the
WSDL file. To open the WSDL security editor, right-click a WSDL file in your workspace and select Edit WSDL Security

or click the WSDL Security Editor == button in the generic service client..

- The test editor is where you develop your test. After recording, you can modify the test to add data correlation or
verification points. You can also add loops and conditions and you can edit every detail of the service requests.

« The stub editor enables you to create service stubs. With the stub editor, you can define multiple input conditions,
which are similar to verification points. Each condition triggers a predefined simulated response, which is functionally
identical to a response from the simulated service.

- In Test Performance, the schedule editor lets you deploy multiple virtual users on local and remote computers to
generate a heavy load for performance testing. A schedule typically contains multiple tests and multiple virtual users.

Generic service client overview

The purpose of the generic service client is to send requests to any service that uses an HTTP, JMS, WebSphere® MQ, or
Microsoft™ .NET transport. The generic service client also displays the response returned by the service.

The generic service client is useful for debugging or testing a service when you do not have access to a dedicated client to
send the request. You can set up a large variety of transport and security configurations for the service, edit the parameters
of the request and send attachments.

When a request is successfully invoked, its message return is added to the Request History. You can use this feature to look
back at results that were produced at different times.

If you are using Test Performance, you can select requests in the Request History and click Generate Test to generate a
test that will replay all the selected requests. You can edit the test to replace recorded test values with variable test data, or
add dynamic data correlation to the test. You can also set verification points on the contents of the XML documents in the

service response.

Supported services

The generic service client enables you to send requests for many types of services that use the following transport

protocols:

« HTTP

« Java™ Message Service (JMS), including JBoss and WebSphere® implementations
» WebSphere® MQ

* Microsoft™ .NET Framework Windows™ Communication Foundation (WCF).
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Encryption and security

The Java™ Runtime Environment (JRE) that the product uses must support the level of encryption required by the digital
certificate that you select. For example, you cannot use a digital certificate that requires 256-bit encryption with a JRE that
supports only 128-bit encryption. By default, the product is configured with restricted or limited strength ciphers. To use less
restricted encryption algorithms, you must download and apply the unlimited jurisdiction policy files (I ocal _policy.j ar

and US_export _policy.jar).

For Oracle Java, download the files from this site:http://www.oracle.com/technetwork/java/javase/downloads/jce8-
download-2133166.html.

Before installing these policy files, back up the existing policy files in case you want to restore the original files later. Then
overwrite thefilesin/jre/li b/ security/ directory with the unlimited jurisdiction policy files.

SSL Authentication

Service tests support simple or double SSL authentication mechanisms:

- Simple authentication (server authentication): In this case, the test client needs to determine whether the service can
be trusted. You do not need to setup a key store. If you select the Always trust option, you do not need to provide a

server certificat key store.

If you want to really authenticate the service, you can configure an certificate trust store, which contains the
certificates of trusted services. In this case, the test will expect to receive a valid certificate.

« Double authentication (client and server authentication): In this case, the service needs to authenticate the test
client according to its root authority. You must provide the client certificate keystore that needs to be produced to

authenticate the test as a certified client.

When recording a service test through a proxy, the recording proxy sits between the service and the client. In this case, you
must configure the SSL settings of the recording proxy to authenticate itself as the actual service to the client (for simple
authentication), and as the client to the service (for double authentication). This means that you must supply the recording

proxy with the adequate certificates.

When using stub services, you can also configure the SSL settings of the stub service to authenticate itself as the actual

server. This means that you must supply the service stub with the adequate certificate.

NTLM and Kerberos Authentication

The product supports Microsoft™ NT LAN Manager (NTLMv1 and NTLMv2) and Kerberos authentication. The authentication
information is recorded as part of the test during the recording phase.

To enable NTLMv2 support, you must add a third party library to the workbench. For more information, see Configuring the

workbench for NTLMv2 authentication on page 678.
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Digital certificates

You can test services with digital certificates for both SSL and SOAP security protocol. Digital certificates must be contained
in Java™ Key Store (JKS) keystore resources that are accessible in the workspace. When dealing with keystore files, you must
set the password required to access the keys both in the security editor and the test editor. For SOAP security you might have
to provide an explicit name for the key and provide a password to access the private keys in the keystore.

Limitations
Arrays are not supported.

Because of a lack of specification, attachments are not supported with the Java™ Message Service (JMS) transport. The
envelope is directly sent using UTF-8 encoding.

All security algorithms are not always available for every Java™ Runtime Environment (JRE) implementation. If a particular
security implementation is not available, add the required libraries to the class path of the JRE that this product uses.

The Microsoft™ .NET transport protocol does not support transactions, scopes, or duplex mode requests such as callbacks
or two-way services based on the MS-MQ transport.

Socket API performance testing overview

With HCL DevOps Test Performance (Test Performance) Extension for Socket Protocols, you can test the performance of any
application that uses a TCP/IP socket-based protocol.

Informative performance test results rely upon sound test development. Each of the following stages contributes to the
generation of meaningful test results:

« Test creation. You create your test by recording a session with a client application. Typically, the recorded session
starts when you run the client application. You then interact with the application in order to produce relevant network
traffic, and the session ends when you close the application or end the recording. The recording is used to generate a
performance test that reproduces the behavior of the client application.

- Test editing. After recording, you can edit the events that were recorded. You can replace recorded test values with
variable test data or add dynamic data to the test.

« Test validation. Before deploying the test, you can run the test manually as a single virtual user to make sure that the
test runs smoothly and produces the expected results in a nominal environment with minimal server load. You might
experience multiple test editing and validation cycles before your test runs as expected.

- Workload emulation with schedules. When the test runs repeatedly as anticipated, you specify an execution schedule
and user groups to emulate a workload that a large number of virtual users generates.

 Schedule execution. You run the schedule, deploying test execution over virtual users that can be hosted on remote
hosts. Each virtual user runs an instance of the test. Response time results are collected.

- Evaluation of results. You evaluate the results produced by the tests through the various reports that are generated
during execution. You can also design custom reports.
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TN3270 performance testing overview

With HCL DevOps Test Performance (Test Performance) Extension for Socket Protocols, you can test the performance of
TN3270 terminal server applications.

Informative performance test results rely on sound test development. Each of these stages contributes to the generation of
meaningful test results:

- Test creation. You create a test by recording a session with a client application. Typically, the recorded session starts
when you run the TN3270 terminal client. You then interact with the application in order to produce relevant network
traffic. The session ends when you close the terminal client or end the recording. The recording is used to generate a
performance test that reproduces the behavior of the client application.

- Test editing. After recording, you can edit the recorded events. You can replace recorded test values with variable
test data or add dynamic data to the test.

- Test validation. Before deploying the test, you can run the test manually as a single virtual user to make sure that the
test runs smoothly and produces the expected results in a nominal environment with minimal server load. You might
complete multiple test editing and validation cycles before your test is robust.

» Workload emulation with schedules. When the test runs repeatedly as anticipated, you specify an execution schedule
and user groups to emulate a workload that a large number of virtual users generates.

- Schedule execution. You run the schedule, deploying test execution over virtual users that can be hosted on remote
hosts. Each virtual user runs an instance of the test. Response time results are collected.

« Evaluation of results. You evaluate the results that the tests produce through the various reports that are generated

during execution. You can also design custom reports.

IBM® Engineering Test Management overview

IBM® Engineering Test Management is a collaborative, web-based, quality management solution that offers comprehensive

test planning, manual testing, and integration with other test tools.

Quality Manager is based on the IBM® Rational® Jazz™ platform (http://jazz.net and http://www.ibm.com/software/rational/
jazz/) and inherits many characteristics from that platform. Engineering Test Management is designed to be used by test
teams of all sizes and supports a variety of user roles, such as test manager, test architect, test lead, tester, and lab manager,
as well as roles outside the test organization.

Comprehensive test planning

A test plan that you define in Engineering Test Management drives activity for distributed teams through all phases of
the project life cycle. The test plan defines the objectives and scope of the test effort and contains criteria to help teams

determine the answer to the question "Are we ready to release?"

The test plan can be configured to meet the needs of your organization. You can use the test plan to do any and all of the
following tasks:
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- Define business and test objectives

« Establish a review and approval process for the test plan and for individual test cases

- Manage project requirements and test cases and establish the interdependencies between the two
« Estimate the size of the test effort

- Define the schedule for each test iteration and track the dates of other important test activities

- List the various environments to be tested and generate test configurations

« Create a read-only snapshot of the test plan at a particular point in time

« Define quality goals, entrance criteria, and exit criteria

- Create and manage test cases

Test script construction, execution, and reuse

Engineering Test Management provides a full-featured manual test editor. You can add reuse and automation capabilities to
your manual tests by using keywords.

With Engineering Test Management, you can manage and execute test scripts that are created with tools such as Test
Performance.

You can also import test artifacts from external test management solutions, such as IBM® Rational® ClearQuest®.

Test analysis and reporting

Engineering Test Management includes several standard test reports to help you evaluate test results. Reports are available
during all phases of the test process.

You can use reports to perform these tasks:

« Determine the validity of a test run.
» Check feature coverage against test plans, test inputs, configurations, and so on. This can also be used to measure
test progress and to analyze trends.

« Run a gap analysis to measure the resources needed to do your testing versus the resources that are available

Team collaboration

Engineering Test Management makes it easy to share information with other members of your team. With the Jazz-based
work-item system, team members can assign tasks and defects to each other and to view everyone's status. Test plan
authors and test case designers can distribute their work for review and track the status of each reviewer. New and changed
requirements are visible to the team, as are the test cases that are needed to satisfy those requirements. Team members are
notified automatically of any changes and milestones that impact their work.

Lab management

With Engineering Test Management lab management capabilities, you can create requests for the test environments that

your test plan specifies. You can then work with the lab manager to ensure that lab resources and test environments are
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available when needed. Lab managers can track all lab resources from a centralized resource repository and fulfill requests

from the test team.

Web application security

Engineering Test Management helps IT and security professionals protect against the threat of attacks and security
breaches. Security testing for your web applications can result in higher-quality, more secure applications at a reasonable

cost.

Governance

Engineering Test Management helps ensure that your business processes comply with industry, corporate, and departmental
standards and regulations. Throughout the testing life cycle, Engineering Test Management provides you with the tools

to obtain an up-to-the-minute measurement of software quality and project metrics. With its comprehensive test plan and
integration with requirements management and defect tracking tools, Engineering Test Management helps streamline your

test strategy and produce reliable records of test results and project history.

Streamlined Eclipse and full Eclipse overview

When you work in the streamlined Eclipse mode, only those functions that are directly related to the product are enabled in
the workbench. When you install the product, by default, the check box to use the streamlined Eclipse mode is selected. With

the full Eclipse mode, you have access to all Eclipse functions.

The streamlined Eclipse mode disables options from the menus that are not typically used during testing. Both the
fully-enabled and streamlined Eclipse modes can operate using the same workspace, so if you start the product in the
streamlined mode and discover that you cannot accomplish all of your tasks, you can close the workbench and restart it in

the full Eclipse mode.

The choice of the mode in which to start the product depends on the user's activity and objectives. The streamlined mode
is designed for straightforward testing and shows only those menu items that are related to testing. However, this restricts

functions. The following list includes use cases where the full Eclipse mode might be preferred:

« You have multiple products installed and you want to use them in the same session.

« You are using the profiling and logging features. The profiling and logging view is not available in the streamlined
mode.

- You are using advanced features of custom code including debugging custom code. For more information on custom

code, see Extending test execution with custom code on page 845.

Starting DevOps Test Performance in full Eclipse mode

You can start the product in the full Eclipse mode to continue to use native Eclipse features along with HCL DevOps Test
Performance (Test Performance).

Before you begin
You must have installed Test Performance.
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1. Click Start > HCL > - Full Eclipse.
2. Perform the following steps to select a working directory, if you are starting the installation of Test Performance for
the first time.

a. Enter the path of a wor ki ng direct ory in the Workspace field or click Browse to select the directory.

b. Select Use this as the default and do not ask again to make this your default workspace.

You can change your workspace from Test Performance by clicking File > Switch Workspace.

3. Click OK.

Results
You have started Test Performance in full Eclipse mode.

Starting DevOps Test Performance in streamlined Eclipse mode

If you do not want to view native Eclipse Ul, you can start HCL DevOps Test Performance (Test Performance) in streamlined

mode.

Before you begin
You must have installed Test Performance.

Note: To start Test PerformanceTest Performance in the streamlined mode, the streamlined mode must be installed
as an optional feature. It is automatically selected during the installation process.

1. Click Start > HCL > .
2. Perform the following steps to select a working directory, if you are starting the installation of Test Performance for

the first time.
a. Enter the path of a wor ki ng direct ory in the Workspace field or click Browse to select the directory.

b. Select Use this as the default and do not ask again to make this your default workspace.

You can change your workspace from Test Performance by clicking File > Switch Workspace.

3. Click OK.

Results

You have started Test Performance in streamlined Eclipse mode.
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This section contains the tutorials which explains the main features of HCL DevOps Test Performance (Test Performance).

You can find the following information:

» Performance test a Web application on page 111
« Performance test an SAP application on page 119

 Performance test a Citrix application on page 124

Performance test a Web application

The movies in this tutorial show you the main features of HCL DevOps Test Performance (Test Performance). The tutorial
requires Flash Player to view.

Learning objectives
You will learn how to perform the following tasks:

« Record user actions to create a test

« Create a schedule, which enables you to run multiple tests and control how they run
* Run the schedule

« Analyze the results from the schedule run

Time required
45 minutes

Introduction: Test a Web application

This tutorial is designed to introduce you to testing.

Learning objectives
The tutorial is divided into six modules, each with its own learning objectives. You will learn to:

« Record a user actions to create a test
- Create a schedule, which enables you to run multiple tests and control how they run.

 Analyze the results from the schedule run

Time required
This tutorial should take approximately 45 minutes to finish. If you explore other concepts related to this tutorial, it could take
longer to complete.

Skill level
Beginner
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Prerequisites
This tutorial assumes that you are familiar with using the perspectives and views in the Test Performance Software Delivery
Platform.

Module 1: Creating projects and recording user actions

Learn how to create projects and record user actions for testing. The second part of this module will help you to build an
understanding of a recorded test.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated

concepts:

« Create a project
» Record a test of user interactions

» View a test in the test editor

Time required
This module requires approximately 8 minutes to complete.

Lesson 1.1: Recording a test

In this lesson, you will learn how to create a project and record user actions. Note that the server under test in this Watch and

Learn tutorial is not publicly available.

About this task

See video

Lesson 1.2: Understanding a recorded test

In this lesson, you will become familiar with your recorded test.
About this task

See video

Module 1 summary

In this tutorial module, you learned how to create projects and record user actions for testing

Lessons learned
By completing this module, you learned about the following concepts and tasks:

« Creating a project is the first step in testing
- Associating elements of the project, such as the tests, with the project
* Recording the actions of your users

- Identifying the components of a recorded test
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Related information

Recording HTTP tests on page 351

Editing HTTP tests on page 460

Module 2: Editing a test

See how to edit your recorded test to include variable data using datasets and verification points.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated

concepts:

- Enable a verification point
« Create a dataset

» Use a dataset in a test

Time required
This module requires approximately 8 minutes to complete.

Lesson 2.1: Enabling a verification point

In this lesson, you will learn how to add verification points to a test. Verification points check whether the expected behavior
actually occurs during a run.

About this task

See video

Lesson 2.2: Creating a dataset

In this lesson, you will learn how to create a dataset, which enables you to vary the values from what you recorded in the test.
About this task

See video

Lesson 2.3: Using a dataset in a test

In this lesson, you will learn how to enable your test to use a dataset.

About this task

See video

Module 2 summary

In this tutorial module, you learned how to use variable data to edit and manage testing situations.
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Lessons learned
By completing this module, you learned about the following concepts and tasks:

« Adding verification points to check whether an expected behavior occurs during a test run
 Enabling datasets to provide substitute variable data for the fixed values stored in the recorded test
« Importing data that is contained in a comma-separated-value (CSV) file

- Updating your test with a reference to the dataset so that the test can use variables from a dataset during a run

Related information

Providing tests with variable data on page 586

Module 3: Validating a test with a single user

Watch a demonstration on running a single-user test for debugging and getting dataset values to work properly.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated
concepts:

* Run a test with a single user

* View the test log

Time required
This module requires approximately 5 minutes to complete.

Lesson 3.1: Running a test with a single user

In this lesson, you will learn how to run a test with a single user, to ensure that your test and the dataset values are working
properly.

About this task
See video

Lesson 3.2: Viewing the test log

In this lesson, you will learn how to open the test log and view a record of all the events that occurred during your test run or
schedule run.

About this task
See video

Module 3 summary

In this tutorial module, you learned how to run a test with a single user and view the test log.
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Lessons learned
By completing this module, you learned about the following concepts and tasks:

« Viewing changes in the reports while the schedule is running
* Running a test locally with one user

« Running a schedule with a default launch configuration

Related information

Viewing test logs on page 995

Module 4: Representing workloads

View how to create schedules that represent a typical workload for your site.

Learning objectives
After completing the lessons in this module, you will understand how to do the following tasks and understand the

associated concepts:

« Create a schedule and add user groups

» Add loops to a schedule

» Add tests to a schedule

- Display your assets by type or in alphabetical order.

 Enable resource monitoring

Time required
This module requires approximately 10 minutes to complete.

Lesson 4.1: Controlling test execution with a schedule

In this lesson, you will learn how to control test execution by creating a schedule and adding user groups, loops, and tests to

the schedule. At the end of the lesson, you will learn how to display your assets in a logical order.
About this task

See video

Lesson 4.2: Enabling resource monitoring

In this lesson, you will learn how to enable resource monitoring in a schedule and to add data sources.
About this task

See video
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Module 4 summary
In this tutorial module, you learned how to represent a workload accurately by creating a schedule and adding user groups,

tests, and other elements to it.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

- Grouping tests in a logical order with user groups

- Adding a loop to a schedule to repeat a test for a number of iterations and set the test run rate
» Adding a test to a schedule to emulate accurately the actions of individual users

- Displaying your assets by type or in the default alphabetical order.

» Monitoring resources to capture system resource data, such as processor or memory usage

Related information

Emulating workloads on page 700

Monitoring resource data on page 747

Module 5: Running the test

Become familiar with configuring a schedule, running a schedule, and adding virtual users during a test run.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated
concepts:

- Configure and run the schedule
« View the report
 Add virtual users during a run

Time required
This module requires approximately 10 minutes to complete.

Lesson 5.1: Configuring the schedule

In this lesson, you will learn how to set up a schedule configuration, which controls where the execution results are stored.
About this task

See video

Lesson 5.2: Running the schedule and viewing the reports

In this lesson, you will learn how to run the schedule.
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About this task

See video

Lesson 5.3: Adding virtual users during a run

In this lesson, you will learn how to increase the number of virtual users during a schedule run.
About this task

See video

Module 5 summary

In this tutorial module, you learned how to configure and run a schedule, and add virtual users to the schedule during a run.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

- Specifying the name and location for your execution results by configuring the schedule
* Running a schedule and viewing the reports

« Increasing the number of virtual users in a schedule during the test run

Related information

Running schedules on page 781
Setting a launch configuration on page 793

Changing the number of virtual users during a run on page 828

Module 6: Evaluating results

Learn how to retrieve stored test results in reports, customize a report, and get detailed information on an event that
occurred in a test.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated
concepts:

« Review reports after the schedule has run
- View the verification report

« Customize and compare reports.

Time required
This module requires approximately 5 minutes to complete.
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Lesson 6.1: Viewing verification point status

In this lesson, you will learn how to view the status of the verification points that you set in the test.
About this task

See video

Lesson 6.2: Customizing and comparing reports
In this lesson, you will learn how to customize reports to investigate a specific performance problem in more detail than that
provided in the default reports. You will also learn how to compare two reports.

About this task

See video

Module 6 summary

In this tutorial module, you learned how to retrieve stored test results in reports, customize a report, and get detailed

information on an event that occurred in a test.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

« Evaluating the results that are generated dynamically during a run
 Regenerating the results for viewing and analysis after a run
« Customizing and comparing reports

Related information

Customizing reports on page 970

Summary

This tutorial has taught you the basics of Test Performance. You have learned how this product provides the following

functions and features:

« Ease of recording
« A graphical test editor for programmers and nonprogrammers alike
« Datasets to supply realistic test data

- Real-time reporting of response time

Lessons learned
After completing all of the modules, you should now be able to perform the following tasks:
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« Create projects and record user actions

« Edit and manage variable data using datasets

« Represent workloads

* Run schedules

 View reports

» Add virtual users

« Retrieve reports from previous runs and customize them

Performance test an SAP application

The movies in this tutorial show you the main features of Test Performance for testing applications on SAP servers. The
tutorial requires Flash Player to view.

Learning objectives
You will learn how to perform the following tasks:

« Record a test for SAP
» Create a multi-user schedule

» Analyze SAP test results

45 minutes

Introduction: Performance test SAP solutions

This tutorial introduces you to performance testing applications running on SAP servers.

Learning objectives
The tutorial is divided into six modules, each with its own learning objectives. You will learn to perform the following tasks:

« Record an SAP test
» Create a multi-user schedule

» Analyze SAP test results

This tutorial requires approximately 45 minutes to finish. If you explore other concepts related to this tutorial, it might take
longer to complete.

Skill level
Beginner

Prerequisites
To complete this tutorial, you need to be familiar with using the perspectives and views in Test Performance Software
Development Platform, with SAP, and with the SAP GUI environment.
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Module 1: Creating projects and recording user actions

In this module, you will learn how to create projects and record user actions for testing. The second part of this module will

help you understand a recorded test.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated

concepts:

« Create a test project
» Record a test of user interactions
» View a test in the test editor

This module requires approximately 8 minutes to complete.

Lesson 1.1: Recording an SAP test

In this lesson, learn how to create a test project and record user actions in the SAP GUI client.
About this task

The most convenient way to create a test in Test Performance is to record an SAP session. The recording contains SAP

events that are transmitted between the SAP GUI client and SAP server.

For each SAP transaction, the recorder logs all the SAP events that occur in the SAP GUI and generates a test that can

reproduce the sequence of events in the SAP GUI.

For SAP recording tips, see SAP performance testing guidelines on page 381.

See video

Lesson 1.2: Understanding a recorded test

In this lesson, become familiar with your recorded test.

About this task

With the test editor, you can edit and view the elements that constitute your SAP performance test.

The left pane of the editor displays the structure of the test as a sequence of SAP transactions, which contain the
recorded SAP Set, Get, and Call events. You can add elements to this sequence, such as transactions, loops, conditions,
synchronization points, or comments. However, if you change the structure of the test, you must ensure that the SAP Set
events are always applicable to the situation on the SAP GUI screen.

The right pane displays details about the current test element.

See video
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Lesson 1.3: Creating an SAP batch input test

In this lesson, learn how record a batch input test for generating a load on the SAP server.
About this task

With SAP batch input tests, you can generate a load on the server without requiring that each virtual tester run the SAP GUI
client. For performance testing, this is particularly useful because the test computer can typically simulate a much larger

number of users with batch input virtual testers than with SAP GUI virtual testers.

However, SAP batch input tests cannot contain verification points and do not produce performance results by themselves.
Therefore, you typically use batch input tests in a schedule mixed with SAP GUI tests to increase the load on the server. The

actual test results are produced by the SAP GUI tests.

See video
Module 1T summary

In this module, you learned how to create projects and record user actions for testing.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

- Creating a project is the first step in performance testing
« Associating elements of the project, such as tests, with the project
» Recording the actions of your users in a test and a batch input test

- Identifying the components of a recorded test

Module 2: Editing an SAP test

In this module, you will see how to edit your recorded test to include variable data using datasets and verification points.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated

concepts:

« Add a verification point
- Create a dataset

» Use a dataset in a test

This module requires approximately 8 minutes to complete.

Lesson 2.1: Adding verification points

In this lesson, learn how to add verification points to check whether an expected behavior occurs during a run.

About this task
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With verification points, you can verify the behavior of the SAP application during a test. For example, you can use verification
points to ensure that a particular transaction returns the expected result in any graphical element of the SAP GUI screen. You
can also use regular expressions and you can search for the occurrence of an expected string in a list.

Each verification point returns a pass, Fai | Or I nconcl usi ve verdict in the test log. You can view a summary of verification point
verdicts in the verification point report after running the test.

See video

Lesson 2.2: Creating and using datasets
In this lesson, learn how to create a dataset that can provide tests with variable data and how to enable your test to use a
dataset during a run.

About this task

Datasets provide tests with variable data during a run. When you record a test, you perform a sequence of steps that you
expect a typical user to perform. From the recording, a test is generated that exactly reproduces these interactions. During
arun, this test uses the same data that you used during recording. To vary the data in the test, you use a dataset, which is
typically a table that contains variable data. At run time, this variable data is substituted for the data in the recorded test.

See video

Module 2 summary

In this module, you learned how to use variable data to edit and manage testing situations.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

« Adding verification points to check whether an expected behavior occurs during a test run
« Enabling datasets to provide substitute variable data for the fixed values stored in the recorded test
« Importing data that is contained in a comma-separated-value (CSV) file

- Updating your test with a reference to the dataset so that the test can use variables from a dataset during a run

Module 3: Running tests

In this module, you will see how to create schedules that represent a typical workload for your SAP server.

Learning objectives
After completing the lessons in this module, you will understand how to do the following tasks and understand the
associated concepts:

« Create a schedule and add user groups
» Add loops to a schedule

» Add tests to a schedule
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This module requires approximately 10 minutes to complete.

Lesson 3.1: Running a single test and viewing the test log

In this lesson, learn how to validate a test by running it with a single user and viewing the results in the test log.
About this task

Before deploying a full emulated workload test with a schedule, ensure that your test runs adequately with a single user.
Developing a performance test often requires several iterations of editing the test and validating changes with a single user

run.

See video

Lesson 3.2: Creating a schedule and adding user groups

In this lesson, learn how to control test execution by creating a schedule and adding user groups.
About this task

A schedule can be as simple as one virtual user running one test, or as complicated as hundreds of virtual users in different

groups, each running different tests at different times.

A schedule is the "engine" that runs a test. You add user groups, tests, and other items to the schedule to emulate a
workload. However, schedules are much more than simple vehicles for running tests. For example, you can use a schedule to

control tests in the following ways:

« Group tests under user groups to emulate the actions of different types of users.
« Set the order in which tests run: sequentially, randomly, or in a weighted order.

- Set the number of times that each test runs.

* Run tests at a certain rate.

« Run tests for a certain time and increase or decrease virtual users during the run.

See video

Lesson 3.3: Running the schedule and viewing the performance report

In this lesson, learn how to run a schedule in a custom run configuration and to view the results in the SAP performance

report.
About this task

After you have validated your individual tests and added them to a schedule, you are ready to deploy the schedule and run the
virtual users on remote computers. By using remote computers, you can multiply the number of virtual users to simulate a

real work load. During the run, you can monitor the behavior of each virtual user.

When the test is finished, you can view the performance report to help locate bottlenecks in your SAP environment.
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See video

Module 3 summary

In this module, you learned how represent a workload accurately by creating a schedule and adding user groups, tests, and

other elements to it.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

 Grouping tests in a logical order with user groups
- Adding a test to a schedule to emulate accurately the actions of individual users
- Adding a loop to a schedule to repeat a test for a number of iterations and set the test run rate

Summary

This tutorial introduced you the basics of the HCL DevOps Test Performance (Test Performance) Extension for SAP

Solutions. You have learned how this product provides the following functions and features:

« Ease of recording

- A graphical test editor for programmers and nonprogrammers alike
- Datasets to supply realistic test data

« Real-time reporting of response time

Lessons learned
After completing all of the modules, you can perform the following tasks:

- Create projects and record user actions

« Edit and manage variable data using datasets
« Represent workloads

 Run schedules

 View reports

» Add virtual users

« Retrieve reports from previous runs

Performance test a Citrix application

The movies in this tutorial show you the main features of using Test Performance for testing applications running in a Citrix

XenApp environment. The tutorial requires Flash Player to view.

Learning objectives
You will learn how to perform the following tasks:
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» Record a test for Citrix
« Create a multi-user schedule
« Analyze Citrix test results

45 minutes

Introduction: Performance test Citrix applications

This tutorial is designed to introduce you to performance testing applications running on Citrix XenApp.

Learning objectives
The tutorial is divided into five modules, each with its own learning objectives. You will learn to perform the following tasks:

» Record a Citrix test
« Create a multi-user schedule
« Analyze Citrix test results

This tutorial requires approximately 45 minutes to finish. If you explore other concepts related to this tutorial, it might take

longer to complete.

Skill level

Beginner

Prerequisites
To complete this tutorial, you need to be familiar with using the perspectives and views in the Test Performance Software
Development Platform and with Citrix XenApp.

Module 1: Creating projects and recording user actions

In this module, you will learn how to create projects and record user actions for testing. The second part of this module will
help you to build an understanding of a recorded test.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated

concepts:

« Create a project
« Record a test of user interactions

» View a test in the test editor

This module requires approximately 8 minutes to complete.

Lesson 1.1: Recording a Citrix performance test

In this lesson, you learn how to create a test project and record user actions in Citrix XenApp.
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About this task

The most convenient way to create a new test in Test Performance is to record a Citrix session. The recording contains

mouse and key strokes as user input actions and window events as responses from the Citrix server.

Because of the way the recorder works, consider these issues during the recording:

- Set up your application so that all actions are repeatable. For example, turn off "tips of the day," ensure that any fiie
al ready exi st swarnings are consistent, and avoid using dynamic menu items such as recent documents.

 Ensure that mouse movements are clearly decomposed. The recorder does not record mouse wheel scrolls.

« Use specific Microsoft® Windows® accounts for performance testing that have limited potential for data loss if there

are errors or synchronization failures during the test run.

For more Citrix recording tips, see Citrix performance testing guidelines on page 398.

The recorder synchronizes user actions and window events automatically so that the generated test waits for a window
event before triggering the next user input. In some cases, however, you must manually add synchronizations. For example,
add synchronizations when screen updates do not result directly from a user action. These synchronizations tell the test to

wait for a specific window, text, or graphic to open on the screen before running the next user input.
See video

Lesson 1.2: Understanding a recorded test

In this lesson, you become familiar with your recorded test.

About this task

With the test editor, you can edit and view the elements that constitute your Citrix performance test.

The left pane of the editor displays the structure of the test as a sequence of input actions and window events. You can
add elements to this sequence, such as transactions, loops, conditions, synchronization points, and comments. However, if
you change the structure of the test, you must ensure that the input actions always apply to the context of the actual Citrix
screen.

The right pane displays details about the current test element.

See video
Module 1T summary

In this module, you learned how to create projects and record user actions for testing.

Lessons learned
By completing this module, you learned about the following concepts and tasks:



Chapter 4. Tutorials

- Creating a project is the first step in performance testing.

- Associating elements of the project, such as tests, with the project.
« Recording the actions of your users in a test.

« Identifying the components of a recorded test.

Module 2: Editing a Citrix performance test

In this module, you will see how to edit your recorded test to include verification points and response time measurements.

Learning objectives
After completing the lessons in this module, you will know how to do the following tasks and understand the associated

concepts:

« Enable a verification point
« Create a response time measurement

This module requires approximately 8 minutes to complete.

Lesson 2.1: Enabling verification points

In this lesson, learn how to add verification points to check whether an expected behavior occurs during a run.
About this task

With verification points, you can test the behavior of the application during a test. For example, you can use verification
points to ensure that a particular window is displayed after a specific action or that a portion of the screen graphically
matches an expected bitmap.

Each verification point returns a pass, Fai I, Or I nconcl usi ve verdict in the test log. You can view a summary of verification
point verdicts in the verification point report after running the test.

In Citrix tests you can also use optical character recognition (OCR) on a screen capture to check for text content.
See video

Lesson 2.2: Creating a response time measurement
In this lesson, learn how to create a response time measurement that can record the time that the application spends
processing an event.

About this task

Response time measurements report how fast the application responds to a specific user input event. Typically, response
time measurements are automatically created between a user input action and the window event that occurs immediately

after.
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In addition, you can manually add your own response time measurements, for example to record a global response time that

covers multiple window events.

See video

Module 2 summary

In this module, you learned how to use verification points and response time measurements to evaluate server response.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

- Adding verification points to check whether an expected behavior occurs during a test run
« Setting up timers inside the test to measure response times

Module 3: Representing workloads

In this module, you will see how to create schedules that represent a typical workload for your Citrix server.

Learning objectives
After completing the lessons in this module, you will understand how to do the following tasks and understand the
associated concepts:

* Run individual validation tests

* Create a schedule and add user groups
« Add loops to a schedule

+ Add tests to a schedule

« Run schedules using a run configuration

- View results in the test log and the Citrix performance report

This module requires approximately 20 minutes to complete.

Lesson 3.1: Running a single test and viewing the test log

In this lesson, learn how to validate a test by running it with a single user and viewing the results in the test log.
About this task

Before you deploy a full emulated workload test with a schedule, ensure that your test runs adequately with a single user.
Developing a performance test often requires several iterations of editing the test and validating changes with a single user

run.

See video
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Lesson 3.2: Creating a schedule and adding user groups

In this lesson, learn how to control test execution by creating a schedule and adding user groups.
About this task

A schedule can be as simple as one virtual user running one test, or as complicated as hundreds of virtual users in different

groups, each running different tests at different times.

A schedule is the "engine" that runs a test. You add user groups, tests, and other items to the schedule to emulate a
workload. However, schedules are much more than simple vehicles for running tests. For example, you can use a schedule to

control tests in the following ways:

- Group tests under user groups to emulate the actions of different types of users.
« Set the order in which tests run: sequentially, randomly, or in a weighted order.

« Set the number of times that each test runs.

* Run tests at a certain rate.

 Run tests for a certain time, and increase or decrease virtual users during the run

See video

Lesson 3.3: Running the schedule and viewing the performance report

In this lesson, learn how to run a schedule in a custom run configuration and to view the results in the performance report.
About this task

After you have validated your individual tests and added them to a schedule, you are ready to deploy the schedule and run the
virtual users on remote computers. By using remote computers, you can multiply the number of virtual users to simulate a
real work load. During the run, you can monitor the behavior of each virtual user.

When the test is finished, you can view the performance report to help locate bottlenecks in your Citrix environment.

See video See video

Module 3 summary

In this module, you learned how represent a workload accurately by creating a schedule and adding user groups, tests, and

other elements to it.

Lessons learned
By completing this module, you learned about the following concepts and tasks:

* Running a test locally with one user

« Viewing changes in the reports while the schedule is running

» Grouping tests in a logical order with user groups

- Adding a test to a schedule to emulate accurately the actions of individual users
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- Adding a loop to a schedule to repeat a test for a number of iterations and set the test run rate

 Running a schedule with a default run configuration

Summary

This tutorial has taught you the basics of the Test Performance Extension for Citrix Presentation Server. You have learned

how this product provides the following functions and features:

- Ease of recording
« A graphical test editor for programmers and nonprogrammers

- Real-time reporting of response time

Lessons learned
After completing all of the modules, you can now perform the following tasks:

« Create projects and record user actions
« Represent workloads

* Run schedules

* View reports

» Add virtual users

« Retrieve reports from previous runs
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This section describes about the sample project which can be used with HCL DevOps Test Performance (Test Performance)

to test the functionality of an application.

You can find the following information:

« Installing the assets for tuning tests on page 132

« Testing with the Snoop test on page 132

« Testing the PlantsByWebSphere application on page 133
« Testing the Daytrader application on page 133

Installation tuning tests for WebSphere® Application Server

The installation tuning tests were created to quickly and conveniently apply load to an application server for the purpose

of tuning the application server for maximum throughput. The three tests that are provided stress various parts of the

application server.
Time required to import sample project: 5 minutes

The installation tuning tests are designed to test IBM® WebSphere® Application Server Version 7. Each test has different

requirements that must be met before you run the test.

» The Schedule_Snoop test is ready to use with any WebSphere® Application Server installation.

 The "Schedule_Plants: PlantsByWebSphere" sample application must be installed. The sample application is provided
with WebSphere® Application Server, but its installation is optional.

 The Schedule_Daytrader test application is freely available from the Apache project Geronimo. Daytrader requires

access to an IBM DB2 database.

Best results can be achieved for all tests by using one or more separate, dedicated computers to provide the greatest
possible loads on the application server. When testing a large WebSphere® Application Server application, a single computer
that runs Test Performance and provides a load on the application might not provide sufficient stress to test the application.

An installation tuning test is designed to stress your application server to achieve maximum throughput from basic tuning.
Tuning is a complex procedure with many possible adjustments available according to the varying requirements of the
application that you plan to run. For more information on tuning WebSphere® Application Server, see http://www.ibm.com/

developerworks/websphere/techjournal/0909_blythe/0909_blythe.html.

A simple goal when you run the installation tuning tests is to achieve the highest percentage of CPU utilization on the

application server while the test runs. Follow these guidelines as you run each test:
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» Use Task Manager, vmstat, or a similar tool to observe CPU utilization on the computer that runs the application
server. With maximum throughput as a goal, you work to achieve the highest CPU percentage possible. To achieve
maximum throughput, this number must increase as you make tuning adjustments.

» Monitor the CPU utilization of the computer that runs Test Performance. If CPU utilization exceeds 70%, you might
be approaching the limits of what that computer can provide. However, Test Performance supports using multiple
computers to achieve an even greater load.

« Because these tests provide high throughput, the tests might exceed the capabilities of your network. A tool such
as Task Manager can show network utilization. If you are limited by a 100 Mbps network, access to a 1000 Mbps

network might be required to fully stress the application server.

Related information

Samples on page 131

Installing the assets for tuning tests on page 132
Testing with the Snoop test on page 132

Testing the Daytrader application on page 133

Testing the PlantsByWebSphere application on page 133

Installing the assets for tuning tests

HCL DevOps Test Performance (Test Performance) provides Installation Tuning Tests for WebSphere Application Server as a

sample project that you can import into your workspace.

1. Right-click on Installation Tuning Tests for WebSphere Application Server and save the sample project.

Note: After saving, import the sample project in Eclipse. To import the sample, click File > Import > Existing
projects into workspace > Select archive file and select the downloaded sample project file.

2. Click Finish. If you are asked to switch to the Performance Test Perspective, click Yes.

What to do next
Expand the sample in the Test Navigator view to open the project and explore the resources and reports.

Testing with the Snoop test
The Snoop test stresses the servlet engine of IBM® WebSphere® Application Server.

Snoop is an application that is provided with all WebSphere® Application Server installations. This exercises only a small,

direct portion of the application server. The Plants test is more complex than the Snoop test.

1. Select Snoop in the Test Project to open it in the editor.
2. Open Test Variables.

3. In hostname enter the name of the WebSphere® Application Server to stress test.
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4. Select Schedule_Snoop in the Test Project to open the test in the editor.

5. Click Run to start the test. The test runs for approximately 5 minutes.

Testing the PlantsByWebSphere application
The Plants test provides load using the PlantsByWebSphere application.

This application is provided with IBM® WebSphere® Application Server, but it must by installed. Use the WebSphere

Administrative console to ensure that the PlantsByWebSphere application is installed and running.

The Plants test is more complex than the Snoop test, because the test exercises more parts of the application server.

1. Select Plants in the Test Project to open the test in the editor.

2. Open Test Variables.

3. In hostname enter the name of the WebSphere® Application Server to stress test.
4. Select Schedule_Plants in the Test Project to open it in the editor.

5. Click Run to start the test. The test runs for approximately 5 minutes.

Testing the Daytrader application

The Daytrader test provides a load using the Daytrader application.

This application is available at http://geronimo.apache.org/GMOxDOC30/daytrader-a-more-complex-application.html.

1. Click Daytrader in the Test Project to open the application in the editor.

2. Open the Test Variables.

3. Change the hostname variable to the name of the IBM® WebSphere® Application Server to stress test.
4. Select Schedule_Daytrader in the Test Project to open the schedule in the editor.

5. Click Run to start the test. The test runs for approximately 5 minutes.

On the Daytrader application configuration page, you can change the configuration from Enterprise JavaBeans (EJB) to Java
Database Connectivity (JDBC). Run the Daytrader test in both modes to obtain the widest possible coverage.
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This guide describes how to install HCL DevOps Test Performance (Test Performance). After you install the product, you can
perform administration tasks such as license configuration and integration with other products. This guide is intended for

administrators.

Installation of DevOps Test Performance

Installation of the product involves verifying requirements, planning, managing licenses, and configuring web-based help.

This section lists all such topics.

This installation guide covers two independent products: HCL DevOps Test Performance (Test Performance) and the HCL
DevOps Test Performance Agent (Test Performance Agent). The Test Performance Agent is a tool that you use with Test

Performance. It is included as part of the Test Performance product kit.

Test Performance Agent consists of two capabilities:

- Generate load for the application under test by using the virtual users. You can increase the load generation capacity

by installing additional agents on remote computers.

Note: The Test Performance and Test Performance Agent are separate offerings and must be installed separately.

Installation requirements

Installation requires the correct hardware, software, server environment, operating systems, and user privileges for installing

and running your software.
Hardware and Software requirements
Before you install the product, verify that your system meets the hardware and software requirements.

For information about hardware and software compatibility, see System Requirements for DevOps Test Performance
2025.12 (11.0.7) on page 72.

User privileges requirements

You must have a user ID that meets the following requirements to install Test Performance and Test Performance Agent.

Notes:
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* Your user ID must not contain double-byte characters.
 For Windows operating system, you must have a user ID that belongs to the Administrators group.

« For Linux operating system, you must be able to log in as root.

Installation conventions and terminology

Understanding these terms and conventions can help you take full advantage of the installation information and your

product.

The following conventions are used in this installation information:

 The default installation directory is written as C:\installation_directory\product\inst.file.
- The default log location for installation information is C:\log_file_dir\log.txt.

These terms are used in the installation topics.
Installation directory

The location of product artifacts after the package is installed.

Package

An installable unit of a software product. Software product packages are separately installable units that can

operate independently from other packages of that software product.

Package group

A package group is a directory in which different product packages share resources with other packages in the
same group. When you install a package using Installation Manager, you can create a new package group or
install the packages into an existing package group. Eclipse-based packages installed in the same package
group are able to use the shell-sharing features of Eclipse. Some packages cannot share a package group, in

which case the option to use an existing package group is unavailable.

Repository
A storage area for installable software packages. A repository can be disc media, a folder on a local hard disk,
or a server or web location.

Shared directory

In some instances, product packages can share resources. These resources are located in a directory that the

packages share.

Installation Manager overview

Installation Manager is a program for installing, updating, and modifying packages. It helps you to manage the applications
or packages that it installs on your computer. Installation Manager also helps you to keep track of what you have installed,

determine what is available for you to install, and to organize installation directories.
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Installation Manager provides features that help you keep packages up to date, modify packages, manage the licenses for
your packages, and uninstall packages.

You can download the most recent version of Installation Manager from Installation Manager downloads. Installation
Manager is required to install each HCL product. You will need to create an account on jazz.net before you can download the

software.

Installation Manager includes six wizards that make it easy to maintain packages:

« The Install wizard walks you through the installation process. You can install a package by simply accepting the
defaults or you can modify the default settings to create a custom installation. Before you install, you get a complete
summary of your selections throughout the wizard. Using the wizard you can install one or more packages at one
time.

.

The Update wizard searches for available updates to packages that you have installed. An update might be a
released fix, a new feature, or a new version of the product. Details of the contents of the update are provided in the
wizard. You can choose whether to apply an update. The Update wizard searches connected repositories for updates.
If you are not connected to the Internet, you may not see newly available updates for your installed products. To apply
an update to a computer that is not connected to the Internet, you must download the update and extract it to a local

repository.

The Modify wizard helps you modify certain elements of a package that you have already installed. During the first
installation of the package, you select the features that you want to install. Later, if you require other features, you
can use the modify packages wizard to add them to your package. You can also remove features and add or remove

languages.

The Manage Licenses wizard helps you set up the licenses for your packages. Use this wizard to change your trial
license to a full license, to set up your servers for floating licenses, and to select which type of license to use for each
package. Test Performance requires runtime floating license keys to run tests with multiple virtual users and to use
product extensions such as protocols. Runtime floating license keys are not managed using Installation Manager.
Use the License Key Administrator program, installed with the License Server, to manage runtime floating license
keys.

« The Roll Back wizard helps you to revert to a previous version of a package.

« The Uninstall wizard removes a package from your computer. You can uninstall more than one package at a time.

For more information about Installation Manager, visit the Installation Manager help.

Installation locations

Installation Manager retrieves product packages from specified repositories and installs the products into selected locations,
which are referred to as package groups.

Package groups

During installation, you specify a package group into which to install a product.
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« A package group represents a directory in which products share resources.

» When you install a product by using Installation Manager, you either create a package group or install the product
into an existing package group. A new package group is assigned a name automatically; however, you choose the
installation directory for the package group.

- After you create a package group you cannot change the installation directory. The installation directory contains files
and resources that are shared by the products that are installed into that package group.

 Product resources that are designed to be shared with other packages are installed in the shared resources directory.
Not all products can share a package group, in which case the option to use an existing package group is disabled.

» When you install multiple products at the same time, all products are installed into the same package group.

Shared resources directory

The shared resources directory is where product resources are installed so that they can be used by multiple product
package groups. You define the shared resources directory the first time that you install the first product package. For best
results, use your largest disk drive for shared resources directories. You cannot change the directory location unless you

uninstall all product packages.

Offering coexistence considerations

Some products are designed to coexist and share functions when they are installed in the same package group. A package

group is a location where you can install one or more software product packages.

When you install each product package, you select whether to install the product package into an existing package group or
to create a package group. Installation Manager prevents you from installing products into package groups products that
are not designed to share or do not meet version compatibility and other requirements. To install more than one product at a

time, the products must be able to share a package group.

Any number of eligible products can be installed to a package group. When a product is installed, the product functions are
shared with all the other products in the package group. If you install a development product and a testing product into one
package group, when you start either of the products, you have both the development and testing functions available to you
in your user interface. If you add a product with modeling tools, all the products in the package group have the development,

testing, and modeling functions available.

Eclipse instance overview

The product package that you install using Installation Manager comes with a version of Eclipse, which is the base platform
of this product package. If you already have Eclipse installed on your workstation, you can add your product package directly

to that Eclipse installation and extend the functions of the Eclipse integrated development environment (IDE).

Extending an Eclipse IDE adds the functions of the newly installed product, but maintains your IDE preferences and settings.

Previously installed plug-ins are also still available.

In most cases, your current Eclipse IDE must be the same version as the Eclipse that the product you are installing uses.
Installation Manager checks that the Eclipse instance that you specify meets the requirements for the installation package
and helps you install the latest updates from eclipse.org, if required.
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Increasing the number of file handles on Linux™ workstations

For best product performance, increase the number of file handles above the default setting of 1024 handles.

About this task

138

Important: Before you work with your product, increase the number of file handles. Most products use more than the
default limit of 1024 file handles per process. A system administrator might need to make this change.

Exercise caution when using the following steps to increase your file descriptors on Linux™. If the instructions are not
followed correctly, the computer might not start correctly.

To increase your file descriptors:

—_

. Log in as root. If you do not have root access, you must obtain it before continuing.

N

. Change to the et c directory.

! Attention: If you decide to increase the number of file handles in the next step, do not leave an empty
i ni tscript file on your computer. If you do so, your computer will not start up the next time that you turn it

on or restart.

3. Use the vi editor to edit the i ni t scri pt file in the et ¢ directory. If this file does not exist, type vi initscript to
create it.

4. On the first line, type ulinit -n 30000. The point is that 30000 is significantly larger than 1024, the default value on
most Linux™ computers.

! Important: Do not set the number of handles too high, because doing so can negatively impact system-wide

performance.

5. On the second line, type eval exec "$4".

6. Save and close the file after making sure that you have completed steps 4 and 5.

Note: Ensure that you follow the steps correctly. If this procedure is not completed correctly, your computer
will not start.

7. Optional: Restrict the number of handles available to users or groups by modifying thel i m t s. conf filein the
et ¢/ securi ty directory. Both SUSE Linux™ Enterprise Server (SLES) Version 9 and Red Hat Enterprise Linux™
Version 4.0 have this file by default. If you do not have this file, consider using a smaller number in step 4 in the
previous procedure (for example, 2048). Do this so that most users have a reasonably low limit on the number of
open files that are allowed per process. If you use a relatively low number in step 4, it is less important to do this.
However, if you set a high number in step 4 earlier and you do not establish limits in the | i mi t s. conf file, computer

performance can be significantly reduced.
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The following sample | i mi t s. conf file restricts all users, and then sets different limits for others afterwards. This
sample assumes that you set handles to 8192 in step 4 earlier.

i soft nofile 1024
i hard nofile 2048
root soft nofile 4096
root hard nofile 8192

userl soft nofile 2048

userl hard nofile 2048

Note that the * in the preceding example sets the limits for all users first. These limits are lower than the limits that
follow. The root user has a higher number of allowable handles open, while the number that is available to user1 is
between the two. Make sure that you read and understand the documentation that the | i mi t s. conf file contains
before making changes.

What to do next

For more information on the ulimit command, see the main page for ulimit in the Linux™ documentation.

Installation of the product by using IBM® Installation Manager

You must download the product bits and then from the Installation Manager point to the Setup disk.

Note: For Linux™ computers, you must log in as the root user before you begin the installation process.

Installing DevOps Test Performance

You must install HCL DevOps Test Performance (Test Performance) to test the performance of an application.
Before you begin

You must have completed the following tasks:

- Installed IBM® Installation Manager. For more information. refer to the IBM Installation Manager Documentation.

« If you were using the IBM testing product and want to reuse the test assets in the HCL testing product, follow these
instructions:
> From the IBM testing product, export all the test assets with dependencies. Follow instructions till step 5 in
Copying test assets with dependencies on page 578.
> Uninstall the IBM testing product.
> Install the HCL testing product by following the instructions.
> Import the test assets with dependencies to the HCL workspace. Follow instructions from step 6 in Copying

test assets with dependencies on page 578.

About this task
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Notes:

- You cannot upgrade to the latest version of the product. You must uninstall the existing version of the
product before installing the latest version of the product.

. Perform the following steps to install the product from Installation Manager:

a. Open Installation Manager.
b. Click File > Preferences > Repositories to add a repository link to the product's setup disk, and then click OK.
c. Click Install.

. Click a product package to highlight it.

Result

The description of the package is displayed in the Details pane at the end of the window.

. Optional: Click Check for Other Versions, Fixes, and Extensions to search for any updates to the product packages.

If updates for a product package are found, they are displayed in the Installation Packages list under their

corresponding product. Installation Manager displays only the recommended updates by default.

. Optional: Select the Show all versions checkbox to view all the updates that are available for the packages.

You can click the package name to view the package description under the Details pane. If additional information
about the package is available, such as a r eadn® file or release notes, a More info link is included at the end of the

description text. You can click the link to view additional information in a browser.

. Select the product package and its updates to install it on your computer, and then click Next.

Note: Updates with dependencies are automatically selected and cleared together. If you install multiple
packages simultaneously, all the packages are installed into the same package group.

. Read and understand the terms of all of the license agreements for the selected package, and then perform the

following steps:
a. If you agree to the terms of all of the license agreements, click | accept the terms of the license agreements.
b. Click Next to continue.

. Select a location for the shared resources directory, and then click Next.

The shared resources directory contains resources that can be shared with one or more package groups. You can
either browse the location in the Shared Resources Directory field or enter the path of the location for the shared

resources directory.

The default path of the Shared Resources Directory is as follows:
> For MM C: \ Pr ogram Fi | es\ HCL\ HCLI Mshar ed
o For 1/ opt / HCL/ HCLI Mshar ed

o For MZEATEMM: / Appl i cat i ons/ HCL/ HCLI MShar ed
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n Remember: You can specify the shared resources directory only for the first time when you install a package.
You must use your largest disk for this directory. The largest disk ensures that you have adequate space for

the shared resources of future packages. You cannot change the location of the directory unless you uninstall

all packages.

8. Select one of the following options to use an existing or new package group:
Choose from:
> Use the existing package group: You can use this option if you already created the package group.

> Create a new package group: You can use this option either to install or update the product.

A package group represents a directory in which packages share resources with other packages in the same group.

Note: The Use the existing package group option is disabled when you install a package for the first time.

9. Perform the following steps to create a new package group:
a. Select Create a new package group.

b. Enter the path in the Installation Directory field for the package group.
The name for the package group is created automatically.

The default paths are as follows:
- For I ¢\ Pr ogram Fi | es\ HCL\ DevOpsTest
= For :/ opt / HCL/ DevOpsTest
= For :/Appl i cati ons/ HCL/ DevQpsTest

c. Select 64-bit as Architecture Selection.
d. Click Next.

10. Click Next.
Test Performance does not support extending an existing Eclipse IDE.

11. Select the languages for the package group, and then click Next.

The corresponding translations for the user interface and documentation for the product package are installed.

12. Select all the features that you want to install, and then click Next.
You can perform the following actions to install or view information about the features:
o Select or clear checkboxes to enable or disable the features.
> Select the Show dependencies checkbox to view the dependency relationships between features.

o Click a feature to view its brief description under the Details section.
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! Important: When you integrate Test Performance along with Rational® Application Developer or Rational®

Software Architect in a shell-shared mode, you must clear Java 8 OpenJDK with Eclipse OpenJ9 checkbox
during the installation. If you not clear this checkbox, multiple instances of OpenJDK are installed as
Rational® Application Developer and Rational® Software Architect already have an existing OpenJDK.

If you install Rational® Application Developer or Rational® Software Architect in a separate package, you
can select the Java 8 OpenJDK with Eclipse OpenJ9 checkbox.

13. Review your choices, and then click Install.
You can click Back to change the choices that you made on previous pages and make your changes.
Result
A progress indicator shows the percentage of the installation that is complete.

14. Optional: Click View Log File to open the installation log file for the current session in a new window.

Note: You must close the Installation Log window to continue.

15. Click Finish to exit the installation wizard.

Results

You have installed Test Performance.

What to do next
You can configure licenses for Test Performance. See License configuration on page 165.

Installing DevOps Test Performance Agent

You must install HCL DevOps Test Performance Agent (Test Performance Agent) on different computers to apply load on the

server that hosts the application under test.
Before you begin

You must have installed IBM® Installation Manager. For more information. refer to the IBM Installation Manager

Documentation.

About this task

Notes:

142


https://www.ibm.com/docs/en/installation-manager/current?topic=manager-installing-using-installation

Chapter 6. Administrator Guide

- You cannot upgrade to the latest version of the product. You must uninstall the existing version of the

product before installing the latest version of the product.

1. Perform the following steps to install Test Performance Agent from Installation Manager:
a. Open Installation Manager.
b. Click File > Preferences > Repositories to add a repository link to the product's setup disk, and then click OK.
c. Click Install.
2. Click a product package to highlight it.
Result
The description of the package is displayed in the Details pane at the end of the window.

3. Optional: Click Check for Other Versions, Fixes, and Extensions to search for any updates to the product packages.
If updates for a product package are found, they are displayed in the Installation Packages list under their
corresponding product. Installation Manager displays only the recommended updates by default.

4. Optional: Select the Show all versions checkbox to view all the updates that are available for the packages.

You can click the package name to view the package description under the Details pane. If additional information
about the package is available, such as a r eadn® file or release notes, a More info link is included at the end of the
description text. You can click the link to view additional information in a browser.

5. Select the product package and its updates to install it on your computer, and then click Next.

Note: Updates with dependencies are automatically selected and cleared together. If you install multiple

packages simultaneously, all the packages are installed into the same package group.

6. Read and understand the terms of all of the license agreements for the selected package, and then perform the
following steps:
a. Click I accept the terms in the license agreement.
b. Click Next to continue.
7. Select a location for the shared resources directory, and then click Next.

The shared resources directory contains resources that can be shared with one or more package groups. You can
either browse the location in the Shared Resources Directory field or enter the path of the location for the shared

resources directory.

The default path of the Shared Resources Directory are as follows:
Y Windows el Program Fi | es\ HCL\ DevOpsTest
o For 1/ opt/ HCL/ DevOpsTest

o For MEXTEMM: / Appl i cat i ons/ HCL/ DevOps Test

n Remember: You can specify the shared resources directory only for the first time when you install a package.

You must use your largest disk for this directory. The largest disk ensures that you have adequate space for
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the shared resources of future packages. You cannot change the location of the directory unless you uninstall

all packages.

8. Select one of the following options to use an existing or new package group:
Choose from:
- Use the existing package group: You can use this package group if you already created the package group.
- Create a new package group: You can use this package group either to install or update the product.

A package group represents a directory in which packages share resources with other packages in the same group.
Note: The Use the existing package group option is disabled when you install a package for the first time.

9. Perform the following steps to create a new package group:
a. Select Create a new package group.

b. Enter the path in the Installation Directory field for the package group.

The name for the package group is created automatically.

The default paths are as follows:
- For MM C: \ pr ogram Fi | es\ HCL\ DevOpsTest
= For 1/ opt/ HCL/ DevOpsTest
« For IIEATYM: / Appl i cat i ons/ HCL/ DevOpsTest

c. Select 64-bit as Architecture Selection.
d. Click Next.
10. Select all the features that you want to install, and then click Next.
You can perform the following actions to install or view information about the features:
o Select or clear checkboxes to enable or disable the features.
> Select Show dependencies to view the dependency relationships between features.
o Click a feature to view its brief description under the Details section.

You can select the Windows desktop Application testing (Next Generation) and Ul Test Agent checkboxes to install
the Ul Test Agent which provides the necessary prerequisites to test native and hybrid mobile applications, and
Windows desktop applications.

The Ul Test Agent is installed along with Test Performance Agent on your computer.
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Note: After the agent installation, the Ul Test Agent starts to run automatically on your computer whenever
you restart your computer. On Linux and macOS, you must set the environment variable to start the Ul Test

Agent automatically.

Notes:

o Installation Manager automatically enforces any dependencies with other features and displays

updated download sizes and disk space requirements for the installation.

11. Perform the following steps to configure the agent:

a. Select DevOps Test Ul Panel if you shell-share Test Performance with Test Ul and run a Ul test on the remote
agent computers.

Notes:

= On Windows system, clear the The agent will be used primarily to support remote execution
of Ul tests from DevOps Test Ul checkbox if you are not running a Ul test, so that Maj or dono

runs as a service.

= On Linux and Mac operating systems, the The agent will be used primarily to support remote
execution of Ul tests from DevOps Test Ul option is not available. The agent runs as a service

and can run a Ul test. This is the default behavior.

= When Maj or dono runs as a service, it starts the service automatically after the computer is
restarted. However, if you want to run the Ul test on remote agent computers, then you must
select The agent will be used primarily to support remote execution of Ul tests from DevOps
Test Ul checkbox so that after the installation of the agent is complete, Maj or dono runs as a
batch file instead of a service.

= When Maj or dono runs as a batch file, it stops after the computer is restarted. You
must restart Maj or dono by double-clicking the Agent | nst al | Di r/ Maj or dono/
Mpj or dono. bat file.

b. Select DevOps Test Ul Load Generation Agent Configuration and perform the following steps:

i. Specify the values for the following parameters for Test Performance:

Field name Description Example
Workbench hostname The hostname of Test Performance. localhost
Workbench port The port number of Test Performance. 7080
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ii. Specify the values of the following parameters for Test Hub:

Field name

Description

Example

Server Host-

name

The hostname of Test Hub.

Notes:

= The hostname of Test Hub must be resolvable

through a Domain Name Server (DNS).

= An IP address cannot be the hostname of Test
Hub.

= The hostname of Test Hub through host files

must not be specified.

For example, / et c/ host s or C. / W n-

dows/ systenB2/ dri ves/ et c/ host

localhost

Server Port

The port number of Test Hub.

443

Server Token

An offline user token that is created from Test Hub.

eyJhbGciOiJlUzI1TNi-
IsInR

Server URL The name of the Server URL Alias that you provided during testteam
Alias the creation of the team space in Test Hub.
Server Path /test

The path context value that corresponds to the value config-
Context

ured on Test Hub.

Note: If the Server Path Context is not configured, the
default value of / t est is applied.
c. Click Next.

12. Review your choices, and then click Install.

You can click Back to change the choices that you made on previous pages and make your changes.

Result

A progress indicator shows the percentage of the installation that is complete.

13. Optional: Click View Log File to open the installation log file for the current session in a new window.
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Note: You must close the Installation Log window to continue.

14. Click Finish to exit the installation wizard.

Results

You have installed Test Performance Agent.

What to do next

You can check the status of agents from Test Performance. See Checking the status of agents on page 731.

Uninstalling the product by using IBM® Installation Manager

When you no longer require Test Performance, you can use IBM® Installation Manager to uninstall Test Performance that

you have installed.
Before you begin

You must have completed the following tasks:

« Installed Installation Manager.
« Closed any open windows of Test Performance.
« Closed any open web browsers.

- Closed all the other applications that are enabled by Test Performance.

1. Open Installation Manager.
2. Click Uninstall.
3. Select the Test Performance package checkbox on the Uninstall Packages window, and then click Next.
4. Review the list of packages that are ready to uninstall, and then click Uninstall.
Result
The Complete page is displayed after the uninstallation process is complete.

5. Click Finish to exit the Installation Manager wizard.

Results
You have uninstalled Test Performance from your computer.

Installation of the product by using the stand-alone installer

This guide intended for an administrator and describes how to install the product by using stand-alone installer on different
operating systems.

You can install the product by using any of the following methods:
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» GUI mode
+ Console mode
« Silent mode
Installation of the product on Windows systems
You can find information about installing the product software on Windows system by using the stand-alone installer.

You can install the product by using any of the following methods:
* GUI mode
+ Silent mode

Installing the product in the GUI mode on Windows systems

To get started with the desktop client on Windows system, you can install the product in the GUI mode by using the stand-

alone installer.

Before you begin

« You must be an administrator.

Note: If you are a non-admin user, you must have the credentials of an administrator to start the installation

by using the Run as Administrator option.

* You must have completed the following tasks:

> Uninstalled the previous version of the product. See Uninstalling the product in the GUI mode on Windows

systems on page 162.

o Verified the software and hardware requirements. See System Requirements for DevOps Test Performance
2025.12 (11.0.7) on page 72.

o Cleared files from the Tenp directory.

About this task

You can use the stand-alone installer and the product in your preferred language. The display language of your computer is
selected as the preferred language of the stand-alone installer. For example, if the display language of your computer is set

as French, then the preferred language of the stand-alone installer is also selected as French.

You can change the preferred language of the stand-alone installer and the product by selecting the language from the drop-
down list during the installation of the product. The drop-down list displays the languages based on the default language that

is seton your computer.
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The following languages are displayed in the drop-down list based on the display language of your computer:

List of preferred languages that are displayed in the drop-down list based on the display language of your computer

« English « Simplified - Traditional » Jap *Cz * Kor *Tu * Ru

* French Chinese Chinese an ech ean rk ss

» German « English « English ese * Engl * En ish ian

« Italian « Engl ish gl « En * En

* Spanish ish * Hun ish gl gl

* Portugu gar ish ish
ese Brazil ian
* Pol
ish

For example, if the display language of your computer is Japanese, then the drop-down list shows Japanese and English as
the preferred languages.

1. Download the product installer from the My HCLSoftware (MHS) .

You must download the appropriate product variant, version, and architecture based on your requirements.

Note: When you want to install both Test Ul and Test Performance on your computer, you can install the
products by using a single shell-shared HCL DevOps Test U and Test Perfor mance package thatis
available in the My HCLSoftware (MHS) .

Note: When you want to install Test Performance on Windows Server 2025, before running the
installer, you must right-click the installer to open the Properties dialog, and then select the Run this

program in compatibility mode for checkbox in the Compatibility tab.

2. Right-click the product installer file and select Run as Administrator.

The GUI window is displayed.

3. Select the language from the drop-down list to view the installation instructions and the product in your preferred
language.
The drop-down list displays the languages based on the display language that is set on your computer.

4. Read through the details on the Introduction window, and then click Next.
5. Read the license agreement carefully, select the I accept checkbox, and then click Next.
6. Browse for the location or directory where you want to install the product, and then click Next.
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Note: You must select any other directory if the default directory is not empty. The default locations for 64-bit
installers is as follows:
o For 64-bit: C: \ Progr am Fi | es\ HCL

7. Read through the installation details and, then click Install.

8. Click Done after the installation of the product is complete.

Results

You have installed the product on your computer.

What to do next

You must enter the license key when you open the product. See License management on page 164.

Creating a properties file on Windows systems

To install the product in the silent mode, you must first create a properties file that contains the data required to install the

product. Alternatively, you can generate the properties file by using the stand-alone installer.
About this task

You can create the properties file by using one of the following methods:

« Generating the properties file by using the stand-alone installer. See steps 1 on page 150 through 4 on page 157.

« Copying the contents of the sample properties file to your local properties file. See step 5 on page 151.

1. Download the product installer from the My HCLSoftware (MHS) .

You must download the appropriate product variant, version, and architecture based on your requirements.

Note: When you want to install both Test Ul and Test Performance on your computer, you can install the
products by using a single shell-shared HCL DevQps Test U and Test Perf or mance package thatis
available in the My HCLSoftware (MHS) .

Note: When you want to install Test Performance on Windows Server 2025, before running the
installer, you must right-click the installer to open the Properties dialog, and then select the Run this

program in compatibility mode for checkbox in the Compatibility tab.

2. Right-click the Command Prompt application and select Run as Administrator.

3. Run the following command to change the directory to a location where you downloaded the installer file:
cd <directory path>

For example, cd C:\users\Downloads
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4. Run the following command to generate the properties file:

<installer_file.exe> -r <location of the installer.properties file>

For example, DevOps-Test-Performance-Windows-x64-v11.0.0.0 -r C:\users\Downloads\installer.properties

5. Create your properties file by copying the content of the following sample properties file:

#Host Name
# Replay feature output

# This file was built by the Replay feature of Installer.
# It contains variables that were set by Panels, Consoles or Custom Code.

#Destination Folder

USER_INSTALL_DIR=C:\\Program Files\\HCL

Results

You have generated or created the properties file.

What to do next

You can install the product by using the silent mode method.

Installing the product in the silent mode on Windows systems

To get started with the desktop client, you can install the product on Windows system by using the silent mode installation

method.

Before you begin

» You must be an administrator.

Note: If you are a non-admin user, you must have the credentials of an administrator to start the installation

by using the Run as Administrator option.

* You must have completed the following tasks:

> Uninstalled the previous version of the product. See Uninstalling the product in the silent mode on Windows

systems on page 162.

> Deleted thei nstal | er. properti es file generated from the previous installation if you are installing a
newer version of the product.

o Created a properties file that contains the inputs for the installer during the installation process. See Creating

a properties file on Windows systems on page 150.
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- Verified the software and hardware requirements. See System Requirements for DevOps Test Performance
2025.12 (11.0.7) on page 72.

> Cleared files from the Tenp directory.

About this task

You can use the stand-alone installer and the product in your preferred language. The display language of your computer is
selected as the preferred language of the stand-alone installer. For example, if the display language of your computer is set
as French, then the preferred language of the stand-alone installer is also selected as French.

You can change the language of the stand-alone installer and the product by providing the -l language_code parameter during
the installation of the product.

1. Download the product installer from the My HCLSoftware (MHS) .

You must download the appropriate product variant, version, and architecture based on your requirements.

Note: When you want to install both Test Ul and Test Performance on your computer, you can install the
products by using a single shell-shared HCL DevQps Test U and Test Perf or mance package thatis
available in the My HCLSoftware (MHS) .

Note: When you want to install Test Performance on Windows Server 2025, before running the
installer, you must right-click the installer to open the Properties dialog, and then select the Run this

program in compatibility mode for checkbox in the Compatibility tab.

2. Right-click the Command Prompt application and select Run as Administrator.

3. Run the following command to change the directory to a location where you downloaded the installer file:
cd <directory path>

For example, cd C:\users\Downloads
4. Extract the downloaded installer file.

5. Run the following command to install the product:

<installer_name> -i silent -1 <language_code> -f <location_of the_installer.properties_file_name>
For example, you can run the following command to install Test Performance 11.0.5 in French:
DevOps-Test-Performance-Windows-x64-v11.0.0.0.exe -i silent -l fr -f C:\users\Downloads\installer.properties

The following table lists the language codes that you might want to choose during the installation:

Lan- |[Chi- |Chi- |Czech|Eng- |French Ger- [Hun- [Ital- [JapaniKore- |Pol- |Por- |Russ-|Span-|Turk-
guagesnese |nese lish man |gari- |ian ese [an ish tuguegeéan ish ish

(Sim- | (Tra- an (Brazil
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pli- di-
fied) |tion-
al)
Lan- |zh_- |zh_- |cz en fr de hu it ja ko pl pt- |[ru es tr
guage| CN T™W BR
codes

Notes:

> The -l parameter is optional. If you do not want to use this parameter, then the following information

are displayed in a language based on the display language that is set on your computer:
= The installation instructions
= The language of the product

o If the installation is terminated due to any reason, you must check the | nst al | error. t xt file to
know more about the problem that occurred during the installation process. The error log is located at

\<instal |l ati on directory>\Logs.

Result
You can verify the status of the installation of the product by checking the log file at\ <i nst al | ati on
di rectory>\Logs.

Results

You have installed the product on your computer.

What to do next

You must enter the license key when you open the product. See License management on page 164.

Changing the language of the product on Windows systems

When you want to use the product in a different language other than the display language of your computer, then you can

change the language of the product by using the command-line interface.

About this task

! Important: After you changed the language and closed the application for any reason, the product displays in the
language that is set in your computer if you re-open the product.

For example, consider the display language of your computer is set as French and you change the language of the product
to Japanese by using the command-line interface. When you close the product and open it again, the product displays in the

French language.
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1. Right-click the Command Prompt application and select Run as Administrator.

2. Run the following command to change the directory to a location where you installed the product:

cd <directory path>

For example, cd C:\Program Files\HCL\DevOpsTest

3. Run the following command to change the language of the product:

eclipse.exe -nl <language_code>

Where <language_code> is the code of your preferred language.

The following table lists the language codes that you might want to choose during the installation:

Lan- |Chi- |Chi- |Czech|Eng- |FrenchGer- [Hun- [Ital- [JapaniKore- |Pol- |Por- |Russ-|Span-|Turk-
guagesnese |nese lish man |gari- |ian ese [an ish tuguegéan ish ish

(Sim- | (Tra- an (Brazil

pli- di-

fied) |tion-

al)

Lan- |zh_- |zh_- |cz en fr de hu it ja ko pl pt.- |ru es tr
guage| CN T™W BR
codes

For example, eclipse.exe -nl ja

Result

The product opens in the Japanese language.

Results

You have changed the language of the product until you restart the product.

Installation of DevOps Test Performance Agent by using the stand-alone installer

To get started with HCL DevOps Test Performance Agent (Test Performance Agent), you must install the product on

Windows system by using the stand-alone installer.

You can install the product by using any of the following methods:

* GUI mode

» Console mode

« Silent mode
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Installation of the Agent on Windows systems

You can find information about installing HCL DevOps Test Performance Agent (Test Performance Agent) on Windows

system by using the stand-alone installer.

You can install the Agent by using any of the following methods:
» GUI mode
+ Silent mode

Installing Agent in the GUI mode on Windows systems

You can install HCL DevOps Test Performance Agent on different computers to apply load on the server that hosts the

application under test. When you want to run the test scripts on any computer, you must install Test Performance Agent.

Before you begin

» You must be an administrator.

Note: If you are a non-admin user, you must have the credentials of an administrator to start the installation

by using the Run as Administrator option.

* You must have completed the following tasks:

> Uninstalled the previous version of the product. See Uninstalling Agent in the GUI mode on Windows systems

on page 163.

o Verified the software and hardware requirements. See System Requirements for DevOps Test Performance

2025.12 (11.0.7) on page 72.

o Cleared files from the Tenp directory.

About this task

The product installer does not support the following features:

- Updates, modifications, or rollback
« Shell sharing in Eclipse

« Sharing of common components

You can use the stand-alone installer and the product in your preferred language. The display language of your computer is
selected as the preferred language of the stand-alone installer. For example, if the display language of your computer is set

as French, then the preferred language of the stand-alone installer is also selected as French.
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You can change the preferred language of the stand-alone installer and the product by selecting the language from the drop-
down list during the installation of the product. The drop-down list displays the languages based on the default language that

is set on your computer.

The following languages are displayed in the drop-down list based on the display language of your computer:

List of preferred languages that are displayed in the drop-down list based on the display language of your computer

 English - Simplified « Traditional « Jap *Cz * Kor *Tu * Ru

* French Chinese Chinese an ech ean rk ss

- German « English * English ese * Engl * En ish ian

« Italian « Engl ish gl * En * En

* Spanish ish * Hun ish gl gl

* Portugu gar ish ish
ese Brazil ian
« Pol
ish

For example, if the display language of your computer is Japanese, then the drop-down list shows Japanese and English as

the preferred languages.

If you do not want to configure the agent during the installation of the product, then you can leave the configuration fields
blank. Later, when you decide to configure the agent, you can update the parameter values in the Maj or dono. confi g file.
The Maj or dono. confi g file is at the following location:

\ HCL\ DevOpsTest \ Mpj or donp. confi g

Note: The URL Alias parameter name is shown as a slug in the Maj or dono. confi g file.

1. Download the product installer from the My HCLSoftware (MHS) .

You must download the appropriate product variant, version, and architecture based on your requirements.

2. Right-click the product installer file and select Run as Administrator.

The GUI window is displayed.

3. Select the language from the drop-down list to view the installation instructions and the product in your preferred
language.
The drop-down list displays the languages based on the display language that is set on your computer.

4. Read through the details on the Introduction window, and then click Next.

5. Read the license agreement carefully, select the I accept checkbox, and then click Next.
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. Read the Microsoft Software license agreement carefully, and then select the | accept check box to install the
execution agent that provides you with the necessary prerequisites to test the hybrid and native mobile applications,
and Windows desktop applications. Click Next to continue.

Note: After the installation, the execution agent starts automatically when you run AFT test suites and it
stops after the playback is completed.

. Browse for the location or directory where you want to install the product, and then click Next.
Note: You must select any other directory if the default directory is not empty. The default locations for 64-bit
installers is as follows:

o For 64-bit: C: \ Progr am Fi | es\ HCL

. Optional: Perform the following steps to configure the agent:

a. Specify the values for the following parameters for Test Performance:

Field name Description Example
Workbench The hostname of Test Performance. localhost
hostname
Workbench | The port number of Test Performance. 7080
port

b. Specify the values for the following parameters for Test Hub:

Field name Description Example
Server Host- | The hostname of Test Hub. localhost
name

Notes:

= The hostname of Test Hub must be resolv-

able through a Domain Name Server (DNS).

= An IP address cannot be the hostname of
Test Hub.
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Field name

Description

Example

= The hostname of Test Hub through host files
must not be specified.

For example, / et c/ host s or C. / W n-

dows/ systenB2/ dri ves/ et c/ host

Server Port

The port number of Test Hub.

443

Server Token

An offline user token that is created from Test Hub.

eyJhbGciOiJlUzITNilsInR

Context

The path context value that corresponds to the value config-

ured on Test Hub.

Note: If the Server Path Context is not configured,
the default value of / test is applied.

Server Team | The name of the URL Alias that you provided during the cre- |testteam
Space Alias | ation of the team space in Test Hub.
Server Path /test

9. Read through the installation details and, then click Install.

10. Click Done after the installation of the product is complete.

Results

You have installed the agent on your computer.

Creating the properties file on Windows systems for DevOps Test Performance Agent

To install HCL DevOps Test Performance Agent (Test Performance Agent) in the silent mode, you must first create a

properties file that contains the data required to install the product. Alternatively, you can generate the properties file by using

the stand-alone installer.

About this task

You can create the properties file by using one of the following methods:

- Generating the properties file by using the stand-alone installer. See steps 1 on page 158 through 4 on page 159.

 Copying the contents of the sample properties file to your local properties file. See step 5 on page 159.

1. Download the product installer from the My HCLSoftware (MHS) .

You must download the appropriate product variant, version, and architecture based on your requirements.
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Note: When you want to install both Test Ul and Test Performance on your computer, you can install the
products by using a single shell-shared HCL DevOps Test U and Test Perf or mance package thatis
available in the My HCLSoftware (MHS) .

Note: When you want to install Test Performance on Windows Server 2025, before running the
installer, you must right-click the installer to open the Properties dialog, and then select the Run this
program in compatibility mode for checkbox in the Compatibility tab.

2. Right-click the Command Prompt application and select Run as Administrator.
3. Run the following command to change the directory to a location where you downloaded the installer file:

cd <directory path>

For example, cd C:\users\Downloads

4. Run the following command to generate the properties file:

<installer_file.exe> -r <location of the installer.properties file>

For example, DevOps-Test-Performance-Agent-Windows-x64-v11.0.0.0.exe -r C:\users\Downloads\installer.properties
5. Create your properties file by copying the content of the following sample properties file:

# Replay feature output

# This file was built by the Replay feature of Installer.
# It contains variables that were set by Panels, Consoles or Custom Code.

#Destination Folder
USER_INSTALL_DIR=C:\\Program Files\\HCL

#HCL Load Generation Agent Configuration

WORKBENCH_HOSTNAME=<host name of HCL OneTest Performance>
WORKBENCH_PORT=7080

SERVER_HOSTNAME=<host name of server>

SERVER_PORT=6969

SERVER_TOKEN=<server token>

SERVER_URL_ALIAS=<name of the URL alias for the team space>

Results

You have generated or created the properties file.

What to do next

You can install the product by using the silent mode method.
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Installing Agent in the silent mode on Windows systems

You can install HCL DevOps Test Performance Agent on different computers to apply load on the server that hosts the

application under test. When you want to run the test scripts on any computer, you must install Test Performance Agent.

Before you begin

» You must be an administrator.

Note: If you are a non-admin user, you must have the credentials of an administrator to start the installation
by using the Run as Administrator option.

* You must have completed the following tasks:

> Uninstalled the previous version of the product. See Uninstalling Agent in the silent mode on Windows
systems on page 164.

> Deleted thei nstal | er. properti es file generated from the previous installation if you are installing a
newer version of the product.

o Created a properties file that contains the inputs for the installer during the installation process. See Creating

the properties file on Windows systems for DevOps Test Performance Agent on page 158.

o Verified the software and hardware requirements. See System Requirements for DevOps Test Performance
2025.12 (11.0.7) on page 72.

o Cleared files from the Tenp directory.

About this task

You can use the stand-alone installer and the product in your preferred language. The display language of your computer is
selected as the preferred language of the stand-alone installer. For example, if the display language of your computer is set
as French, then the preferred language of the stand-alone installer is also selected as French.

You can change the language of the stand-alone installer and the product by providing the -l language_code parameter during
the installation of the product.

If you decided to configure the agent, later, then you can update the parameter values in the Maj or dono. confi g file. The

Maj or dono. confi g file is at the following location:

\ HCL\ DevOpsTest \ Maj or dono. confi g

Note: The SERVER_URL_ALIAS parameter name is shown as a slug in the Maj or donp. confi g file.

1. Download the product installer from the My HCLSoftware (MHS) .

You must download the appropriate product variant, version, and architecture based on your requirements.
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2. Right-click the Command Prompt application and select Run as Administrator.

3. Run the following command to change the directory to a location where you downloaded the installer file:
cd <directory path>

For example, cd C:\users\Downloads

4. Run the following command to install the product:

<installer_name> -i silent -1 <language_code> -f <location_of the_installer.properties_file_name>
For example, you can run the following command to install Test Performance Agent 10.2.0 in French:
DevOps-Test-Performance-Agent-Windows-x64-v11.0.0.0.exe -i silent -| fr -f C:\users\Downloads\installer.properties

The following table lists the language codes that you might want to choose during the installation:

Lan- |Chi- |Chi- |Czech|Eng- |French Ger- [Hun- [ltal- [JapaniKore- |Pol- |Por- |Russ-|Span-|Turk-
guagesnese |nese lish man |gari- |ian ese [an ish tuguegéan ish ish

(Sim- | (Tra- an (Brazil

pli- di-

fied) |tion-

al)

Lan- |zh_- |zh_- |cz en fr de hu it ja ko pl pt.- |ru es tr
guage| CN T™W BR
codes

Notes:

> The -l parameter is optional. If you do not want to use this parameter, then the following information

are displayed in a language based on the display language that is set on your computer:
= The installation instructions
= The language of the product

o If the installation is terminated due to any reason, you must check the | nst al | error. t xt file to
know more about the problem that occurred during the installation process. The error log is located at

\<instal | ati on directory>\Logs.

Result
You can verify the status of the installation of the product by checking the log file at\ <i nst al | ati on

di rectory>\ Logs.

Results

You have installed the product on your computer.
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Uninstallation of the product by using the stand-alone installer

When you no longer require the product, you can use the stand-alone installer to uninstall the products that you have

installed.
Uninstalling the product on Windows systems
You can find information about uninstalling the product on Windows system by using either the stand-alone installer.

You can uninstall the product by using any of the following methods:
« GUI mode
« Silent mode

Uninstalling the product in the GUI mode on Windows systems

When you want to remove the product on a Windows system computer, use the uninstall option. You can choose to uninstall

the product by using any one of the uninstallation methods regardless of the mode of installation.
Before you begin

You must have completed the following tasks:

« Closed any open windows of the product.
* Closed any open web browsers.

« Closed all the other applications that are enabled by the product.

1. On the Start menu, click Add or remove programs option.
2. On the Apps & Features page, click the product software that you want to remove.
3. Click Uninstall.

A dialog appears with the warning message.

4. In the dialog, click Uninstall and follow the on-screen instructions.

The product is removed from your system.

Results
You have uninstalled the product from your computer.

Uninstalling the product in the silent mode on Windows systems

When you no longer require a version of the product, you can uninstall the product automatically without manual intervention
by using the command prompt option.

Before you begin

You must have completed the following tasks:
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- Closed any open windows of the product.
* Closed any open web browsers.
« Closed all the other applications that are enabled by the product.

« Closed any open windows of the product.
* Closed any open web browsers.

« Closed all the other applications that are enabled by the product.

1. Right-click the Command Prompt application and select Run as Administrator.

2. Change to the directory where the product is installed by running the following command:
cd <directory path>
For example, cd C:\Program Files\HCL\Uninstall

3. Start the uninstallation process by running the following command:

Uninstall-DevOps-Test-Performance.exe -uninstall -i silent

Results

You have uninstalled the product from your computer.

Uninstalling Agent in the GUI mode on Windows systems

When you want to remove HCL DevOps Test Performance Agent (Test Performance Agent) on a Windows system computer,
use the uninstall option. You can choose to uninstall the product by using any one of the uninstallation methods regardless

of the mode of installation.
Before you begin

You must have completed the following tasks:

1. On the Start menu, click Add or remove programs option.
2. On the Apps & Features page, click the product software that you want to remove.
3. Click Uninstall.

A dialog appears with the warning message.

4. In the dialog, click Uninstall and follow the on-screen instructions.

The product is removed from your system.

Results
You have uninstalled the agent from your computer.
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Uninstalling Agent in the silent mode on Windows systems

When you no longer require HCL DevOps Test Performance Agent (Test Performance Agent), you can uninstall it
automatically without manual intervention by using the command prompt option. You can choose to uninstall the product by
using any one of the uninstallation methods regardless of the mode of installation.

Before you begin

You must have completed the following tasks:

« Closed any open windows of the product.
« Closed any open web browsers.
« Closed all the other applications that are enabled by the product.

1. Right-click the Command Prompt application and select Run as Administrator.
2. Change to the directory where the product is installed by running the following command:

cd <directory path>

For example, cd C:\Program Files\HCL\Uninstall

3. Start the uninstallation process by running the following command:

Uninstall-DevOps-Test-Performance-Agent.exe -uninstall -i silent

Results
You have uninstalled the product from your computer.

License management

Licensing for HCL DevOps Test Performance (Test Performance) is administered through My HCLSoftware (MHS). This
portal is a cloud-based web application that helps to manage software entitlements and licenses.

When a software order is placed and acknowledged, a software entitlement is created. You must then follow the instructions
in the Software Order Acknowledgment document that you receive to activate your entitlement, create devices, and

download the software from the portal.

The license portal provides both software distribution and management of your software entitlements that are purchased
from HCL Software. The portal provides control and flexibility on how to consume your licenses. An organization identifies

one of its resources as a License Manager (also called Tech or Portal Admin) who is familiar with the language of licenses.

If you do not have access to the internet, you can install and configure a Local License Server (LLS).See Configuring licenses

by using a Local License Server on page 167.

License descriptions

The usage of base product and test extensions are enabled by floating licenses, whereas schedule runs can be enabled by
floating. With floating licenses, multiple users can use the product; however, the total number of concurrent users cannot

exceed the number of floating licenses you purchase.
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When a software order is placed and acknowledged, a software entitlement is created for the user. a license server
deployment in My HCLSoftware (MHS) and map the licenses to the deployment through the MHS. Every Deployment is
associated with a server ID or deployment ID. This server ID or deployment ID is applied in the product. Multiple software

entitlements can be created based on the requirements.
You can use any of these licenses according to your requirements:

Product licenses

* Floating license to use the product:

To use the product, you need a Test Performance floating license or you can also use a Test Workbench floating
license. A floating license is checked out when you use the product and is returned to MHS when the license is not

used for 15 minutes.

« Floating licenses for test extensions:

For Test Performance, in addition to the license for product usage, if you use SOA, SAP, and Citrix test extensions,
you need separate software entitlements. You can map all the entitlements to one server ID. With Test Workbench
license, you can use the above test extensions without the need for separate entitiements. A license is checked out
from the time the product is opened by the user. The license remains checked out until the user closes the product.
When the user closes the product, after 15 minutes, the license is returned to the MHS.

Licenses for schedule, in this context, is used to refer to VU Schedule and Rate Schedule runs

« HCL DevOps Test Workbench - Virtual Users:

These are floating licenses that are purchased in blocks of 100 virtual users each. After the run, the licenses are
checked back in to the server. For example, if you have 200 DevOps Test Workbench - Virtual Users available, you
can run schedule A with 100 virtual users and schedule B with 20 virtual users, leaving 80 virtual users for other team
members to use for schedule execution using the same license server. After the schedule run completes, the all the

virtual users are returned to the server for others to use.

You can add more virtual users or change the rate of execution during the test or schedule run only if there are sufficient
number of Virtual User licenses or if a sufficient number of VU-Hours are on balance in the customer's account.

License configuration

You must first apply a license to start using the product.

When you start the product for the first time, a licensing dialog is displayed. Specify the server ID or deployment ID that
was provided to you or copy the ID from the My HCLSoftware (MHS) . When you submit the server ID or deployment ID,
the product connects with the MHS to verify it and if there is a license available, it is checked out so that you can use the
product. If the license is not available, a message is displayed about it. In most cases, you must specify both URL and ID in

the licensing dialog.
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Notes:

« If the license is not used for 15 minutes, the license is returned to the server for others to consume it. If the
product looses connectivity to the MHS, you can use the product for two hours only if the server ID that you
entered last time is correct.

- After the product installation, when you apply the license to the product, the license information is cached
in a system directory. If there are any permission issues accessing the directory or the directory is deleted,
there can be licensing error when starting the product. The workaround is to create an environment variable
HCL_DT_LICENSING_DIR and specify a directory path. The licensing information is now stored in the new
directory. For example,

MNew System Variable e
Variable pame: 'HC L_DT_LICENSING_DIR
Variable value: ChUsers\ <User_name>My_lice nseI

Browse Directory... Browse File.. QK Cancel

You can also apply the license after you open the product by using any of the following methods based on your requirement:

« Configuring licenses by using a cloud-based License Server on page 167
« Configuring licenses by using a Local License Server on page 167

« Configuring licenses by using a Proxy Server on page 168

To apply the license without opening the product, add the licensing parameters as environment variables:

Variables Values

HCL_DT_LICENSING_URL URL of the licensing server. You get this URL when you acti-
vate your deployment in the My HCLSoftware (MHS) . For ex-

ample, https://my.hcllicenserver.com.

HCL_DT_LICENSING_ID Enter your server ID or deployment ID.

You can add HCL_DT_LICENSING_PRIORITIZE_STUDIO as an environment variable and set the value to "true", if you want to
prioritize the checkout of Workbench licenses over Performance seat licenses.

When running the tests from command line, you do not have to specify any licensing argument. However, when running a
schedule for Test Performance in an uninterrupted mode, you must specify vimar gs - Dhpt cost conf i r margument in the
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command. The uninterrupted mode refers to any of the non-GUI based test execution scenarios such as the following use

cases:

* Running a test from the command line

« Running a test with Jenkins

* Running a test with Ant

* Running a test with Deploy

« Running a test with IBM® Engineering Test Management
Configuring licenses by using a cloud-based License Server
You can apply license by using a cloud-based License Server to use HCL DevOps Test Performance (Test Performance).
Before you begin

You must have configured cloud-based License Server. For more information, refer to Managing HCL Cloud License Server.

. Open Test Performance.

. Click Windows > Preferences > Test > HCL Licensing.

. Enter the URL of the License Server in the Server URL field.
. Enter the ID of the License Server in the Server ID field.

. Click Test Connection to verify the connection to the License Server.

o g~ WN =

. Click Apply to configure the license.

Results

You have configured the license to use Test Performance. The HCL Licensing dialog displays the following information:

« The number of Virtual Users (VUs)

« The number of floating licenses

What to do next

You can work with Test Performance.

Configuring licenses by using a Local License Server

You might not be able to connect your computer to the internet due to certain restrictions. In such cases, you can configure a
Local License Server (LLS) behind a firewall to use Test Performance.

Before you begin

You must have completed the following tasks:
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« Installed and started the LLS. For more information, refer to the LLS installation guide.

- Imported a self-signed certificate into Java key store if you installed the LLS by using the self-signed certificate and
used an HTTPS protocol to check out licenses from the LLS.

Note: You can run the following commands to import the certificate into Java key store:

cd <install_dir>\HCL\DevOpsTest\jdk\bin

keytool -printcert -sslserver <LLS_host>:<LLS_port> -rfc | keytool -import -noprompt -alias
hclfnls -keystore "<install_dir>\HCL\DevOpsTest\jdk\jre\lib\security\cacerts" -storepass
changeit

You must replace <LLS_host > and <LLS_por t > with the hostname and port number of the LLS.

! Important: An alternative to importing the self-signed certificate is to append #skip-tls-verify to the
end of the Server URL, example: https://localhost:443#skip-tls-verify.

» Mapped entitlements of software with the LLS to serve your requests.

. Open Test Performance.

. Click Windows > Preferences > Test > HCL Licensing.

. Enter the URL of the license server in the Server URL field.
. Enter your server ID or deployment ID in the Server ID field.

. Click Test Connection to verify the connection to the LLS.

(o) NS N N R S R

. Click Apply to configure the license.

Results

You have configured the license to use Test Performance. The HCL Licensing dialog displays the following information:
 The number of Virtual Users (VUs)

 The number of floating licenses

What to do next
You can work with Test Performance.

Configuring licenses by using a Proxy Server

You can connect directly to a cloud-based license server when you start HCL DevOps Test Performance (Test Performance)
for the first time. As an alternative, you can configure Test Performance to use a Proxy Server.

1. Open Test Performance.
2. Click Windows > Preferences > Test > HCL Licensing.
3. Select the Use Proxy Server checkbox and specify the Host and Port of the Proxy Server.
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4. Optional: Select the Provide Credentials checkbox and specify the User Name and Password if login credentials are
required to access the Proxy Server.

5. Click Test Connection to verify the connection to the Proxy Server.

6. Click Apply to configure the license.

Results

You have configured the license to use Test Performance. The HCL Licensing dialog displays the following information:

+ The number of Virtual Users (VUs)

« The number of floating licenses

What to do next

You can work with Test Performance.

Collecting usage metrics data

To provide an insight into the usage patterns of the product itself and not necessarily the application that it is testing, the
usage metrics are collected. The product can collect the metrics about the usage of the tool including and not limited to the
number of tests executed, the number of actions performed against an application under test, the number of successful

versus failed actions, verification points, and so on.

Before you begin

» Ensure that Test Virtualization Control Panel is installed. See the Test Virtualization Control Panel documentation for
the installation instructions.

- Ensure that the license key is applied. See License configuration on page 165

About this task
When you collect usage metrics, the data is collected for internal use to provide you better services. For example, in an HTTP
test, the number of HTTP Pages and Requests are counted and logged. No information about the application under test is

collected.

1. Click Window > Preferences > Test > DevOps Test Virtualization Control Panel.

2. Specify the IP address or host name of the computer where Test Virtualization Control Panel server is installed.
Note: If the IP address or host name is not specified, depending on the license key setting, a warning
message might be logged every time you run a test, the test execution itself might be blocked, or the tests

can be executed without any warning messages.

3. Click Test Connection to check whether the connection is established. Click OK if the connection is established.
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Product upgrade and migration

When you want to use the enhanced functionalities of HCL DevOps Test Performance (Test Performance), you must upgrade
to the latest version of the product software.

You can upgrade Test Performance to the latest version by uninstalling the existing version of Test Performance. You can
then install the latest version of Test Performance.

Migrating test assets to new version of the product

After you install a later version of the product and you choose to open the product from an old workspace, you are prompted
to migrate test projects, tests, schedules, rules, and reports. Tests and schedules are migrated automatically when you

modify and save them.

You cannot have two versions of the products installed on your computer at one time. Before you install a new version,
uninstall the previous version of the product. If you update the product with IBM® Installation Manager, you do not have to

uninstall the previous version. Uninstalling a previous version does not delete your test assets.

Note: When you want to uninstall the previous version of the product and then install the latest version, you must
install the latest version in the same folder that contained the previous version. Thereby, you can avoid compilation

errors in the project in the latest version.

When you open a project that contains an older test asset, a message is displayed in the Test Navigator view. Typically, you

upgrade your tests, schedules, and rules.

1, Theworkspace contains rescurces produced in a 57
previous release. Click here to upgrade,

! Important: Ensure that you back up the test assets before upgrading them for the new version of the product. Do not

open a migrated test project with a previous version of the product.

If you leave tests, schedules, and rules unchanged, they will not have the new functions that current release adds. You can
always save a modified test asset under a new name, which preserves the older asset. You can identify an older asset by its
version, which is listed in brackets:

(‘EEE visitIBM [7.0.1.0] &3

Note: A new release might include enhancements to the default reports. When you run a test or schedule or open
a report, you are prompted to upgrade reports to the latest version. If you upgrade the default reports to the latest
version, you lose customizations that you have made to the reports.

If you encounter errors when you open a workspace from a different version of the product, reset the perspective. To reset

the perspective, click Window > Reset Perspective.
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Configuration of the product

You must configure HCL DevOps Test Performance (Test Performance) when you want to run SAP tests, or use the product
in the Docker container.

The following topics provide more information about the configuration of Test Performance:

Configuring the environment for SAP tests

Some of the capabilities of service tests require that you manually install additional libraries and files or that you configure
some elements of the test environment.

Configuring SAP for performance testing

Performance test recording and execution requires scripting to be enabled on the SAP application server and on all SAP GUI

clients that are installed on remote computers. The instructions might vary based on the SAP versions that you use.
Before you begin

Performance testing relies on the SAP Scripting APl and ActiveX. Make sure that Active X is installed when installing the SAP

GUI client and enable scripting on the SAP server.

Note: You only need to perform the following actions once. Scripting should remain enabled on the SAP server after
arestart.

To enable scripting on the SAP server:

1. Check that there is a Scri pt i ng directory located in the SAP GUI installation directory.
If this directory does not exist, then the SAP Scripting API is not installed and you must reinstall SAP GUI with the SAP
Scripting API option.

2. Run the SAP GUI client and logon to SAP with your user name and password.
Administrator privileges might be required to enable scripting on the server.

3. In SAP run the transaction rz11, type the parameter name sapgui / user _scri pti ng, and then click Display.
If the parameter is not found, then make sure you have the correct support package level from SAP. Contact your SAP
representative for guidance.

4. If the Current value is FALSE, click the Change value button, and then set the New value to TRUE in uppercase
characters.

5. Click Save, and then end the transaction.
Scripting will be enabled the next time you log on.

6. In the SAP GUI client toolbar, click the Customizing of Local Layout toolbar button, and then select Options.
Result
The SAP GUI Options page is displayed.

7. Expand Accessibility & Scripting from the left pane.

8. Select the Scripting page.
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9. Select the Enable scripting check box, and then disable both Notify when a script attaches to SAP GUI and Notify
when a script opens a connection.
10. Click OK.
11. In the Help menu, select Settings, and then select the F4 Help page.
12. In Display, select Dialog (modal) and then click the Enter ¥ button.

What to do next

Repeat steps 5 through 10 for SAP GUI clients on all remote computers. For more information about enabling scripting on

the SAP application server, refer to the following SAP notes, available from SAP:

» 480149: ABAP and patch level requirements

- 587202: Limitations of SAP GUI Scripting

» 527737: Composite SAP Note on SAP GUI Scripting

« 612454: SAP GUI Scripting status and lifetime

» 619459: SAP GUI Scripting support of SAP applications

Configuring an environment for batch input tests
You must configure the environment to record and play back SAP batch input tests by installing the SAP Java™ Connector
(JCo) libraries provided by the SAP administrator on HCL DevOps Test Performance (Test Performance) computer.

Before you begin

You must have downloaded the following files provided by the SAP administrator:

* sapjco3.jar
« sapjco3.dll

For more information about downloading the SAP files, refer to the SAP portal.

Note: You must have verified that the Microsoft® Visual Studio 2013 C/C++ runtime libraries are installed on your
computer. If the runtime libraries are not present in your computer, then you must download and install the latest
version of the Visual C++ 2013 Redistributable Package from Microsoft Download Center, depending on the Windows
operating system. For more information about the redistributable packages, refer to the Microsoft support portal.

1. Copy sapj co3.jar and sapj co3. dl | tothe Test Performance computer in the following path: ...\ hcl
\ DevOpsTest\ dt p\ ext ernal _fil es\ depl oyabl e\ sapj co\. ..\ hcl\DevOpsTest\dtp\external _fil es\depl oyabl e\ sapj co\,
where ...\ hcl\ DevOpsTest\dtp\...\hcl\DevOpsTest\dtp\ is the product installation directory.

You can use the rptExternal variable in the confi g. i ni file to control where external files must be installed. By default,
the rptExternal variable is set to the product installation directory. Edit the rptExternal variable if you want to install
the .dll files to a different location.
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For example, if you set the rptExternal variable to e\ : \\ hcl \\ DevOpsTest\\ dt pe\ : \ \ hcl \\ DevOpsTest \\ dt p then you must
install sapjco3.dll and sapjco3.jarin e:\ hcl \ DevOpsTest \ dt p\ ext er nal _fi | es\ depl oyabl e\ sapj co\ . Note that you must
use an extra backslash before the colon and backslashes in the path.

After installation in the correct directory on the Test Performance computer, sapjco3.dll and sapjco3.jar files are

automatically deployed as needed to any remote location.

2. Click Start > Control Panel > Administrative Tools > Services, and then stop and restart the Majordomo service, if you

are using an Test Performance Agent.

Results
The environment for the SAP batch input test is configured and as a result, the SAP Batch Input Recording option is available

for selection on the Select Client Application page.

What to do next

After the configuration is complete, you can then select the SAP Batch Input Recording option, and runs a SAP batch input
test. You can then verify the test results from the Batch Input Transaction Rate page of the SAP performance report. You can
also view the Test Log page to verify the SAP connection and transaction execution information.

Related information

Recording a SAP batch input test on page 393

Configuring Docker containers

Instead of reading through the system requirements list and installing the products, you can now deploy the Docker
containers on any computer and get started with testing. To automate playing back tests, you can push the product images
to the Docker container.

Before you begin
You must have downloaded and installed Docker-CE. For more information, refer to the following Docker documentations:

« Docker Desktop for Windows
» Docker Engine on Ubuntu

« Other platforms

1. Open PowerShell or a terminal of your choice and run the following command to verify whether your Docker

installation was successful:
$ docker run hello-world

2. Download the container image for the agents from the same location that you downloaded the product bits and

extract the compressed files.

173


https://store.docker.com/editions/community/docker-ce-desktop-windows
https://docs.docker.com/engine/install/ubuntu/
https://hub.docker.com/search?type=edition&offering=community

HCL DevOps Test Performance

! Important: The version of the product and agents must match.

3. Run the following command to load the agent image into the Docker repository:

$ docker load -1i imageFileName.tar.gz
For example, to load the 11.0.5 Docker image, you can use the following command:

$ docker load -i hcl-devops-workbench-11.0.5.tar.gz

Result
When the image is loaded, the following message is displayed:

Loaded i mage: inmageFil eNane: versi onNunber

What to do next
You must set up the playback environment on Docker. See Running tests with containerized agents on page 784 and

Running automated tests with containerized workbench and agents from Docker on page 786.

Integration with other products

You can integrate HCL DevOps Test Performance (Test Performance) with certain products to run tests, manage test assets,

and create defects.
The following topics provides more information about the integration of Test Performance with other products:

Integration plugin compatibility matrix

You can find information about the versions of the integration plugin that are compatible with HCL DevOps Test Performance

(Test Performance).

The following table lists the versions of the integration plugin that are required to integrate Test Performance with Jenkins,

Ant, and Deploy.

Note: You must download the required version of the integration plugin from the My HCLSoftware (MHS) based on
the existing version of Test Performance. You can then integrate Test Performance with Jenkins, Ant, HCL Launch,

and Deploy.
Test Performance Ant plugin Jenkins plugin HCL DevOps HCL™ Launch plugin
Deploy plugin
10.1.0 N/A
HOT-PERF-Ant-5.0 HOT-PERF-Jenkins-6.0 | HOT_PERF_1010_-
UCD-5.0
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Test Performance Ant plugin Jenkins plugin HCL DevOps HCL™ Launch plugin
Deploy plugin
10.1.1
HOT-PERF-Ant-6.0 HOT-PERF-Jenkins-7.0 | HOT-PERF-UCD-6.0 HOT-PERF-
LAUNCH-6.0
10.1.2
HOT-PERF-Ant-7.0 HOT-PERF-Jenkins-8.0 | HOT-PERF-UCD-7.0 HOT-PERF-
LAUNCH-7.0
10.1.3
HOT-PERF-Ant-7.0 HOT-PERF-Jenkins-8.0 | HOT-PERF-UCD-7.0 HOT-PERF-
LAUNCH-7.0
10.2.0
HOT-PERF-Ant-8.0 HOT-PERF-Jenkins-8.0 | HOT-PERF-UCD-7.0 HOT-PERF-
LAUNCH-7.0
10.2.1
HOT-PERF-Ant-8.0 HOT-PERF-Jenkins-8.0 | HOT-PERF-UCD-7.0 HOT-PERF-
LAUNCH-7.0
10.2.2
HOT-PERF-Ant-9.0 HOT-PERF-Jenkins-9.0 | HOT-PERF-UCD-7.0 HOT-PERF-
LAUNCH-7.0
10.2.3
HOT-PERF-Ant-9.1 HOT-PERF-Jenkins-9.1 |HOT-PERF-UCD-9.2 HOT-PERF-
LAUNCH-9.2
10.5.0
HOT-PERF-Ant-9.1 HOT-PERF-Jenkins-9.2 | HOT-PERF-UCD-9.3 HOT-PERF-
LAUNCH-9.3
10.5.1
HOT-PERF-Ant-9.1 HOT-PERF-Jenkins-9.2 | HOT-PERF-UCD-9.3 HOT-PERF-
LAUNCH-9.3
10.5.2
HOT-PERF-Ant-9.1 HOT-PERF-Jenkins-9.4 | HOT-PERF-UCD-9.3 HOT-PERF-
LAUNCH-9.3
10.5.3
HOT-PERF-Ant-9.1 HOT-PERF-Jenkins-9.5 | HOT-PERF-UCD-9.3 HOT-PERF-
LAUNCH-9.3
10.5.4
HOT-PERF-Ant-9.1 HOT-PERF-Jenkins-9.6 | HOT-PERF-UCD-9.3 HOT-PERF-
LAUNCH-9.3
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Test Performance Ant plugin Jenkins plugin HCL DevOps HCL™ Launch plugin
Deploy plugin
11.0.0
DTPerf-Ant-HCL-10.0 | DTPerf-Jenk- DTPerf-DD-HCL-10.0 DTPerf-DD-HCL-10.0
ins-HCL-10.0
11.0.1
DTPerf-Ant-HCL-10.1 DTPerf-Jenk- DTPerf-DD-HCL-10.1 DTPerf-DD-HCL-10.1
ins-HCL-10.1
11.0.2
DTPerf-Ant-HCL-10.2 | DTPerf-Jenk- DTPerf-DD-HCL-10.2 DTPerf-DD-HCL-10.2
ins-HCL-10.2
11.0.3
DTPerf-Ant-HCL-10.2 | DTPerf-Jenk- DTPerf-DD-HCL-10.2 DTPerf-DD-HCL-10.2
ins-HCL-10.3
11.0.4
DTPerf-Ant-HCL-10.2 | DTPerf-Jenk- DTPerf-DD-HCL-10.2 DTPerf-DD-HCL-10.2
ins-HCL-10.3

Running tests by using Ant

When you want to automate repetitive tasks, you can run performance test assets from the command-line interface by using

Ant .

Before you begin

You must have completed the following tasks:

« Installed Test Performance.

If you installed Test Performance on the Mac operating system, you must have added TEST_WORKBENCH_HOMVE as

an environment variable. You must have pointed that environment variable to the installation directory of Test

Performance.

Note: On Windows® and Linux™ operating systems, the TEST_WORKBENCH_HOME environment variable is set after

the installation of Test Performance is complete.

- Created test assets within Test Performance. See Test Author Guide on page 349.

- Installed Apache Ant. For more information, refer to the Installing Apache Ant section in the Apache Ant

Manual.

™

User

» Downloaded the Test Performance ant plugin from the My HCLSoftware (MHS) onto the computer where you install

Test Performance.


https://ant.apache.org/manual/index.html
https://ant.apache.org/manual/index.html
https://hclsoftware.flexnetoperations.com/flexnet/operations/logon.do
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For more information about specific versions of plugin, see Integration plugin compatibility matrix on page 174.

» Closed Test Performance.

About this task

You must provide the values for certain parameters in the ANT test script to run tests from the command-line interface. The

minimum parameters that you need to provide are name, workspace, projectname, and suite or configfile. The remaining

parameters are optional.

For example, if you provide a complete path of a configuration file that contains the parameters for atest or schedul e run in

the configfile parameter, then you need not be required to provide values for the name, workspace, projectname, and suite

parameters.

Note: If Test Performance is not installed in default location, then you must provide the value for the imsharedloc

parameter along with other mandatory parameters.

n Remember: You must consider the following requirements:

« Enter the parameter values within the double quotation marks.

« Ensure that the special characters in the parameter values do not break the validation of the XML file. For

example, you must enter the & character as ganp; .

1. Extract the following files from the downloaded Ant plugin:

The ant plugin includes the following files:

o DTPer f - Ant - HCL- x. y. j ar

Where x.y is the version number of the ant plugin.

o Execut ePer f or manceTest . xm
o README. t xt

2. Open the Execut ePer f or manceTest . xni file in a text editor and provide the required parameter values within

<pt > tag by referring to the following table:

The following table lists the required parameters that you must provide to run the test from Ant:

Parameters

Description

configfile

Enter the complete path to a configuration file that contains the parameters for atest or

schedul e run.

For example,
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Parameters Description
<pt configfile=C:\Users\HCL\devopstest\workspace\Projectl\config.txt />
For more information about creating a command line config file from Test Performance, see
the Related information section.
name Enter a name for the ant task.
For example,
<pt name="runtest_ant" />
projectname
Enter the name of the project that has performance test assets.
For example,
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"/>
suite
Enter the name of the test asset that you want to run.
For example,
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite"/>
workspace
Enter the complete path of the Eclipse workspace.
For example,
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"/>

The following table lists the optional parameters that you can provide to run the test from Ant:

Parameters

Description

duration

Use this parameter to change the duration of the stages in the rate schedule.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\hclonetest\workspacel"
projectname="proj123"
suite="testl.testsuite" duration="Stagel=10s, Stage2=3m"/>

The stage number specified must exist in the rate schedule.
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Parameters

Description

Note: The duration parameter creates a new copy of the rate schedule that contains

the specified number of duration.

exportlog

Use this parameter to specify the path of the file directory to store the exported HTTP test

logina.txt format.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" exportlog="C:/Users/Documents/ANT/LogExp.txt"/>

Note: When you do not use the exportlog parameter, then the ant execution output
is logged into the | ogfi | e. t xt file and stored in at enp directory where you ex-
tracted the files of the ant plugin.

exportstatreportlist

Use this parameter to specify the IDs of reports that you want to export in place of the de-
fault reports.

You can provide multiple report IDs separated by a comma. You can navigate to Prefer-
ences of Test Performance (Window > Preferences > Test > Performance Test Reports >
Export Reports), and then select the Show Report IDs checkbox to view the report IDs.

You must use the exportstatreportlist parameter along with the exportstats or exportstat-
shtml parameter.

For example, you can provide the value for the exportstatreportlist parameter as follows to
export the Performance Report:

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite" exportstats="C:/Users/Documents/ANT"
exportstatreportlist="http"/>

exportstats

Use this parameter to provide the complete path to a directory that you can use to store the
exported report in a comma-separated values (CSV) format.

For example, you can provide the value for the exportstatreportlist parameter as follows to
export the Performance Report:
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"

projectname="proj123"
suite="testl.testsuite" exportstats="C:/Users/Documents/ANT"/>
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Parameters Description
Note: If you do not specify a value for the exportstatreportlist parameter, then the
reports that you selected in Preferences of Test Performance (Window > Prefer-
ences > Test > Performance Test Reports > Export Reports) are exported.
exportstatsformat

Use this parameter to specify a format for the result that you want to export along with the

exportstats parameter.

You must use at least one of the following options with the exportstatsformat parameter:
> simple.csv
o full.csv
o simple.json
> full.json
° csv

° json

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite" exportstats="C:/Users/Documents/ANT"
exportstatsformat="simple.json"/>

You can add multiple options separated by a comma.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite" exportstats="C:/Users/Documents/ANT"
exportstatsformat="simple.json,full.csv"/>

When you want to export both simple and full type of test results in a j son or csv format, you

can specify either j son or csv as options.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite" exportstats="C:/Users/Documents/ANT"
exportstatsformat="json"/>

When the test run completes, the test result exports to si mpl e. j son and ful I . j son files.

Note: The values provided in the Execut ePer f or manceTest . xnl file always take
precedence over the Export Reports options set in the Preferences of Test Perfor-
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Parameters

Description

29 mance (Window > Preferences > Test > Performance Test Reports > Export Re-

ports).

exportstatshtml

Use this parameter to provide the complete path to a directory that you can use to export

web analytic results.

The results are exported to the specified directory. You can analyze the results on a web

browser without using Test Performance.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" exportstatshtml="C:/Users/Documents/ANT"/>

Note: When you do not use the exportstatshtml parameter, then the Performance
report is stored in a t enp directory where you extracted the files of the ant plugin.

history

Use this parameter when you want to view a record of all events that occurred during a t est

Or schedul e run.
You can use any of the following options:

- jaeger: To send test logs to the Jaeger Ul during the test or schedul e run.

Note: You must set the JAEGER AGENT_HOST property as an environment vari-
able by using the command line before you use the jaeger option to send
test logs to the Jaeger UL

- testlog: To send test logs as traditional test logs in Test Performance during the

test Or schedul e run.

o null: To send no test logs either to the Jaeger Ul or Test Performance during the t est

Or schedul e run.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" history="jaeger"/>

You can add multiple options separated by a comma to send test logs during the test or
schedul ea run to Test Performance and the Jaeger Ul.

181



HCL DevOps Test Performance

182

Parameters Description
For example,
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" history="jaeger,testlog"/>
For more information about how to view test logs in the Jaeger Ul and Test Performance,
see the Related information section.
imsharedloc
Use this parameter to enter the complete path to the HCLIMShared location, if it is not in the
default location.
The default location of the | MShar ed directory is as follows:
Operating system The default path to the directory
Windows® C.\ Program Fi | es\ HCL\ HCLI Mshar ed
Linux™ [ opt / HCL/ HCLI Mshar ed
Mac / Appl i cati on/ HCL/ HCLI MsShar ed
For example,
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" imsharedloc="D:\ Testt ool \ HCL\ devopstest "/>
labels

Use this parameter to add labels to test results when the test run is complete.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" labels="labell, label2"/>

You can add multiple labels to a test result separated by a comma. When you run test as-
sets, then the labels that you added are displayed on the Performance Report in Test Perfor-

mance.

The Results page of Test Hub displays the label that you added, in the specific test asset in

the following conditions:

> When you set Publish result after execution as Always or Prompt in the Preferences

of Test Performance (WindowsPreferencesTestDevOps Test Hub).

> When you use the labels parameter along with the publish parameter.
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Parameters

Description

Note: If the value of the labels parameter contains double quotation marks ("), for

example, "100" users, then the test run fails due to non-validation of xml file.

To work around this problem, you must create a command-line config file, and then

run the test by using the configfile parameter.

overridermlabels

Use this parameter to perform any of the following actions:

> Enable the Resource Monitoring from Service option for a performance schedul e if
the Resource Monitoring from Service option is not enabled from the schedule edi-

tor in Test Performance.

> Ignore Resource Monitoring sources that were set in the performance schedule and

change for a label matching mode.

» Replace an existing set of Resource Monitoring labels that were set in the perfor-

mance schedule and run the schedule with a new set of Resource Monitoring labels.

If you have added a label in Test Hub for a Resource Monitoring source as rnt, then you can

provide value as shown in the following example to collect data from the source:

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" overridermlabels="rm1"/>

If your label for resource monitoring contains a comma (,) then you must replace the single
comma with the double comma while providing the value. For example, if you added a label
to a Resource Monitoring source as rnt, t est, then you must provide the value as shown in

the following example to collect data from source:

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" overridermlabels="rml,,test"/>

Notes:
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Parameters

Description

> You can use this field only when you want to run a Rate schedule or VU
schedule.

> You can add multiple Resource Monitoring labels separated by a comma.

> You must add the Resource Monitoring labels to the Resource Monitoring

sources on the Resource Monitoring page in the Test Hub project.

overwrite

Set this parameter value to t rue or f al se to determine whether a result file with the same
name must be overwritten or not.

The default value is f al se.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" overwrite="true"/>

publish

Use this parameter to publish test results to Test Hub by using Anr.

n Remember: Before you use the publish parameter, you must provide the offline user
token of Test Hub by using any of the following methods:

o Set the value of the HCL_DEVOPS_OFFLINE_TOKEN environment variable to

the offline user token of Test Hub by using the command-line interface.

> Provide the offline user token of Test Hub in the preferences of Test Perfor-

mance (Window > Preferences > Test > DevOps Test Hub)

You must use one of the following values in the publish parameter:

o serverURL#project.name=name_of_the_project&teamspace.name=name_of_the _-
teamspace

o serverURL#project.name=name_of_the_project&teamspace.alias=name_of_the _-
teamspace_alias

° no

The no option is useful if the product preferences are set to publish the results, but

you do not want to publish them.

For example:
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Parameters Description
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" publish=
"URL_OF_DevOpsTest_Hub#project.name=test&amp;teamspace.name=ts1"/>
<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" publish=no"/>
Where:
o URL_OF Test Hub is the URL of Test Hub.
o test is the name of the project in Test Hub.
> ts1 is the name of the team space.
Notes:

o If you have a project with the same name in different team spaces, then you
must append either the &teamspace.name=name_of_the _teamspace or
&teamspace.alias=name_of_the_teamspace_alias options.

o If the name of the project or team space contains a special character, then
you must replace it with %Hexval ue_of _speci al _char act er >
For example, if the name of the team space is Initial Team Space, then you
must provide it as Intial%20Team%20Space.

Where %20 is the Hex value of the space character.

> The values provided in the Publish field always take precedence over the Re-
sults options set in the product preferences (Window > Preferences > Test >
DevOps Test Hub > Results).

The Reports information section on the Log file displays the names of the report along with
its corresponding URLs in the following conditions:
> When you configured the URL of Test Hub in Preferences of Test Performance (Win-
dow > Preferences > Test > DevOps Test Hub).
> When you set Publish result after execution as Always or Prompt in the Preferences
of Test Performance (Window > Preferences > Test > DevOps Test Hub > Results).
> When you used publish parameter or publish parameter along with publishreports
parameter.
publish_for

Use this parameter to publish test results to Test Hub by using anT based on the completion
status of the tests.
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Parameters Description

You must use the publish_for parameter along with the publish parameter. You must add
multiple parameters separated by a comma. The available options that you can use for the
publish_for parameter are as follows:

o ALL: You can use this option irrespective of the status of the test.
> PASS: You can use this option to publish test results for the tests that have passed.
o FAIL: You can use this option to publish test results for the tests that have failed.

> ERROR: You can use this option to publish test results for the tests that included er-

rors.

o INCONCLUSIVE: You can use this option to publish test results for the inconclusive

tests.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite" publish=
"URL_OF_DevOpsTest_Hub#project.name=test&amp;teamspace.name=ts1"
publish_for="FAIL,ERROR"/>

publishreports
Use this parameter to publish specific test results to Test Hub.

You must use the publishreports parameter along with the publish parameter. The options
that you can use with publishreports are as follows:

o STATS
> TESTLOG

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite" publish=
"URL_OF_DevOpsTest_Hub#project.name=test&amp;teamspace.name=ts1"
publishreports="STATS"/>

You can prefix the publishreports value with ! to publish the reports except for the specified

one in the test script.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"

projectname="proj123"
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Parameters

Description

suite="testl.testsuite" publish=
"URL_OF_DevOpsTest_Hub#project.name=test&amp;teamspace.name=ts1"
publishreports="!TESTLOG" />

rate

Use this parameter to change the rate of the rate runner group.

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"
suite="testl.testsuite" rate="Rate Runner Groupl=1l/s, 3/m"/>

Where, Rat e Runner Group1 is the name of the rate runner group that has two stages. The de-
sired rate for the first stage is one iteration per second and the rate for the second stage is

three iterations per minute.

Notes:

o The name of the Rate Runner group must match with the name in the rate
schedule.

> The rate parameter creates a new copy of the rate schedule that contains
the specified number of rate.

results

Use this parameter to provide a different name to the result file.

The default name of the result file is the name of the t est or schedul e with a timestamp ap-
pended.

swapdatasets

Use this parameter to replace the dataset values during a t est or schedul e run.

You must ensure that both original and new datasets are in the same workspace and have
the same column names.When you enter a value for the swapdatasets parameter, you must
also include the path to the dataset. You must provide the values for the swapdatasets pa-

rameter in the following format:

/ proj ect _nane/ ds_pat h/ ori gi nal _ds. csv:/project_nane/ ds_pat h/ new_d-

S. CSV

For example,

<pt name="runtest_ant" workspace="C:\Users\HCL\devopstest\workspacel"
projectname="proj123"

suite="testl.testsuite"
swapdatasets="/proj1023/Datasets/dsl.csv:/projl1023/Datasets/new_dsl.csv"/>
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Parameters Description
You can override multiple datasets that are saved in a different project by adding multiple
paths to the dataset separated by a semicolon. For atest or schedul e, the default value is
the dataset specified in the test editor or schedule editor.
usercomments
Use this parameter to add text that you want to display in the user comments row of the re-
port.
For example,
<pt name="runtest_ant" workspace="C:\Users\HCL\hclonetest\workspacel"
projectname="proj123"
suite="testl.testsuite" usercomments="test run with dataset"/>
Note: If the value of the usercomments parameter contains double quotation marks
(™), for example, test run with "dataset", then the test run fails due to non-valida-
tion of xml file.
To work around this problem, you must create a command-line config file, and then
run the test by using the configfile parameter.
users
Use this parameter to override the default number of users, if required.
For a schedul e, the default is the number of users specified in the schedule editor, and for a
test, the default is one user.
Note: The users parameter creates a new copy of the schedul e that contains the
specified number of users.
varfile Use this parameter to provide a complete path to an XML file that contains the variable
name and value pairs.
vmargs
Use this parameter to specify the maximum heap size for the Java process.
You can add multiple VM Arguments separated by a comma.

Note: You can add multiple <pt > tasks and provide the details for each test to run multiple tests

simultaneously.

3. Save the DTPer f - Ant - HCL. xni file.

4. Open the command prompt, and then change the directory to a location where you downloaded the ant plugin.
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cd D:\Downloads\Ant\DTPerf-Ant-HCL-x.y

Where x.y is the version number of the ant plugin.
5. Run the following command to initiate the test run:

ant -f DTPerf-Ant-HCL.xml

Results
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You have run the test from the command-line interface by using Ant .

What to do next

You can view the ant execution output from the | ogfi | e. t xt file that is stored in at enp directory. The temp directory is

located where you extracted the files of the ant plugin. If you provided the location for the exportlog parameter, then the ant

execution output is stored in the specified location.

The Reports information section on the Log file displays the names of the report along with its corresponding URLs if you

publish test results to Test Hub.

Related information

Creating a command-line config file on page 796
Viewing test logs in Jaeger
Viewing test logs on page 995

Generating offline user tokens

Integration with Azure DevOps

When you use Azure DevOps for continuous integration and continuous deployment of your application, you can create tests
for your application in HCL DevOps Test Performance (Test Performance) and run those tests in Azure DevOps pipelines.

You must use the extension from the Visual Studio Marketplace portal to integrate Test Performance with Azure DevOps.

The following table lists the tasks that you must perform to run performance test assets from Azure DevOps:

Tasks

Go to...

Install Test Performance.

Installation of the product by using the stand-alone installer

on page 147.

Create any or all the following types of test assets in Test

Performance to test your application:

Test Author Guide on page 349.
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Tasks Go to...

» Compound tests
« Performance tests
« Schedules (Rate or VU Schedules)

Install at least one agent in Azure Pipelines. Azure DevOps documentation.

Create an Organization and a Project in Azure DevOps to run | Azure DevOps documentation.

test assets as jobs in Azure DevOps pipelines.

Install the HCL DevOps Test Workbench extension. Installing the DevOps Test Workbench extension on
page 190

Run the test assets from an Azure DevOps pipeline. Running tests from Azure DevOps as a Pipeline job on
page 191

Installing the DevOps Test Workbench extension

You must install the HCL DevOps Test Workbench extension for an Organization in Azure DevOps to run tests from an Azure

DevOps pipeline.

Before you begin

« You must be familiar with working with Azure DevOps.

« You must have access to the following portals:

o Azure DevOps
» Visual Studio Marketplace

. Log in to the Visual Studio Marketplace portal, if you are not already logged in.
. Click the Azure DevOps tab.
. Search for the DevOps Test Workbench extension.
. Click the DevOps Test Workbench extension.
. Click Get it free.
Result

a A WO N =

The Visual Studio Marketplace portal for the DevOps Test Workbench is displayed.

6. Select the Organization from the drop-down list.
7. Click Install.

Result

The installation process begins and after a few minutes the installation is complete.
8. Click Proceed to organization.

Result

The Organization page in Azure DevOps is displayed.
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9. Click Organization settings, and then Extensions.
Result
The DevOps Test Workbench extension is displayed as an installed extension.

Results

You have installed the DevOps Test Workbench extension for the Organization in Azure DevOps.

What to do next
You can add the details of performance test assets to task, and then run the tests from an Azure DevOps pipeline. See

Running tests in an Azure DevOps Pipeline on page 191.
Running tests from Azure DevOps as a Pipeline job
You can run test assets from Azure DevOps as a Pipeline job to test the performance of your application under test.

Before you begin

« You must be familiar with working with Azure DevOps.
« You must have completed the following tasks:
> Been granted access to the Azure DevOps portal.
o Created an Organization in Azure DevOps.
- Created and configured the repository for the project in Azure DevOps.
o Started the Azure DevOps pipeline agent.
o Closed Test Performance.

- Optional: Created test cases under test plans in Azure DevOps if you want to view the results of the test runs
on the Test Plans dashboard.

- Optional: Created encrypted secrets or environment variables for your personal access token (PAT), if you
want to use an encrypted PAT.

About this task
You must provide the values for certain fields for the selected task to run tests from Azure DevOps. The minimum fields that
you need to configure along with Display name are Workspace Location, Project Name, and Test Suite Name or Configfile.

The remaining fields are optional.

For example, if you provide a complete path of a configuration file that contains the parameters for atest or schedul e run in

the Confidfile field, then you need not provide values for the Workspace Location, Project Name, and Test Suite Name fields.

If you have created test cases under test plans in your Azure DevOps project, you can provide the details in the Azure DevOps
URL, Test Plan Name, Test Case Name, and Azure DevOps PAT fields while you configure the job in a pipeline so that you

can view the results of the test run on your Test Plan dashboard.
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1. Sign in to the Azure DevOps portal, if you are not already logged in.
2. Open the Organization page, and then select the project that you want to use to run tests.
3. Initialize the repository if you have created a new project by performing the following steps:
a. Click Repos from the left pane.
b. Select the Add a README checkbox if it is not selected.
c. Click Initialize from the Initialize <branch_name> with a README or gitignore section.
4. Click Pipelines from the left pane, and then click Create Pipeline.

Note: If your project already contains a pipeline, then you can click New Pipeline to create another pipeline.

5. Click Use the classic editor to create a pipeline without YAML.

6. Verify the values for the Team project, Repository, and Default branch for manual and scheduled builds fields, and
then click Continue.

7. Click Empty job to add a task to the pipeline.

Note: The values for the Name, Agent pool, and Agent Specification fields are auto populated. You can
change the values for the fields, if required.

8. Perform the following steps to add a task to the Agent job:

a. Click the Add a task to Agent job icon |
Result
The Add tasks pane is displayed.

b. Search for the HCL tasks defined in the DevOps Test Workbench extension.
Result
The tasks that you can select are displayed.

c. Select the DevOps Test Performance Task option, and then click Add.

The selected task is added to the agent job and it is displayed with a warning that some settings require
attention. When you configure the details about the test run, the warning disappears.

You can also remove the tasks that are not required in your job by selecting the tasks from the list. You can
then right-click the tasks, and click Remove selected task(s) to remove them.

9. Configure DevOps Test Performance Task to provide the details about the test run by referring to the following table:

The following table lists the required fields that you must provide to run the test from Azure DevOps pipeline:

Fields Description

Configfile
Enter the complete path to a file that contains the parameters for atest or schedul e run.

For example, C:\Users\HCL\devopstest\workspace\Project1\config.txt
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Fields Description

For more information about creating a command line config file from Test Performance, see

the Related information section.

n Remember: If you provide a complete path of a configuration file in the Config File
field, then you need not provide values for the Workspace, Project, and Test Suite

Name fields.

Display name
Enter the name for the task.

For example, testrun1

IMShared Path
Enter the complete path to the | Mshar ed directory, if it is not in the default location.

For example, D:\Testtoo\HCL\HCLIMShared

The default location of the | MsShar ed directory is as follows:

Operating system The default path to the directory
Windows® C:\ Program Fi | es\ HCL\ HCLI Mshar ed
Linux™ / opt / HCL/ HCLI Mshar ed
Mac / Appl i cati on/ HCL/ HCLI MShar ed

Project Name
Enter the name of the project that has performance test assets.

For example, testproj1

Test Suite Name
Enter the file name of the performance test assets relative to the project.

For example, test1.testsuite

Workspace Location
Enter the complete path of the Eclipse workspace.

For example, C:\Users\HCL\devopstest\workspace1

The following table lists the optional fields that you can provide to run the test from Azure DevOps pipeline:

Fields Description

Azure DevOps PAT
Use this field to enter the personal access token of the Azure server where the test project

is hosted.
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You can also enter the variable for the encrypted PAT that you create in Azure DevOps. The

token must have read and write access.

You must use Azure DevOps PAT with the following fields:
o Azure DevOps Project URL
o Test Plan Name
> Test Case Name

Azure DevOps
Project URL

Use this field to enter the URL of the test project in the Azure server in the following format:

htt ps://<host >/ <or gnane>/ <pr oj ect Nane>

Note: You must enter the URL of the Azure DevOps project if you have created test
cases under Test Plans in your Azure project and want to view the test results on
the Test Plans dashboard.

You must use Azure DevOps Project URL with the following fields:
o Azure DevOps PAT
o Test Plan Name
> Test Case Name

Dataset Override

Use this field to replace the dataset values during a t est or schedul e run.

You must ensure that both original and new datasets are in the same workspace and have
the same column names. When you enter a value for the Dataset Override field, you must
also include the path to the dataset. You must provide the values for the Dataset Override

field in the following format:

/ proj ect _nane/ ds_pat h/ ori gi nal _ds. csv:/project_nane/ ds_pat h/ new_d-

S.CSV
For example, /proj1/Datasets/ds1.csv:/proj1023/Datasets/new_ds1.csv

You can override multiple datasets that are saved in a different project by adding multiple
paths to the dataset separated by a semicolon. For atest or schedul e, the default value is

the dataset specified in the test editor or schedule editor.

Duration

Use this field to change the duration of the stages in the rate schedule.
For example, Stage1=10s, Stage2=3m

The stage number specified must exist in the rate schedule.
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Note: The Duration field creates a new copy of the rate schedule that contains the

specified number of duration.

Exportlog

Use this field to specify the path of the file directory to store the exported HTTP test log in a

.t xt format.

For example, C:/Users/Documents/tests/logexp.txt

Exportstatreportlist

Use this field to specify IDs of reports that you want to export in place of the default reports.

You can provide multiple report IDs separated by a comma. You can navigate to Prefer-
ences of Test Performance (Window > Preferences > Test > Performance Test Reports >

Export Reports), and then select the Show Report IDs checkbox to view the report IDs.

You must use the Exportstatreportlist filed along with the Exportstats or Exportstatshtml
field.

For example, you can provide ht t p as a value in the Exportstatreportlist field to export a Per-

formance Report.

Exportstats

Use this field to provide the complete path to a directory that you can use to store exported

reports in a comma-separated values (CSV) format.

For example, C:/Users/Documents/tests

Note: If you do not specify a value for the Exportstatreportlist field, then the reports
that you selected in the Preferences of Test Performance (Window > Preferences >
Test > Performance Test Reports > Export Reports) are exported.

Exportstatsformat

Use this field to specify a format for the report that you want to export.

You must use at least one of the following options along with the Exportstats field:
> simple.csv
o full.csv

° simple.json

> full json
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° cSV
° json
For example, json.

You can add multiple formats for the report separated by a comma. When you want to ex-
port both simple and full type of report in a json or csv format, you can specify json or csv as
the format in the field.

The reports are saved to the location specified in the Exportstats field.
Note: The values provided in the Exportstatsformat field always take precedence

over the Export Reports options set in the product preferences Window > Prefer-
ences > Test > Performance Test Reports > Export Reports).

Exportstatshtml

Use this field to provide the complete path to a directory that you can use to export web an-

alytic results.

The results are exported to the specified directory. You can analyze the results on a web

browser without using Test Performance.

For example, C:/Users/Documents/Reports

History

Use this field when you want to view a record of all events that occurred during a test or

schedule run.
You can use any of the following options:
- jaeger: To send test logs to the Jaeger Ul during the test or schedul e run.
Note: You must set the JAEGER_AGENT_HOST property as an environment vari-

able by using the command line before you use the jaeger option to send

test logs to the Jaeger UL

- testlog: To send test logs as traditional test logs in Test Performance during the

test Or schedul e run.

o null: To send no test logs either to the Jaeger Ul or Test Performance during the t est

Or schedul e run.

For example, jaeger
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You can add multiple options separated by a comma to send test logs during the test or

schedul ea run to Test Performance and the Jaeger UL.
For example, jaeger,testlog

For more information about how to view test logs in the Jaeger Ul and Test Performance,

see the Related information section.

Labels

Use this field to add labels to test results when the test run is complete.
For example, label1, label2

You can add multiple labels to a test result separated by a comma. When you run test as-
sets, then the labels that you added are displayed on the Performance Report in Test Perfor-

mance.

The Results page of Test Hub displays the label that you added in the Labels field for the
specific test asset in the following conditions:

> When you set Publish result after execution as Always or Prompt in the preferences

of Test Performance (Windows > Preferences > Test > DevOps Test Hub).

> When you use the Labels field along with the Publish field.

Note: When you run tests by using the double quotation marks (™) for the Labels

field, then the labels in the test result do not include double quotation marks.

For example, if you provide the value for the Labels field as "100" users, then the la-

bels in the test result display as 100 users.

To work around this problem, you must create a command-line config file, and then
run the test by using the Configfile field.

Overwrite

Use this field to determine whether a result file with the same name is overwritten or not.

The default value is f al se. If the value is set to t r ue, the file is overwritten and retains the

same file name.

Publish

Use this field to publish test results to Test Hub from Azure DevOps.

n Remember: Before you use the Publish field, you must provide the offline user token
of Test Hub by using any of the following methods:
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n o Set the value of the OFFLINE_TOKEN environment variable to the offline
user token of Test Hub by using the command-line interface.

> Provide the offline user token of Test Hub in the preferences of Test Perfor-

mance (Window > Preferences > Test > DevOps Test Hub)

You must use one of the following values in the Publish field:

- serverURL#project.name=name_of_the_project&teamspace.name=name_of_the _-

teamspace

o serverURL#project.name=name_of_the_project&teamspace.alias=name_of_the _-

teamspace_alias

° no

The no option is useful if the product preferences are set to publish the results, but
you do not want to publish them.

Note:

You must not include the double quotation marks (") while providing th